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Chapter 1: Remark Office 

OMR Overview 

Software Overview 

Remark Office OMR is a software package designed to collect data from marks (bubbles, checkboxes) on 

plain paper forms. In addition, the software recognizes machine printed text (OCR) and barcodes. The 

software works in conjunction with an image scanner to collect the data. The software then analyzes that 

data and/or allows you to export it to various file formats. 

The software is commonly used to grade tests and analyze various types of surveys. The following 

overview provides the basic steps to using the software. Click the links below to learn more about 

processing forms for your specific application. 

General Use: 

• Create a scannable form in the software package of your choice: word processing, survey 

design, etc. The forms you can use with Remark Office OMR vary tremendously, from tests 

and assessments to surveys and market research. Remark Office OMR can read marks 

(bubbles, checkboxes, etc.), machine printed text (OCR) and barcodes. While Remark Office 

OMR is not a form designer, you are allowed a great deal of flexibility in the design process 

because you do not need special marks or drop-out inks, nor do your respondents need to 

use a number 2 pencil to fill in the forms. Because Remark Office OMR works with forms that 

you create, we provide form design guidelines to help you get the best results possible.  

• Use the Template Editor portion of the Remark Office OMR software to create a form 

template (definition file). The form template tells Remark Office OMR how to read your form. 

To create the form template, scan a blank copy of the form into the software and use the 

mouse to drag boxes around the areas you want recognized. You then provide the software 

with information about the area, including what type of data to output. Each form you wish to 

process requires a form template, but the form template is a one-time setup that tells the 

software how to read your particular form. 

• Process filled-in forms using a scanner or saved image files. Remark Office OMR provides 

flexibility in terms of how you process images. For example, you can use a desktop scanner 

connected to the PC running Remark Office OMR, or scan with a networked multi-function 

printer (MFP) and save image files on your network (that Remark Office OMR will read). 

Remark Office OMR displays the data in a spreadsheet style grid based on the form template 

you created. Each row of this grid corresponds to one scanned form in its entirety and each 

column corresponds to one question or variable on the form. 

• Correct any exception cases. Remark Office OMR denotes exceptions with color-coded data 

grid cells and by providing a descriptive word in the answer cell (e.g. "BLANK" for a question 

that was not answered). The software provides a Review Exceptions function to correct 

file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/remark_office_omr_overview_b/designing_scannable_forms_overview.htm
file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/remark_office_omr_overview_c/using_the_template_editor_overview.htm
file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/remark_office_omr_overview_d/processing_forms_overview.htm
file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/remark_office_omr_overview_d/reviewing_exceptions_overview.htm
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exception cases as you process the forms or after the forms are processed. Remark Office 

OMR assists you in the data cleaning process by storing an image of each form as it is 

processed. The software then uses these images to help automate the correction of output 

errors and exception cases without needing to locate the appropriate paper form. 

• Save data and/or use the built-in analysis tool, Remark Quick Stats®. Save the data to many 

output formats, including Access, Excel, SPSS, Oracle, SQL Server, ODBC, etc. Or, use the 

analysis program included with the software, Remark Quick Stats, to tabulate your survey or 

grade your test. If you use Remark Quick Stats, you can take advantage of powerful grade 

results, crosstabulations, graphs, charts and more. 

  

This user’s guide file is designed to provide information about all of the features of the software as well as 

guidelines for using the software. Software features are not only described, but you are also given steps 

for how to use the features. Items taken directly from the software, such as menus, buttons and dialogs, 

are in bold format whenever they are used in an instructional context. 

You are encouraged to read the user's guide before designing your own forms or using the software with 

your own forms. There are two tutorials included with the software, which are accessed by clicking 

Start|Programs|Remark Office OMR|Documentation|Tutorials (and from the Help menu in the software). 

The tutorials are PDF files that can be printed or read on-screen (you need the Adobe Acrobat Reader to 

use these files: www.adobe.com). The help file and the user's guide contain answers to many of the 

common questions and/or problems users potentially face. 

Getting to Know Your Software 

The Remark Office OMR software has three basic parts: 

• The Template Editor: You use the Template Editor to create template definitions for the forms you 

want to process. 

• The Data Center: You use the Data Center to read filled in forms, clean up the data and save the 

data. 

• Remark Quick Stats: You use Remark Quick Stats to analyze a survey or grade a test. 

Each part of the software has a similar layout with a main working window and a task pane to the left. The 

task pane shows you the possible things you can do based on where you are in the software. For example, 

if you just scanned filled in forms, the task pane gives you options to run Review Exceptions to clean your 

data and save options for saving your data. All of the functions in the task pane can also be found on the 

toolbar and in the main menus. You can also access help from any screen via the Help menu or by 

pressing F1. Remark Office OMR supports basic Windows functions that you see in most desktop 

software, such as: 

• Cut, Copy, Paste from the Edit Menu (shortcut keys also supported) 

• Home and End Keys in the Data Grid 

• File|Save and File|Save As 

• File|Print 

• File --> Recent File Access 

file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/remark_office_omr_overview_e/saving_data.htm
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• Edit|Find/Replace  

• Edit|Sort 

• Tools|Spell Check 

The software also has two tutorials included: a basic test and a basic survey. We strongly suggest 

performing the tutorial that applies to your applications. We recognize that you are using a wide variety 

of forms with the software, so these tutorials are designed to provide guidance on the basic functions of 

the software, which you can then apply to your specific forms. The tutorials are accessible from the Help 

menu. You will also find all of the user documentation under the Help menu. In addition, there are many 

video trainings and overviews on our website and YouTube channel. 

Processing Tests Overview 

If you are grading tests in Remark Office OMR, here are the basic steps for processing a test in Remark 

Office OMR and getting test results:  

1. Create a test or test answer sheet, or choose one of the included answer sheets.  

• Using Included Templates: If you would like to use our answer sheets, first launch 

Remark Office OMR. The standard templates are then copied to your Documents library 

under Remark Office OMR\Templates\Gravic (use Windows Explorer to find this folder). 

Word versions of the files are included if you want to make modifications. Ensure that 

your changes still meet our form design guidelines. If you change the forms, be sure to 

reset the template image to match using Tools|Reset Images in the Remark Office OMR 

Template Editor. 

• Creating Forms: You can create your own test answer sheets in Word® or anywhere you 

are comfortable. Be sure to follow our form design guidelines when creating your forms 

and utilize our free form review service to check them over before using them. There are 

also other sample answer sheets on our website: www.gravic.com/remark if you need 

some help getting started.   

2. Create a template for your form in the Remark Office OMR Template Editor.  

You can access the Template Editor from the Remark Office OMR Data Center or by clicking 

Start|Programs|Remark Office OMR|Remark Office OMR Template Editor. Creating a template tells 

the software where to look for data on your form and what to output. You only have to create the 

template one time per form. You can set up testing parameters, such as allocating points earned 

(the default is 1 point per correct response), setting up extra credit and allocating points for 

subjective (non-multiple choice) or rubric style questions. Don’t worry about setting up an answer 

key yet… you will do that later in the process. Remember to use the same quality form as you will 

be distributing to respondents when you set up your template (e.g. if you photocopy forms, use a 

blank photocopy for the template). 

Don't forget to test your form and template before administering the test to make sure it works 

well (print a few out and fill them out like your students will and then scan them in).  

• Tip: If you want to have a few standard answer sheets, create the documents then create 

one template and copy it to make the other templates. You can reset the template image 

to another form and then make modifications instead of starting from scratch each time. 

http://www.gravic.com/remark/support/training/
http://www.youtube.com/user/RemarkSoftware?feature=creators_cornier-http://s.ytimg.com/yt/img/creators_corner/YouTube/youtube_32x32.png
http://www.gravic.com/remark/support/office/formdesign.html
http://www.gravic.com/remark/support/office/formdesign.html
file://///CESIUM/Corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/Remark%20Office%20OMR%202014/!SSL!/Printed_Documentation/www.gravic.com/remark
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3. Administer the test. 

Have your students take the test. 

4. Scan your filled in test sheets.  

You can either scan test answer sheets to an image file (this is common if you use a muti-function 

printer) or scan them directly into Remark Office OMR with a TWAIN scanner. If you want to 

bubble in an answer key, scan it along with the rest of your tests, putting it at the top of the stack 

of forms. This is the easiest way to get an answer key into the software.  

If you are scanning outside of Remark Office OMR, we strongly recommend you use the TIFF 

format for your images. When you are ready to process the tests, click the Read link from the task 

pane and choose to read from a scanner or import your images. Follow the steps in the Read 

window to complete the process.  

5. Review the results.  

If there are any problem areas, such as blank responses or multiple responses, they are flagged in 

the data. Run Review Exceptions from the task pane to clean them up.  

6. Grade your test.  

If you scanned an answer key as your first form, click the Quick Grade button. The tests are 

graded according to the scanned answer key and any grading options you set up in the template. 

If you want to do more advanced grading or didn’t scan an answer key, click the Advanced 

Grade button, where you can turn off grading for questions, change point values, allow multiple 

correct responses, set up learning objectives, set benchmarks and modify your grade scale.  

7. Export data and test results. 

If you want to get the data or reports out of Remark Office OMR, click the File|Save options. For 

data, there are several formats in the list, including CSV, which is the most commonly accepted 

format in other programs. For graded results, you can choose to export full reports to PDF or 

Excel, or you can export the grades (with or without the actual data) to various formats including 

CSV and Excel. 

  

This topic is meant to help you understand the steps to take when using Remark Office OMR for test 

grading. For more detailed information about any of the topics above, please see the appropriate section 

of this file. Some related links are included below. 
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Processing Surveys Overview 

If you are working with survey-style forms, here are the basic steps for processing a survey form in 

Remark Office OMR and getting results:  

1. Create a form. 

You can create your own forms in Word® or anywhere you are comfortable. Be sure to follow our 

form design guidelines when creating your forms and utilize our free form review service to check 

them over before using them. There are also sample forms on our website: 

www.gravic.com/remark if you need some help getting started. 

2. Create a template for your form in the Remark Office OMR Template Editor.  

You can access the Template Editor from the Remark Office OMR Data Center or by clicking 

Start|Programs|Remark Office OMR|Remark Office OMR Template Editor. Creating a template tells 

the software where to look for data on your form and what to output as data. You only have to 

create the template one time per form. You can set up processing and analysis parameters, such 

as which questions identify respondents, how to handle multiple responses and add question text 

so that your reports are more meaningful. Remember to use the same quality form as you will be 

distributing to respondents when you set up your template (e.g. if you photocopy forms, use a 

blank photocopy for the template). Don't forget to test your template before administering the 

form to make sure it works well (print a few out and fill them out like your respondents will and 

then scan them in).  

3. Administer the survey.  

Have your respondents fill out the survey. 

4. Scan your filled in forms.  

You can either scan forms to an image file (this is common if you use a muti-function printer) or 

scan them directly into Remark Office OMR with a TWAIN scanner. If you are scanning outside of 

Remark Office OMR, we strongly recommend you use the TIFF format for your images. When you 

are ready to process the forms, click the Read link from the task pane and choose to read from a 

scanner or import your images. Follow the steps in the Read window to complete the process. 

5. Review the results.  

If there are any problem areas, such as blank responses or multiple responses, they are flagged in 

the data. Run Review Exceptions from the task pane to clean them up.  

6. Analyze your data.  

The quickest way to run reports on your data is to click the Quick Survey button on the toolbar, 

which opens Remark Quick Stats and several reports. If you want to dive deeper into your 

analysis, click the Advanced Survey option, where you can change properties of individual 

questions and create groups of questions to analyze together.  

7. Export data and results. 

If you want to get the data or reports out of Remark Office OMR, click the File|Save options. For 

data, there are several formats in the list, including CSV, which is the most commonly accepted 

format in other programs. For tabulated results, you can choose to export full reports to PDF or 

Excel, or you can export the data and statistics (with or without the actual data) to various formats 

including CSV and Excel. 

  

http://www.gravic.com/remark/support/office/formdesign.html
http://www.gravic.com/remark
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This topic is meant to help you understand the steps to take when using Remark Office OMR for survey 

data collection and analysis. For more detailed information about any of the topics above, please see the 

appropriate section of this file.  

Support and Maintenance 

Remark Office OMR includes a user's guide and online help. You will also find a knowledgebase on the 

Gravic website, where you will find the answers to frequently asked questions and training videos. In 

addition, there are two tutorials included with the software (Start|Programs|Remark Office 

OMR|Documentation|Tutorials), which we strongly recommend you perform before using the software 

with your forms. Most questions can be answered by consulting these reference materials. 

If a problem with Remark Office OMR arises that cannot be solved using the materials above, customers 

who purchased Technical Support and Maintenance may contact Gravic technical support. Technical 

Support and Maintenance includes unlimited phone and email support as well as software updates. 

Technical support and Maintenance is renewable annually. Please note that without technical support and 

maintenance, you will not receive product updates. 

Before contacting technical support, please gather the following information:  

• The version and serial number of the Remark Office OMR software (you can find this 

information by selecting the Help menu and then clicking About in the software or look in the 

lower right hand corner of the Data Center) 

• The steps required to reproduce the problem 

• The type, model and configuration of your computer and scanner, if applicable  

Gravic's technical support team provides product support to customers with valid Technical Support and 

Maintenance via email, web and phone (610.647.8595. In addition, you will find free support tools on our 

website.  

 

 

 

 

 

 

 

 

 

 

 

 

 

https://remarksoftware.com/
https://vimeopro.com/remarksoftware/remark-office-omr-support-videos
mailto:support@gravic.com
https://remarksoftware.com/support/
https://remarksoftware.com/
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Chapter 2: Software 

Installation and Activation  
Remark Office OMR is installed on a Windows® based computer. Once installed, the software is activated. 

See the following sections for further details on installation and activation. If you need to uninstall the 

software, you may do so via the Windows Control Panel under Programs.  

System Requirements 

The following section provides the system requirements for running Remark Office OMR.  

Minimum requirements: 

• Personal computer with 2 GHz or faster processor 

• Supported Microsoft Windows® 32-bit and 64-bit desktop operating systems: 

Windows 8.1, Windows 10  

• .NET 4.7.2 (or higher) framework 

• Microsoft Visual C++ 2015 Redistributable Package (will be installed if not present) 

• 2 GB RAM 

• 1 GB free fixed disk space 

• Screen/monitor resolution of 1024x768 or higher and at least 32-bit color 

• Mouse or other pointing device 

Recommended optional requirements: 

• Supported scanner (includes multifunction printer that has scanning capabilities) 

• Windows-supported printer 

• Internet connection recommended for initial software activation and email 

functionality 

• PDF viewer required to view installed documentation 

• Microphone for speech recognition 

• Microsoft Outlook 2007 or greater can be used for email functionality; if not present 

an internal Remark Office OMR email client (using your SMTP server) may be used 

*The software uses activation for license regulation. If you choose to install on a virtual machine (VM), due 

to the nature of how virtual environments behave, activation is required every time the software is run.  
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Installing the Software 

You must run the Remark Office OMR installation program in order to use the software. Install Remark 

Office OMR on a fixed drive with at least 1GB of free disk space. To scan directly into Remark Office OMR, 

you must install the software on the same system to which the scanner is attached. (Note: Scanners can be 

used if they are not connected to the PC running Remark Office OMR. You must first scan forms and save 

them as image files outside of Remark Office OMR. Then the software reads those images.) Before 

installing the software, make sure you are an administrator on your computer. Each single license of the 

software can only be installed on a single computer, which is validated through activation of the license 

after installation. 

If you are upgrading to Remark Office OMR 10 from an earlier version, do not install the software in the 

same directory as your previous version. Once the installation is complete, you can copy information from 

your old installation that you want to use in the new version (e.g. form templates, data, etc.). 

• Note: Form template files, RMK/RMX/ROA/ROX data files, answer keys (AKY) and survey 

definition files (SDF) are not backwards compatible. Remark Office OMR 10 converts these files 

from previous versions of the software automatically. However, once a file has been converted, it 

cannot be opened in a previous version of the software. Always make copies of these files before 

converting them. 

  

To install Remark Office OMR 

  

1. Double click the file you downloaded. 

2. Follow the on-screen instructions to display the Remark Office OMR Installation window. 

• Note: The .NET 4.6.1 Framework is required to install Remark Office OMR. If you do not have 

it installed on your system, you are prompted to install it. Once the .NET Framework 

installation completes, the Remark Office OMR installation resumes normally.  

3. Follow the on-screen instructions to complete the installation. You are prompted for a serial 

number and authentication code. You can find this information in the email that you received 

when you purchased the software. 

4. Some operating systems may ask whether you wish to install the software for all users or only the 

person currently logged into the computer. In most cases, and especially if multiple people use 

this computer and need to use Remark Office OMR on this computer, you should choose the 

option for "all users." 

5. When the installation completes, click the Finish button to close the installation program.   

Please retain the download in case you need to reinstall the software in the future. Once the download 

completes, you may run the software. You may be prompted to activate the software. When you first run 

the software, folders are created in your Documents folder under Remark Office OMR for you to store files 

for use within the software (using these folders is optional). 
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Software Activation 

Remark Office OMR requires activation in order to run on your computer. Activation means that the copy 

you have installed is licensed to the computer. Once the software is activated, it cannot be installed on 

another computer without deactivating it from the current computer. You may activate your software over 

the Internet (recommended) or through a manual (offline) method. 

The first time the software runs it attempts to activate. If you are connected to the Internet, the activation 

is seamless. It will connect to the Gravic server to ensure that the license is not already in use, and then 

activate automatically. There is nothing else you need to do. Note that the software also validates 

activation periodically. 

Manual Activation 

If you do not have an Internet connection, you can activate the license manually. You are provided with a 

“token,” which is a file with a “.key” extension. You save that file and then take it to a computer with 

Internet connectivity. You upload the token, which activates your software. Then an activation key is 

returned to you to take back to the computer without Internet connectivity. 

We strongly suggest printing the manual activation steps so that you can easily follow them.  

Please use the following steps: 

 When the Software Activation Required 

window appears, click the link for Want 

to activate manually? 

 Under Step 1, click the blue “here” text to 

receive an activation token (file). Save the 

file on your computer or network. 

 Take this token to a computer with 

Internet access.  

 Log on to https://activations.gravic.com. 

 Upload the token from Step 2.  

 You receive an activation key in return. 

 Go back to the computer with Remark 

installed and click the link for Do you have 

an activation key? 

 Select the key from Step 6 and click OK. 

The software is now activated. Note that the software 

also validates activation periodically so you may need 

to repeat these steps if the computer running Remark 

is always offline (not connected to the Internet). In 

this case, you receive messages that you need to activate. There is a Software Activation link under the 

Help menu that you can access to perform the same steps above. 

https://activations.gravic.com/
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Transferring a License 

The Gravic software license agreement states that any one copy of the software can only be installed on 

one computer. If you need to transfer your software to another computer, you may deactivate the license 

on one computer and then activate the software on the new computer. Transferring a license typically 

occurs when something happens to your computer and you acquire a new one, or when the person using 

Remark leaves and you need to assign the license to a new person. Note that once a license is deactivated 

on a computer, it cannot be activated on that computer again. You will need to contact Remark Support 

in this case.  

  

To Transfer a License: 

1. Install the software on the new computer. 

2. Run Remark. You are prompted that a message indicating there are no activations available. Click 

the link for Want to transfer your license? 

3. A list of previous activated computer(s) is 

presented. You can choose to deactivate 

the license from a computer in the list 

and activate it on the current computer. 

This action is most likely if you 

reformatted your computer or received a 

new computer. If you do not recognize 

the computer(s) listed we recommend 

contacting your IT department to ensure 

that you deactivate the proper computer. 

Once a computer is deactivated, Remark will no longer run on that computer. 

• Note: Remark Support cannot help you decipher the list of activated computers, as 

this is internal to your 

organization. If you are 

unsure what to deactivate, 

you must contact your 

internal IT help desk to 

assist you. 

4. Read the warning that states I 

understand that Remark Office OMR 

will no longer run on my old 

computer and then mark the checkbox 

next to it to accept this statement. 

5. Click the Transfer button. 

The license is now transferred to the new computer. After a few seconds, Remark Office OMR will run on 

your system. The software is now inoperable on the old computer and can be uninstalled (if available). 
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Chapter 3: General Scanner 

Information 

Scanner Overview 

Scanners come in many different flavors, but the two types typically used with Remark Office OMR are 

desktop scanners and multi-function printers (MFP). A desktop scanner is connected directly to the 

computer, typically with a USB cable, running Remark Office OMR. In this case, you use the scanner's 

TWAIN driver to scan pages into Remark Office OMR. An MFP can print, scan, copy and sometimes fax, 

and is usually used over a network. Some MFPs also have TWAIN drivers and can scan directly into 

Remark Office OMR. You can also use a wireless scanner to send pages through and save the resulting 

files on a computer or in the cloud. 

How you perform scanning varies depending on the type of scanner you are using. Use the links below to 

understand each type:  

Direct Scanning with a Desktop Scanner 

Scanning to Image File with an MFP or Non-TWAIN Scanner 

Direct Scanning with a Desktop Scanner 

Scanners communicate with Remark Office OMR through a TWAIN driver. TWAIN is a standard for 

controlling scanning equipment. Most scanners ship with a TWAIN driver. If you are uncertain whether 

you have a TWAIN driver, check with your scanner manufacturer. 

• Note: Individual scanner manufacturers write their own scanner drivers. The TWAIN standard 

leaves some areas unclear/open for interpretation, and as a result, the functionality of some 

TWAIN drivers is questionable. Remark Office OMR supports the TWAIN protocol, however, since 

scanners come onto the market so quickly and different companies have different software 

quality standards, Gravic, Inc. cannot guarantee that all TWAIN drivers work correctly. Scanner 

manufacturers typically revise TWAIN drivers frequently to correct for any problems; therefore it is 

a good idea to check for updated drivers for your scanner from time to time. Manufacturer 

websites often have updated drivers available for download. 

When scanning in Remark Office OMR with a TWAIN driver, there are several basic settings that you want 

to use. Remark Office OMR supports color and grayscale scanning. However, it is not necessary. Most 

scanners achieve optimum scanning rates when used in black and white scanning mode. If you choose to 

scan in grayscale or color, you will likely experience slower scan rates. The resolution on the scanner, 

measured in dots per inch (DPI), should be set at 200-300 DPI. 200 DPI is usually sufficient, but you may 

wish to use 300 DPI if you are scanning barcodes or using OCR (optical character recognition). You should 

also verify that the page size your scanner is using matches the actual paper size you are scanning. You 
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can also utilize the scanner's brightness (sometimes called threshold) and contrast settings to make 

scanned images lighter or darker. Under normal conditions, you want to use the scanner's default 

brightness and contrast settings. If, however, you need to make shading or a lightly colored paper 

background drop out (disappear), you could raise the brightness setting to accomplish these tasks. On the 

same token, you could set the brightness setting to a darker level to help compensate for light marks or 

lightly filled marks on forms. 

• Tip: It is important to remember that the settings used to create the form template should 

also be used to scan the filled-in forms in order to maintain a level of consistency and achieve 

optimum recognition rates. 

In order to select a TWAIN source in Remark Office OMR, the TWAIN driver must first be installed. Consult 

your scanner's documentation for installation instructions and information about obtaining a TWAIN 

driver for your scanner. Once the driver is installed, use the following procedures to select the scanner in 

Remark Office OMR. 

  

To select and configure a scanner 

1.  From the Remark Office OMR Data Center, select the Tools menu and then click Scanner 

Properties to display the Scanner Properties 

window. 

2. Click the TWAIN Source drop-down arrow to 

display a list of TWAIN compliant scanners that 

are available on your system. 

• Note: Your scanner must be turned on and 

connected to the computer, and you must 

install your scanner's TWAIN driver in order 

for the scanner to display in this list. 

3. Click the appropriate scanner to select it. 

• Note: Some versions of Windows come with 

Windows Image Acquisition (WIA) drivers. If 

you see two drivers for your scanner, we do 

not recommend selecting the one beginning with WIA. Whenever possible, it is better to use 

the driver provided by the manufacturer. 

Once your scanner is set up, there are many possible properties to set:  

Parameters 

The following Scanner Properties are available in the Parameters section: 

Resolution:  

Use the Resolution setting to set the scanning resolution in Dots Per Inch (DPI). We recommend scanning 

at 200-300 DPI. This setting is not available if you have chosen to show the scanner's TWAIN interface 

(you select DPI when you scan a page).  
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Color Depth: 

Use the Color Depth setting to choose a scanning mode: Black/White, Grayscale or Color. For most cases, 

scanning in Black/White is fine and recommended. However, if your scanner supports grayscale or color 

scanning, you may select to use it here without having to do so in your scanner's TWAIN driver. Scanning 

in color or grayscale may be appropriate if you plan to use the images outside of Remark Office OMR or 

have dropout colors on your form. Note that scanning in color or grayscale slows down scanner and 

software performance. 

Brightness: 

Use the Brightness setting to set the scanner's brightness. We recommend scanning at your scanner's 

default brightness setting unless you encounter problems. The default setting in Remark Office OMR is 0. 

This setting is not available if you have chosen to show the scanner's TWAIN interface (you select 

brightness when you scan a page). Use a positive number to scan lighter and a negative number to scan 

darker.  

Contrast: 

Contrast is the difference between the color or shading of printed material on a document and the 

background on which it is printed. Most scanners can adjust contrast for a sharper image. Use the 

Contrast setting to set the scanner's contrast when scanning in grayscale or color. We recommend 

scanning at your scanner's default contrast setting unless you encounter problems. The default setting in 

Remark Office OMR is 0. This setting is not available if you have chosen to show the scanner's TWAIN 

interface (you select contrast when you scan a page). Use a positive number to lighten the contrast and a 

negative number to darken the contrast. 

Image Processing Options 

The following Scanner Properties are available in the Image Processing Options section:  

Despeckle Images: 

Mark the Despeckle Images checkbox to remove speckling from the image. If you scan your forms and 

see black specks on the form, this is speckling. Note that sometimes scanning at a lighter brightness 

setting on your scanner can also remove speckling. We recommend only turning on this feature if you are 

having trouble with speckled forms. 

Maximum Speckle Size to Remove: 

Use the Maximum speckle size to remove option to select the pixel size to remove when using the 

Despeckle Images option. A pixel by definition is the smallest piece of information in an image. Pixels are 

represented using dots or squares. The default setting is 2 pixels. Use a higher number to remove larger 

speckles. Note that if you go too high, you run the risk of removing or damaging the marks (bubbles, 

checkboxes) on your form image. 

Deskew Image: 

Use the Deskew image option to have Remark Office OMR automatically correct for skewing during the 

scanning process. Skewing can occur when pages are not fed neatly in the scanner's ADF or if your 

scanner pulls in the pages unevenly, in which case you may want to have your scanner serviced. In either 

case the result is a crooked image, which can make it hard for the software to read the marks on the 

image. We recommend only turning on this feature if you are having trouble with skewed forms. 
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Invert Image: 

Use the Invert image option to correct an image that scans in reverse: black background with white text. 

The default setting is No. You only need to adjust this setting if your image comes in reversed. 

Rotate Front Side: 

Use the Rotate front side option to rotate the front side of each page that is scanned. Select the rotation 

degrees in the box provided. Only use this option if the front side of your form does not rotate correctly 

on its own. 

Rotate Back Side: 

Use the Rotate back side option to rotate the back side of each page that is scanned when scanning 

duplex (two sides at one time). Select the rotation degrees in the box provided. Only use this option if the 

back side of your form does not rotate correctly on its own. 

Hardware Options 

The following Scanner Properties are available in the Hardware Options section:  

ADF/Flatbed/ADF and Flatbed: 

Choose the option that matches your scanner: Flatbed Only, ADF (automatic document feeder) only or 

Flatbed and ADF. 

Duplex Scanner: 

Select the Duplex scanner checkbox if the scanner you are using has duplex capabilities for double-sided 

form scanning (meaning the scanner can scan both sides of a piece of paper at one time).  

Scanner Options 

The following Scanner Properties are available in the Scanner Options section:  

Scan Duplex: 

Mark the Scan duplex checkbox if you have selected a duplex scanner and wish to scan both sides of a 

page at one time. This feature is used for scanning double-sided forms. 

Show TWAIN Interface: 

Mark the Show TWAIN interface checkbox to show your scanner's TWAIN interface. By showing the 

scanner's interface, you can setup scanning parameters. We recommend turning this selection on initially 

to verify your scanner's settings (e.g. scanning mode, page size, resolution, brightness). Some scanners, 

but not all, support having the interface hidden. Once you verify all the settings within the scanner's 

interface, you can try turning off the TWAIN interface so that you do not have to see it every time you 

scan. 

Show Scanning Progress: 

Mark the Show scanning progress checkbox to show the scanner's progress indicator as pages are being 

scanned. Please note that not all scanners support this feature. Some scanner drivers always show 
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scanning progress and some never show scanning progress. If the scanner's driver allows applications to 

control the scanning progress indicator, marking this checkbox enables the feature. 

Center Feed Adjustment: 

Mark the Center feed adjustment checkbox to have the page aligned with the center portion of the ADF, 

regardless of how the ADF is positioned. This feature is useful when scanning pages that are smaller than 

8.5x11 inches. An adjustment is made so that the image does not start at the left most part of the scanner 

and cutoff a portion of the image (which can happen on some scanners even if the ADF is in the center 

position). Please note that some scanners have this property built in to their drivers, and some do not 

support this feature at all. 

Scan Ahead: 

Mark the Scan Ahead checkbox if your scanner supports this feature. Scan Ahead allows the scanner to 

scan pages faster than processing occurs. It keeps the scanning moving so that there are not significant 

pauses while any processing takes place.  

Scanning to Image File with an MFP or 

Non-TWAIN Scanner 

A multi-functional printer, or MFP, is a printer that also scans, copies and sometimes faxes. These all-in-

one units are becoming increasingly popular to automate workflows. Some MFPs are connected directly 

to a computer, while most are free standing and attached to your network. If you wish to utilize an MFP 

for scanning, you may do so with Remark Office OMR. 

When using an MFP that is connected directly to the computer running Remark Office OMR, you scan 

documents just as you would with any desktop scanner. 

When using an MFP on your network (not connected directly to a computer), you may scan the forms at 

the MFP and save them as image files, using the MFP's scanning software. Most MFPs can save images as 

TIF or PDF files. Remark Office OMR can then read those image files. Remark Office OMR users commonly 

scan the forms as TIF image files and save them on a network drive. Then they go to the computer where 

Remark Office OMR is installed and read the images from the network drive. You can also email the 

images to yourself, and then save the files from the email to a place on your computer or network. If you 

are using a networked MFP, you can determine the workflow that works best for you and your 

organization.  

• Tip: If you have the choice of TIF or PDF images, choose TIF. PDF files are not native image files 

and require more processing by Remark Office OMR. The result is that the scanning process is 

slower. TIF Group IV images are the most compressed for smaller file sizes and faster processing. 

Some network MFPs offer a network TWAIN driver that allows you to control the MFP from the computer 

running Remark Office OMR. Depending on the quality of the network TWAIN driver, you may be able to 

utilize it within Remark Office OMR. When using an MFP that has a network TWAIN driver, you scan 

documents just as you would with any desktop scanner. 

 

To import images scanned on an MFP or Non-TWAIN Scanner: 
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1. Scan the filled in forms on the MFP, preferably as a multi-page TIF file. 

• Note: Talk to your IT staff about ways to optimize your MFP with profiles that allow the MFP 

to be preconfigured so that when you scan the documents are automatically in TIF format 

and to go a folder on the network. 

2. Open Remark Office OMR on your desktop. 

3. Open the desired template file by clicking File|Open Template. 

4. Click the Read option in the task pane. 

5. Select the Read Images button, if not already selected. 

6. Click the Next button. 

7. Choose the image(s) that you scanned in step 1. 

8. Click the Finish button.  

The images are read and your data is visible in the data grid. From here you can save the data or run 

Review Exceptions to clean the data. 
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Chapter 4: Creating Forms  

Creating Forms Overview 

Remark Office OMR provides a flexible solution for scanning forms you create and producing data and 

reports. Because there is so much flexibility, a wide variety of forms can be created. Good form design is a 

key component to using Remark Office OMR successfully. Therefore, we have created a set of form design 

guidelines to help you create forms that will work well with the software. Remark Office OMR works with 

plain paper forms; no special inks or marks are needed. Respondents can use pen or pencil to complete 

the forms. 

• Note: Remark Office OMR is not a form designer. Forms used with Remark Office OMR are 

created independently of the software in programs such as word processing and survey design 

packages. 

  

Where do I create forms? 

The first step in designing a scannable form is determining where you prefer to design the form. Some of 

your options include: 

• Word processing software 

• Survey design software 

• Form design software 

Word processing software (e.g. Microsoft® Word®) is commonly used for creating forms, as many people 

already have this software and are familiar with using it. If you are comfortable with word processing 

software, this may be the best choice for you. 

Software created specifically for survey design and analysis can offer the additional benefits of question 

banks (the ability to draw and save questions to and from a question library), layout assistance and 

analysis components. Form design software can give you advanced layout tools to create professional 

looking forms. 

Determining what software application to use is an individual decision. You should base your decision on 

what you are comfortable with using, your budget and your overall data collection needs. No matter what 

your choice, the design guidelines set forth in this file apply. Please read through them thoroughly before 

undertaking your own form design. 

Sample test answer sheets are included with the software. They are found in your Windows Documents 

library: \Documents\Remark Office OMR\Templates\Gravic once you run the software. Just remember that 

if you modify a form, you will need to reset the image provided with the template file so that it matches 

your version of the form. You can also find sample forms on our website that you are welcome to 

download and modify to suit your needs.  

Once you decide what tool you will use to create forms, the following guidelines apply: 
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Mark and Character Selection 

Important Keyword: Mark: A mark is any type of complete shape used on a form. Respondents darken 

the marks to indicate their answer choice. Marks are typically bubbles or checkboxes on OMR forms.  

Forms need to be created so that Remark Office OMR can recognize the data on them. Remark Office 

OMR recognizes optical marks, which include bubbles (a circle or oval), checkboxes, etc., that respondents 

darken with a pen or pencil to indicate their response. Although Remark Office OMR works with almost 

any complete shape (e.g. circle, square, triangle), experience indicates that bubbles between 10 and 14 

points in height work the best. Non-oval shapes are somewhat harder to fill completely. Respondents 

typically fill bubbles more completely and neatly, which leads to better recognition rates. If you need to 

use a checkbox, we recommend our OMR Checkbox font that installs with the software. 

When using word processing software, we recommend using a capital "O" in an Arial font. You may also 

use our OMR Bubbles fonts, which creates a circle or square with a letter or number (e.g. ). The OMR 

Bubbles fonts install with the Remark software. They can also be downloaded from the Gravic website. 

Once installed, you may access the fonts from Windows applications on your computer just as you would 

any other font. While it is possible to place numbers or letters inside of marks, the number/letter must be 

as small and light as possible. Dark, thick or bolded characters may cause Remark Office OMR to interpret 

the mark as being filled. Therefore we recommend using our tested OMR Bubbles fonts if you require 

encircled numbers or letters. 

We do not recommend creating bubbles using the Times New Roman font, which may be the default font 

in some word processing programs. This font does not create an evenly defined bubble and can therefore 

break apart when scanned. Using the Arial font yields a well-defined bubble that scans consistently. 

OCR 

Remark Office OMR includes the capability to recognize machine printed text. This functionality is called 

OCR, or optical character recognition.  

• Note: OCR does not include handwriting recognition (commonly called ICR or intelligent 

character recognition). In order to use the OCR feature, the text must be machine or computer 

generated. 

While the software's sensitivity level can be adjusted, certain fonts and font sizes recognize better than 

others. We recommend using a common font such as Arial or Times New Roman. You do not want to 

select a handwriting style font. The font size should be a minimum of 14 points (even larger is better), and 

you do not want to use bold, underline or italics formatting. If you notice areas where letters almost touch 

each other due to the shape of the letter, we suggest increasing the character spacing slightly, which is 

supported by most word processing applications. When scanning forms, a scanning resolution of 300 DPI 

(dots per inch) is recommended. Always test your forms with the Remark software to ensure that the 

characters are recognized properly before you print and distribute large quantities. 
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Form Spacing 

Allowing enough white space on a form is an important part of good form design. Allow at least 3/8 inch 

of space between any text, lines or graphics on the form and all user-markable areas (bubbles, 

checkboxes, barcodes, text you plan to read using OCR, etc.). The white space around your marks provides 

a buffer that can help Remark Office OMR accommodate scanner skew, form offset and not-so-perfect 

markings from your respondents. 

The more white space you have, the better Remark Office OMR is able to tolerate differences from form to 

form. In contrast, the more crowded a form (or the less white space there is), the harder it is for Remark 

Office OMR to compensate for form differences. 

Although groups of bubbles need to be 3/8 inch away from any visible lines or text, the individual bubbles 

within the group can be as close to one another as one or two character spaces. 

We recommend staying away from the use of lines or boxes around or between the marks on a form. If 

you find it necessary to use lines or boxes, you may make them a light gray that drops out (completely 

disappear) during the scanning process. In addition, follow the spacing guidelines above. 

• Note: You cannot photocopy forms that use gray lines as the gray becomes too dark. Only use 

clean printouts for forms utilizing gray lines.  

Margin space along the edges of a form is important. We recommend leaving a one inch margin around 

all sides of the page. At a minimum, do not go below ½ inch margins. The margin space allows some 

shifting in forms without having the marks fall off of the page when scanned. The smaller the margin, the 

less tolerance you have for inconsistencies from form to form. 

Positioning all of the marks for the same question type in a single region area minimizes your efforts 

when you create form templates within the software. Whenever possible, try to place similar types of 

questions together. For example, place all true/false questions in one area of the form and all multiple 

choice questions in another. All marks you want to define in a single OMR region must align horizontally 

and vertically. 

When possible, place the labels for a group of questions on the top of each column or at the beginning of 

each row (at least 3/8th inch away from the marks); this allows you to select the entire group of questions 

within one region when you create a form template in the software. If the labels are between marks, you 

may have to select questions individually and/or link marks together to form logical questions. 

Shading and Lines 

Remark Office OMR works best with marks printed in black ink on white paper without shading. While we 

do not recommend the use of shading in areas containing marks, you can create shading that completely 

drops out when scanned (a 5-10% gray typically works well). A better alternative is to shade the questions 

but leave the area containing the marks white. Similarly, we do not recommend putting visible lines 

between rows of bubbles or anywhere within 3/8 inch of the bubbles. If you must use lines, again, you can 

use a light gray that drops out during scanning.  

• Note: You cannot photocopy forms that use shading or lines as the shading and lines become 

too dark. Use clean printouts for forms utilizing shading. 
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Always test your form with your scanner before printing large quantities. Shading varies from printer to 

printer and scanner to scanner. If your scanner supports color drop-out, you can shade questions using a 

pale shade of one of the colors your scanner drops out. Note that this may slow down the scanning 

process and should be thoroughly tested before printing and distributing forms. 

Barcodes 

Remark Office OMR can read many types of barcodes. Barcodes can be used to capture a variety of 

information, including, but not limited to, names, ID numbers, session/class numbers, other demographic 

information, etc. The software recognizes the following barcode types:  

• Code 3 of 9 (Code 39): Alphanumeric 

• Interleaved 2 of 5: Numeric 

• Codabar: Numeric 

• PDF 417: 2D, Alphanumeric 

• Data Matrix: 2D, Alphanumeric 

• QR Code: 2D, Alphanumeric 

• Code 11: Numeric 

• Code 128: Alphanumeric 

• Code 93: Alphanumeric 

• EAN 13: Numeric 

• EAN 8: Numeric 

• UPCA: Numeric 

• UPCE: Numeric  

You may put one or more pieces of data within one barcode. If using multiple pieces of data in one 

barcode, you must separate the data with some character (called a delimiter), such as a space, comma or 

tab. Remark Office OMR outputs the individual pieces of data to separate cells in the data grid when the 

forms are processed. 

Use the following guidelines when placing barcodes on your forms:  

• Barcodes should be at least 26 points in terms of size (about 1/4 inch high). 

• Barcodes may be placed on forms horizontally or vertically. 

• If using barcode stickers, place a lightly colored placeholder on the form so that the person 

affixing the stickers to the form knows where to place the barcodes. The barcodes must be in the 

same place on each form in order for Remark Office OMR to recognize them. Ideally, the 

placeholder should be covered by the sticker or light enough to drop out (completely disappear) 

when scanned. You do not want the placeholder to interfere with recognition of the barcode. 

• Do not put text, lines, etc., within ½ inch of the barcode (*with the exception of the tip below). 
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• Tip: If you would like to be able to read the barcode with the human eye, place the text of the 

barcode in small, light print directly beneath the barcode. 

The Code 3 of 9 Barcode 

The Code 3 of 9 barcode is created by installing the Code 3 of 9 barcode font. This font installs 

automatically with the Remark software or can be downloaded from the Gravic website. 

When using the Code 3 of 9 barcode font you need to begin and end the barcode with asterisks. These 

asterisks become bars in the barcode and are necessary for proper recognition of the barcode. Without 

these asterisks, Remark Office OMR cannot read your 3 of 9 barcode. Use caution as some word 

processing applications use the asterisks as an auto formatting feature to bold the text and drop the 

asterisks. Check your form design's program options for this auto formatting feature. In addition, do not 

use spaces in the barcode. If you need to represent a space, use the exclamationpoint (!) character. The 

Code 3 of 9 barcode always outputs letters in upper case.  

Example: To barcode the name Jane Doe, you would type: *Jane!Doe* and then convert the entire 

sequence to the Code 3 of 9 barcode font. 

Paper Selection 

Remark Office OMR works best with plain white paper and black ink. Utilizing standard 20# copier paper 

works well for single sided forms and 28# or higher paper works well for double-sided forms (heavier 

paper helps avoid bleed-through). While we recommend using white paper for the best recognition, you 

may use colored paper (pastel colors tend to work well), as long as the color completely drops out when 

scanned. Test your paper selection with your scanner before printing large quantities of your forms. 

• Tip: You can test colored paper by scanning a form in the Remark Office OMR Template Editor. 

The resulting image should have a white background with black text. If you see speckles or other 

black marks in the background, your paper may be too dark. You can try raising the brightness 

setting on your scanner to see if the rest of the color from the paper drops out without 

compromising the marks on the form. 

Remark Office OMR supports any paper size or thickness supported by your scanner. Consult your 

scanner's user's guide for further information about what your scanner can handle.   

Duplicating Forms 

When reproducing forms, quality and consistency can reduce form processing errors. You have the 

flexibility to duplicate forms in several ways: using a laser printer, a high quality photocopier or a 

professional printer. Consistency from form to form is important. Try to use the same source to duplicate 

all of the forms you will need for a single form type. 

When photocopying forms, the accuracy of page placement into the photocopier and your overall form 

design are the limiting factors as to how large your margins must be in order to minimize errors. Forms 

with inadequate spacing have a low tolerance for offset/skew. Carefully placing forms directly on the 
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photocopy machine's glass tends to yield better copies than using the document feeder, which can skew 

the page as it is pulled into the copier. Test your form by creating a form template in the software and 

processing a batch of forms that are filled out as you expect to have them returned (e.g. not perfectly) 

before printing large quantities. Once you feel that your form design is adequate, try to photocopy all of 

the forms that you will need in one batch. This eliminates the need to make photocopies from 

photocopies at a later date, which can lead to form inconsistencies. 

Regardless of how you duplicate your forms, be sure to keep blank copies on hand. You always want to 

create your Remark Office OMR template using the same quality form that you distribute to your 

respondents. For example, if you photocopy your form, use a blank photocopy to make the form template 

in the software. 

It is best to maintain as much control over form duplication as possible. However, if your workflow is such 

that multiple locations print and distribute their own forms, request that at least one blank copy of the 

form is returned to you with the filled in forms from each location. This allows you to realign your 

scanning template to the printout if you find that the forms have shifted significantly. 

• Tip: Save forms to the Adobe PDF format to retain original form formatting. If you need to have 

someone else print your form, this format is preferable over other native word processing 

formats. Remember to embed the fonts you use in case the person printing the form does not 

have the same fonts. Do not turn on page scaling or fit options for printing. And remember, do 

not use the PDF to create the form template; always use a blank scanned image. 

Testing Forms 

The best way to know whether you have created a good, scannable form is to test it. Always test any 

forms you plan to use with Remark Office OMR before printing and distributing them. It is much easier to 

find and fix problems before the forms are printed and distributed. 

To test your form, create a form template in the Remark Office OMR Template Editor. Then fill out a 

sampling of forms as you expect to get them back from your respondents (not perfectly!). Scan the forms 

and check your results. If you do not get the accuracy you expect, check your form's design against the 

guidelines presented in the user's guide, and make the appropriate modifications. Remember to use the 

same scanner settings for form template creation and when scanning the filled-in forms. 

Form Review Service 

We will review any form after it is created to ensure it is compatible with Remark Office OMR. You can 

email or fax forms to our technical support department and we will check them for known issues. We can 

often head off potential issues before they become problems. Be sure to use this service before you print 

and distribute your forms. We recommend checking your form to see if it meets the form design 

guidelines outlined in this file before sending it for review. If the form does not meet our guidelines, we 

will not recommend that you use the form in its current state, and point out the areas that need 

improvement.  
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Chapter 5: Template Editor  

Template Editor Overview 

The Remark Office OMR Template Editor is used to create form templates for the forms you process in 

Remark Office OMR. You must create one form template file for each form that you process with the 

Remark software. The form template file defines all of the information needed for the software to process 

your form correctly. Once a form template is created, the form can be used as often as desired without 

needing to create a new form template (as long as the form does not change). Example: If processing 

student exams, you can create form templates for various forms (e.g. 25 questions, 50 questions and 75 

questions) and then use those form templates as often as needed. 

The form template file holds information about where the marks, barcodes and text are located on the 

page, how many pages your form contains and what type of output you would like. A single template can 

hold up to 150 pages. 

• Tip: The form template is the key to accurate recognition in Remark Office OMR. When creating 

form templates, be sure to use the same quality form as you will be distributing to respondents 

(e.g. if you are photocopying forms, use a blank photocopy for the form template). Also use the 

same scanner and scanner settings for both the form template and filled-in forms (e.g. resolution, 

brightness). 

• Tip: It is strongly recommend that you perform the tutorials included with the software to get an 

understanding of the Template Editor. You can find the tutorials under the Help menu in the 

software or by clicking Start|Programs|Remark Office OMR|Documentation on your computer. 

 

Important Keyword: 

Region: A region is an Image, Barcode, OCR or 

OMR area that you define. A single OMR region can 

contain one or more questions. 

The Remark Office OMR Template Editor contains 

three basic components that you use to create and 

edit your form templates. The left portion of the 

template editor window contains a tree view (an 

item list) with nodes representing each region in 

your template. 

Also in the left portion of the window, you can find 

the task pane. The task pane contains links to 

commonly used features and updates automatically 

based on your selections to help you navigate 

through the software. (Note that you may turn off 

the task pane by clicking View|Task Pane.) The right 

side of the window contains an image 

representation of your form. You provide this image 

via the scanner or a saved image file. You may use 
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the tree view and the image representation area to work with your form template. Each region in the tree 

view contains the properties of that region, which are accessed by double clicking the region. You may 

think of a region as a question or item on your form. You may also double click within a region in the 

image representation area to view the region's properties. 

Once the form template is created, use the File menu to save it (it will have a .omr file extension). Form 

templates can be shared among Remark Office OMR users if you process the same form types.  

Creating New Templates 

Form templates are created in the Remark Office OMR Template Editor. There are two main ways to 

access the Template Editor to create a new form template: 

1. From the Remark Office OMR Data Center, select the File menu and then click New Form 

Template. Alternatively, with the Templates tab selected in the task pane, click New form 

template. 

2. From your Windows Start menu, click Start|Programs|Remark Office OMR|Remark Office 

OMR Template Editor. 

  

To create a new form template 

1. From the Remark Office OMR Template Editor, select the File menu and then click New, to 

begin a new form template. Alternatively, select New form template from the task pane. The 

Properties window appears. This window allows you to specify general information about the 

template, including a description, page size and page orientation. 

2. [OPTIONAL] If desired, enter a description for 

the form template in the Form template 

description box. 

3. Select the appropriate size of the form(s) you 

are scanning in the Page size drop-down box. 

All pages contained in a form template must 

be of the same size. Use the custom option if 

your page size is not listed. (Remark Office 

OMR can recognize any size form that your 

scanner can scan.) 

4. Select the orientation of the form in the Page 

orientation area. You may choose Portrait or Landscape. All pages contained in a form template 

must be of the same orientation. 

• Tip: You may not change the Page Size and Orientation once the form template is created. 

Therefore, make your selections carefully in this window. 

5. Click the Capture Image button to continue.  

The Create Page Elements window appears. From this window, select how you want to import the 

images of your form. You may scan pages directly into the Template Editor or you may import image files 
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(that you previously scanned and saved) of the form. Regardless of how you import these images, 

remember to always base your form template on a blank copy of your form. 

• Note: You must scan the blank form for template creation in order for accurate recognition. Do 

not import a PDF or similar file that did not originate from a scanner. Creating a PDF file directly 

from a document is not the same as scanning a form and producing an image file, and therefore 

your form template does not match the scanned images of your completed forms, leading to 

recognition errors. 

The next step is to determine whether you want to create your template by scanning a page directly from 

the scanner or use an existing image file that you have already scanned.    

Creating New Templates - Scanning the Form 

Once you begin the form template, you need to acquire a blank image of your form. The following 

instructions explain how to scan a copy of your form in order to create the template file.   

 

To create a form template image using the scanner 

1. Continuing from creating form template 

instructions, in the Image Collection 

Method section, click the Scan button. 

2. Note: If you need to configure your scanner, 

you may click Scanner Properties to view 

the Scanner Properties window. 

3. [OPTIONAL] If you are using drop-out colors 

on your form, choose the color you wish to 

drop-out of the form: Red, Blue, Green. You 

may also select a Drop-out threshold. This 

threshold determines how close the color 

match must be in order for the color to 

drop-out. The higher the number, the closer the match must be. 

• Note: Dropping out color is useful on forms where you have colored lines or shading 

near your marks. Dropping out the color means that the color disappears as the form is 

scanned. The marks (bubbles, checkboxes) must not be the same color you are dropping 

out or they will drop-out as well, making the form unreadable. Using drop-out colors via 

the software works with any scanner that can scan in color. If your scanner can also drop-

out colors, we recommend using the scanner's color drop-out by turning on the scanner's 

TWAIN interface for optimum performance. Please note that dropping out color will likely 

slow down the scanning process. 

4. Place the blank page(s) to be scanned in the scanner. You may scan pages one at a time or all of 

the form's pages at once. 

5. Click the Begin Scanning button to scan the page(s). The page(s) are scanned and then a 

thumbnail image of the form appears in the Image window. If scanning multiple pages at once, 

use the arrows under the image to view all scanned images. You may also delete images by 

clicking the Delete icon. 
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6. If you are satisfied with the image(s), click the OK button. Otherwise, click Begin Scanning again 

to rescan a page. (Make sure images do not look severely skewed; if they are, acquire the images 

from the scanner again.) 

 

Remark Office OMR opens a window with a tree view (item list) on the left and an image representation of 

your form on the right. In this window you outline the areas to be recognized. 

Creating New Templates - Using an Existing Image File 

Once you begin the form template, you need to acquire a blank image of your form. The following 

instructions explain how to import a scanned image of your form in order to create the template file.   

 

To create a form template image using an existing image file 

1. Scan a blank copy of your form using your preferred scanner of multi-function printer (MFP).  

Preferably scan to the TIFF format. Save the image in a place where you can access it in Remark 

Office OMR. 

2. Continuing from creating form template 

instructions, in the Image Collection 

Method section, select the Read Images 

button. 

3. [OPTIONAL] If you are using drop-out 

colors on your form, choose the color you 

wish to drop-out of the form: Red, Blue, 

Green. You may also select a Drop-out 

threshold. This threshold determines how 

close the color match must be in order for 

the color to drop-out. The higher the 

number, the closer the match must be. 

• Note: Dropping out color is useful on forms where you have colored lines or shading 

near your marks. Dropping out the color means that the color disappears as the form is 

scanned. The marks (bubbles, checkboxes) must not be the same color you are dropping 

out or they will drop-out as well, making the form unreadable. If your scanner can also 

drop-out colors, we recommend using the scanner's color drop-out feature when you 

scan the forms so that when the images are read in Remark Office OMR, the color is 

already gone.  

4. Click the Browse button to select an image from file. 

5. In the Select Image File window, use the Look in drop-down list to find the image file you wish to 

use for the form template (from step 1). You may only select one image at a time; however you 

can go back to this window to select more images in succession. A thumbnail image of the form 

appears in the Image window. 

6. Repeat Steps 3-4 to add any other images to the form template, if desired. 

7. If you are satisfied with the image(s), click the OK button. Otherwise, click Browse again to 

reselect an image. 
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Remark Office OMR opens a window with a tree view (item list) on the left and an image representation of 

your form on the right. In this window you outline the areas to be recognized. 

Important Note: Do not save a Word or other document as a PDF and then import that PDF into Remark 

Office OMR to create your template. While Remark Office OMR does read PDF files, they must be scanned 

PDF files. The image used for the template must be the same quality form you are distributing to your 

respondents, which is a scanned form. 

Region Types Overview 

There are four types of regions you can create. A region is an area on the form for which you want Remark 

Office OMR to recognize and output data.  

OMR (Optical Mark Recognition) Regions: 

OMR regions are used to capture marks, such as bubbles and checkboxes, on your form. Marks can be 

used to collect many varying types of information, ranging from multiple choice questions to ID numbers 

to names. 

How are they represented? 

Bubbles, checkboxes or any other complete shape, often used for answering multiple choice questions, 

filling in names and codes, etc.  

Barcode Regions: 

Barcodes are used to encode just about any desired information, ranging from names to ID numbers to 

other demographic information. 

How are they represented? 

Horizontal or vertically positioned typically at the top or bottom of a form, often to capture demographic 

and descriptive information.  

OCR (Optical Character Recognition) Regions: 

OCR regions are used to read text that is machine printed (computer generated) on your form (not 

handwritten). The software can read characters, such as ID numbers and names, as long as they are 

machine printed. 

How are they represented? 

Machine printed text anywhere throughout the form, often to capture demographic and descriptive 

information.  

Image Regions:  

Image regions capture handwriting from comment areas and other open ended questions. The software 

does not automatically interpret handwriting, but it does either take a picture of the handwriting, allow 

you to hand enter the written comments using image assisted data entry or type qualitative codes to 

apply themes to the handwritten comments. 

How are they represented? 

An area for handwritten text, or other information that cannot be automatically converted to data. 
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OMR Regions 

An OMR region is an area on the form containing OMR bubbles, checkboxes, or some other complete 

shape. The respondent darkens the marks that correspond with his or her answer choice. Each OMR 

region contains a specific number of rows and columns. A single OMR region can contain one or more 

questions. When an OMR region is created, you must specify certain properties pertaining to the region, 

including the size of the region, the type of region and what output (data) Remark Office OMR should 

generate.  

Types of OMR Regions 

There are seven types of OMR regions. The most commonly used regions are: 

• Multiple Region: A Multiple region designation is used for multiple-choice style questions. These 

questions can allow a single response or multiple responses. One Multiple region may contain 

more than one question, depending on how the marks are arranged on your form (e.g. a test 

answer sheet with rows of questions). 

• Grid Region: A Grid region designation is used for questions where the output from the rows and 

columns of bubbles represents one piece of data. The respondent typically fills in several bubbles 

that make up one response (e.g. student ID numbers, names, social security numbers).  

The less commonly used regions are: 

• List Region: List region designation is used for regions that contain multiple choice style 

questions, but the response bubbles are not contained in a single row or column. Each bubble has 

a unique output value. 

• Add Region: An Add region designates a region where the values of all of the chosen OMR 

bubbles are added together to produce one value. You can assign individual values to each 

answer choice (or mark on the form). 

• Boolean Region: A Boolean region designation is used when you want a user-defined value (e.g. 

Yes) to be output if an answer choice is selected and another user-defined value (e.g. No) for 

answer choices that are not selected. Each response is output to a separate cell in the data grid 

during form processing. In comparison, when you use the Multiple or List region types for 

questions that allow multiple responses, Remark Office OMR places the data in a single cell, 

delimited by commas. The Boolean region type is useful for questions that allow multiple 

responses but for which you need the data in separate cells.  

• Binary Region: A Binary region designation is used when you want a pre-defined value (1) to be 

output if an answer choice is selected and another pre-defined value (0) for answer choices that 

are not selected. Binary regions output all responses to one cell.  

• Rank Region: A rank region designation is used for multiple-choice questions where each 

response or response set can only be used one time. For example, on a voting ballot you may be 

asked to put a list of candidates in order. Using the Rank question type allows you to limit how 

many times each answer choice can be selected. 
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OMR Region Orientation  

An OMR region can be oriented in columns or rows. The region orientation property in the form template 

determines how the region is positioned on the form: by column or by row. 

Column: Regions oriented by column contain question(s) that are positioned on the form in columns (it 

can be one column or several columns). 

  

Examples:  

Select the best response:  

  

O Excellent 

O Good 

O Fair 

O Poor 

  

What is your gender?   

  

O Female 

O Gender 

  

Row: Regions oriented by row contain question(s) that are positioned on the form in rows (it can be one 

row or several rows). 

  

Examples:  

  Excellent Good Fair Poor 

          

Question 1 O O O O 

Question 2 O O O O 

Question 3 O O O O 
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What is your age group? 

  

18-24 25-34 35-44 45-54 55-64 65+ 

            

O O O O O O 

Creating an OMR Region 

There are three ways to create any region type:  

Toolbar: Click the OMR toolbar button. This option creates a new OMR region after the item you 

currently have selected in the tree view (question list). 

Task Pane: Click Insert OMR Region from the task pane (you may need to click Draw Regions first). This 

option creates a new OMR region after the item you currently have selected in the tree view (question 

list). 

Menu: Click the REGION or PAGE menu (depending on your selection point) and then choose either 

OMR Region After or OMR Region Before, depending on where you want the region placed in the tree 

view (question list). 

Remember that the order in which the regions appear in the tree view is the order in which they are read 

during form processing. 

  

To Create an OMR Region 

1. Use one of the methods d to begin inserting an OMR region. 

2. The mouse cursor turns to a crosshair, indicating you need to drag a box around the 

region in the image representation area of the screen. When you drag a box around 

an OMR region, do not include any surrounding text, lines or graphics.   

3. Place the crosshair in the top left corner of the region, hold down the left mouse 

button and drag a box to the lower right hand corner of the region. When drawing 

the box, you want to leave a little bit of space between the outermost marks and the 

box border. If you do not get it perfect the first time, you can always adjust the box 

later using the image handles along the edges of the region in the image area. 

4. Release the mouse button. 

The Properties window appears. Learn more about how to define an OMR region by continuing to the 

next section.  
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Defining an OMR Region's Properties 

Once you have inserted an OMR region, the Properties - OMR Region window appears. The following 

table contains a brief summary of the OMR region properties. 

  

Property Function 

Region name A name assigned to an OMR region. Region names are used as grid column headers in 

the data grid window and are exported when saving data to common file formats. 

Region names are limited to 60 characters. The following characters cannot be used in 

region names: : . – Period, ! – Exclamation, ' - Singe quote, [ - Left bracket, ] - Right 

bracket, , - Comma, " – Doublequote, ( - Left paren, ) - Right paren. 

OMR type The type of OMR region being described. Region types include: 

Multiple- indicates a region containing multiple-choice questions. 

Grid- indicates a grid or matrix of marks (bubble, checkbox) that equates to a single 

piece of data (e.g. student ID number). 

List- indicates a region where each mark is assigned a unique output value, but the 

marks are not contained in a single row or column (e.g. a list of answer choices). 

Add- indicates a region where the values for each of the answers that are filled by the 

respondent are added together to produce a single value for numeric data, or 

concatenated together for textual data. 

Boolean- indicates a region where a user-defined value (e.g. Yes) is output for filled 

responses and another value (e.g. No) is output for non-filled responses. Boolean 

regions output one piece of data for each mark (answer choice) in the region. 

Binary- indicates a region where a value of 1 is output for filled responses and a value 

0 is output for non-filled responses. Binary regions output a string of responses (1s 

and 0s) to a single cell. 

Rank- indicates a region containing multiple-choice questions where each selection 

choice can only be selected one time. 

Data type Sets whether the data should be considered text or numeric when saved/exported. 

Region orientation Sets the orientation of the region in terms of columns and rows: 

Column- the region contains questions that are oriented in columns. 

Row- the region contains questions that are oriented in rows. 

There is an option to read right to left (for column orientation) and read bottom to top 

(for row orientation) if your marks are oriented in such a pattern to support your 

language of choice. 
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Property Function 

Columns in the region Sets the number of columns of marks contained in the region. Remark Office OMR 

attempts to determine the number of columns in the region for you but you should 

check this value. 

Rows in the region Sets the number of rows of marks contained in the region. Remark Office OMR 

attempts to determine the number of rows in the region for you but you should check 

this value. 

Possible label scales Sets a range of pre-determined values as output Labels (e.g. A-E or 1-5). Use this 

setting to quickly enter labels into the Labels grid as opposed to entering each label 

individually. Each mark on your form is represented by a label. The label is the output 

when the filled in form is processed. Note that only label scales corresponding to the 

number of answer choices you have selected appear in this list. 

Labels Sets the output data that appears in the data grid when reading forms. Each mark on 

your form is represented by a Label. The Label is the output when the filled in form is 

processed. You cannot use the following reserved characters in the list of labels: 

commas, quotation marks, semicolons or parentheses. Enter labels carefully because 

once you have processed data, you cannot change your labels without reprocessing 

your forms. 

Values Use this setting to associate a numeric value with each textual answer choice (label). 

Values are used for calculating statistics for responses that are set to the textual data 

type. Values are also used when saving to the SPSS file format.  

Note: Values are not used as point values when grading tests. You cannot use them to 

assign partial credit to individual answer choices when performing test grading. If you 

need to assign partial credit, use Advanced Grade.) 

Possible value scales Sets a range of pre-determined numbers as Values. Use this setting to quickly enter 

Values for each of your textual output Labels into the Values grid as opposed to 

entering each Value individually. 

Save Current Scale Saves a scale of user-defined labels and values as output Labels that you can save and 

use over again (e.g. Excellent, Good, Fair, Poor). Click the Save Current Scale button 

after entering your labels in the Labels grid to save the scale for future use. 

NA Label If your question has a Not Applicable (NA) answer choice and you do not want the NA 

responses to be included in the Remark Quick Stats statistics (e.g. when calculating a 

mean), choose the appropriate label from the NA Label drop-down list. This list is 

automatically populated with the labels you defined in the Labels grid. Only one 

option can be selected as NA per question. In the Remark Quick Stats preferences you 

can choose whether to include or exclude the NA responses (they are excluded in the 

statistics by default, though you still see how many times they were selected). 
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Property Function 

Define Format The Define Format feature applies to Grid OMR regions only. Mark this checkbox to 

enter a pattern for the data that is output during form processing. The default setting 

(*) indicates that the characters are displayed one after the other with no separators. 

The * is a placeholder for your data. You may change this pattern to enter items such 

as slashes for a date, decimal points, etc. Enter the appropriate character in the proper 

position (e.g. for a date: **/**/****). 

Include region in read 

operation 

Mark this checkbox to include data from this region when processing forms. If this 

checkbox is not marked the region exists in the form template, but no data is captured 

during form processing. This checkbox is on by default. 

  

5. In the Properties window, enter the appropriate properties for the region, as described above. 

There are additional advanced features that may be defined. 

6. Click the OK button to create the region.  

After creating an OMR region, you can see the region in the image representation area and a new node is 

added to the tree view. Each OMR region in the image representation area is green to differentiate the 

regions. When you select a region, it has white image handles (tiny squares) around it to indicate it is the 

active region. You may use these handles to adjust the size of the region if needed. 

Combining OMR Regions (Linking) 

Marks that are separated by text, lines or graphics cannot be selected in one region definition. When 

creating an OMR region in an area that contains items such as text or lines, you can only select the marks. 

The Append Linked Region function allows you to link these types of marks into one OMR region. OMR 

region types that can be linked include Multiple, Grid, List, Rank, Binary and Add. The following is an 

example of a question layout that would require a linked OMR region: 

  

What is your gender?  

O    Female    O    Male 

  

The marks (bubbles) are separated by the response text in between them, but are still logically considered 

one question. However, you cannot select the word "Female" within your OMR region. Therefore, you 

create a region around just the mark for Female and then link the mark for Male to the original region. 

• Tip: When designing your form try to avoid having to use linked regions by laying out questions 

without text, lines or anything else between the OMR bubbles whenever possible. 
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To use the append linked region function 

1. Create an OMR region around the first region to be linked as if it were its own region (in the 

example above, you would select the bubble for "Female"). Enter all of the region details as 

previously described. For the region size, only enter what pertains to what you have defined so far 

(in the example, the region is only one row by one column at this point). 

2. After defining the first part of the region, select the REGION menu and then click Append Linked 

Region. The mouse turns into a crosshair. 

3. Drag a box around the second area to be defined (in the example, you would select the OMR 

bubble for Male). 

4. When you release the mouse button the Properties window appears. This window contains the 

same settings that were defined for the first part of the region that you selected. You need only 

define the Labels and Values (if desired) section of the window (unless the number of bubbles in 

each appended region varies, in which case you can adjust the number of columns or rows). 

5. Make any necessary changes to the region definition and then click the OK button. 

Regions that are defined with the Append Linked Region feature are automatically linked to the previous 

region. These regions are a green color in the 

image representation window like OMR regions, 

but also have a dashed line around them and a 

plus sign in the tree view to represent their linked 

status. If you click a linked region, its square image handles are gray instead of white (like an unlinked 

OMR region). 

• Tip: Only regions of the same OMR type, data type and orientation can be linked. However, the 

columns/rows of marks do not have to have the same number of answer choices in order to be 

linked. 

To make changes to a region that is already linked, first separate the regions by breaking the link, then 

make the changes and relink the regions. Many properties can only be accessed by first separating the 

linked regions. 

  

To break a linked region 

1. Use the tree view or image representation area to select one of the OMR boxes within the linked 

set you want to separate. 

2. Select the REGION menu and then click Break Region Link. 

The regions are separated into individual OMR regions. If you need to make changes to the regions, edit 

the regions and then relink them. 

  

To relink regions 

1. While holding down the Shift key, select each OMR region to be linked by either clicking its node 

in the tree view or clicking it in the image representation area. 

2. After all regions are highlighted, select the REGION menu and then click Link Regions. 
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Troubleshooting OMR Regions 

Each region in the form template has a different color so that you can tell one from the other easily. As 

indicated, OMR regions are green. If you create an OMR region and it turns a solid red, this is an 

indication that Remark Office OMR cannot properly recognize the region as it is set up. When a solid red 

region is encountered, you can place your mouse over the region and the Template Editor provides 

details of the problem. Flagged regions are also red and italicized in the tree view, indicating that you 

need to make a correction. Reasons for this issue include the following: 

• The number of columns or rows entered in the Properties window is not correct. 

• One of the region borders is touching something else on the image. It could be touching a 

mark, text, lines or graphics that are present on your form image. Borders cannot be touching 

anything on the image. You should have adequate white space on your form so that you can 

create regions without touching anything on the image. 

• You have captured something other than marks 

(bubbles) within your OMR region (e.g. text or lines). Only 

capture the actual marks within a given OMR region. If 

there is something such as text prohibiting you from 

selecting all of the marks for a single question, you need 

to use the Append Linked Region function. 

• You are using a form that does not have optical marks. In 

order for Remark Office OMR to read your form, the form 

must contain complete shapes, such as bubbles or 

checkboxes. You cannot process forms that use circle the 

number style questions or those that have a line that 

someone marks to indicate a response. 

• The image used for the form template is degraded. When scanning forms, the quality of the 

resulting image is sometimes not as clear as expected. The marks may break up, meaning that 

they have tiny gaps in them. You can use the zoom options on the toolbar to zoom in on your 

image to see if your marks are complete. When marks are not complete, Remark Office OMR 

cannot properly recognize them. If this problem occurs, reacquire your form template image 

by scanning it at a darker brightness setting (sometimes called threshold) on your scanner. 

Note that you may save templates that have solid red OMR regions but you need to correct the problem 

before you begin processing forms to have the software recognize the forms properly. 

  

To reposition or redefine a region 

1. If a region is solid red in color, place your mouse over the region to see the tooltip describing the 

problem. Then review the potential reasons for the red color listed above. If you need to move 

the entire region, place the mouse over the region and drag the entire region with the left mouse 

button to its new position and release the mouse. If you need to move a portion of the region, 

drag the box where you see the white image handle boxes. You can drag right, left, up, down or 

diagonally to adjust the region's borders. You know you have the image handle selected correctly 

when the mouse turns into a double arrow. 
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2. If the region appears to be positioned properly but still appears as solid red, double click inside 

the red box to display the Properties window. 

3. Ensure that the number of columns and rows specified match what has been captured in the 

region. Make corrections if necessary and then click the OK button.   

If neither of these solutions addresses the red region, you may need to reacquire a cleaner image of your 

form or adjust your form design. 

Barcode Regions 

Barcodes are a reliable way to capture information from a form while using a small amount of space. 

Barcodes can be placed directly on a form or on a sticker that is placed on a form. The barcode must be 

located in the same position on each form. You can create barcodes using special barcode generation 

software or by using a barcode font in a word processing program. Barcodes can be placed horizontally or 

vertically on the form. The barcode should be at least 26 points in terms of size (about ¼ inch high). A 

single barcode can contain one or more pieces of data. If using multiple pieces of data within one 

barcode, you must separate the data with a delimiter (e.g. comma, space, tab, etc.). When separating the 

data, make sure you choose a delimiter that is supported by your specific barcode type. 

Remark Office OMR recognizes several barcode types: 

• Code 3 of 9 (Code 39): Alphanumeric 

• Interleaved 2 of 5: Numeric 

• Codabar: Numeric 

• PDF 417: 2D, Alphanumeric 

• Data Matrix: 2D, Alphanumeric 

• QR Code: 2D, Alphanumeric 

• Code 11: Numeric 

• Code 128: Alphanumeric 

• Code 93: Alphanumeric 

• EAN 13: Numeric 

• EAN 8: Numeric 

• UPCA: Numeric 

• UPCE: Numeric 

  

Barcode regions have the following properties: 
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Property Function 

Region name A name assigned to a Barcode region. Region names are used as grid column headers in 

the data grid window and are exported when saving data to common file formats. 

Region names are limited to 60 characters. The following characters cannot be used in 

region names: : . – Period, ! – Exclamation, ' - Singe quote, [ - Left bracket, ] - Right 

bracket, , - Comma, " – Doublequote, ( - Left paren, ) - Right paren. 

Barcode type Use this setting to select the type of barcode to be recognized. You may use the Auto 

Detect setting to have Remark Office OMR automatically determine what type of 

barcode is in the region. However, if you know the barcode type that you are using, we 

recommend that you choose it from the list. 

Barcode orientation Use this setting to select the orientation of the barcode: horizontal (left to right) or 

vertical (top to bottom). 

Data type Sets whether the data should be considered textual or numeric when saved/exported. 

Barcode Contains 

Multiple Items 

Barcodes can contain multiple pieces of data. When outputting more than one piece of 

data, the barcode must include a delimiter to separate the pieces of data. You can 

choose the delimiter that separates the pieces of data in the barcode using the box 

marked Item delimiter. Your choices are comma, tab, space, tilde (~), carriage return, 

line feed, carriage return/line feed. Make sure you set up the barcode with a delimiter 

that is supported by your specific barcode type. In the Number of items box, enter the 

number of pieces of data contained in the barcode. You may use the up/down arrows or 

type a number in this box. Delimited barcodes display in the tree view with an 

expandable plus (+) sign. You can expand the barcode node to see the separate pieces 

of data within that barcode. Opening the properties for one of the expanded nodes 

provides access to certain advanced features only for that piece of data. 

Include region in read 

operation 

Mark this checkbox to include data from this region when processing forms. If this 

checkbox is not marked the region exists in the form template, but no data is captured 

during form processing. This checkbox is on by default. 

  

There are three ways to create any region type:  

Toolbar: Click the Barcode toolbar button. This option creates a new barcode region after the item you 

currently have selected in the tree view (question list). 

Task Pane: Click Insert Barcode Region from the task pane (you may need to click Draw Regions first). 

This option creates a new barcode region after the item you currently have selected in the tree view 

(question list). 

Menu: Click the REGION or PAGE menu (depending on your selection point) and then choose either 

Barcode Region After or Barcode Region before, depending on where you want the region placed in the 

tree view (question list). 
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Remember that the order in which the regions appear in the tree view is the order in which they are read 

during form processing. 

 

To create a barcode region 

1. Use one of the methods above to begin inserting a Barcode region. 

2. In the image representation area, use the mouse to drag a 

box around the barcode or the location where the barcode 

will be on the forms (e.g. if using stickers after the forms are 

returned, place the Barcode region in the area where the 

stickers will be affixed). Barcodes may vary in length 

depending on the data that you are  capturing. Be sure 

to make the Barcode region large enough to capture 

the longest barcode you plan to recognize. If you do 

not get it perfect the first time, you can always adjust 

the box later using the image handles along the edges 

of the region in the image area.  

3. In the Properties window, enter the appropriate 

properties for the region on the Barcode region, as 

described above. There are additional more advanced 

features that may be defined. 

4. Click the OK button.  

After creating a Barcode region, you see the region in the image representation area and a new node is 

added to the tree view. Each Barcode region is orange to differentiate the regions.  

OCR (Optical Character Recognition) 

Regions 

OCR (Optical Character Recognition) regions are used to recognize machine printed (computer generated) 

text. It is useful for demographic and other static information you may want to collect on your forms. 

• Note: OCR does not include handwriting recognition (commonly called ICR or Intelligent 

Character Recognition). In order to use the OCR feature, the text must be machine or computer 

generated. 

You can pre-print information on your form and have the software recognize it. Please note that some 

fonts work better than others when it comes to recognizing text.  
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Property Function 

Region name A name assigned to an OCR region. Region names are used as grid column headers in 

the data grid window and are exported when saving data to common file formats. Region 

names are limited to 60 characters. The following characters cannot be used in region 

names: : . – Period, ! – Exclamation, ' - Singe quote, [ - Left bracket, ] - Right bracket, , - 

Comma, " – Doublequote, ( - Left paren, ) - Right paren. 

OCR type Use this setting to select the type of OCR to use. Remark Office OMR includes three 

types: Primary, Legacy (previously called Standard) and Microsoft Office Document 

Imaging (MODI). You only see the MODI option if you have Microsoft Office 2007 with 

the MODI option installed on the computer running Remark Office OMR. We encourage 

you to use the Primary option first and only switch to the other options if you encounter 

difficulties. 

Data type Sets whether the data should be considered textual or numeric when saved/exported. 

Language Use this setting to choose the language for the characters in the region. 

Primary OCR: Bulgarian, Catalan, Chinese Simplified, Chinese Traditional, Czech, Danish, 

Dutch, English, Indonesia, Finnish, French, German, Greek, Hungarian, Indonesian, Italian, 

Japanese, Korean, Latvian, Lithuanian, Norwegian, Polish, Portuguese, Romanian, Russian, 

Serbian, Slovakian, Slovenian, Spanish, Swedish, Tagalog, Turkish, Ukrainian, Vietnamese. 

Legacy OCR: English, French, Dutch, UK English 

MODI OCR: System Default, Chinese Simplified, Chinese Traditional, Czech, Danish, Dutch, 

English, Finnish, French, German, Greek, Hungarian, Italian, Japanese, Korean, Norwegian, 

Polish, Portuguese, Russian, Spanish, Swedish, Turkish 

Text orientation Use this setting to select orientation of the text: Left to right, Right to left, Top to bottom, 

Bottom to top. (Applies to Primary and Legacy OCR only.) 

Define format Mark this checkbox to establish a pattern of characters to be recognized. Use the 

following syntax for your format: 

# = number 

A = letter 

X = any character 

? = optional character (for trailing purposes only) 

Other = character must match what you type exactly. 

For example, if you are reading a date field, type in ##/##/#### and if you are reading an 

abbreviated US State field, type in AA. (Applies to Legacy OCR only.) 

Region contains more 

than one word 

Mark this checkbox if the OCR region contains more than one word. 

Region contains 

multiple lines of text 

Mark this checkbox if the OCR region extends past one line of text. 
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Property Function 

Invert region image Mark this checkbox to invert the colors on the text and background of the OCR region 

during recognition. This feature can be used if the text on your form is white and the 

background is black and you want to invert them in order to read the text. 

Deskew region image Mark this checkbox to deskew the OCR region during recognition to assist in reading the 

text. 

Despeckle Image 

Region 

Mark this checkbox to despeckle the OCR region during recognition to assist with 

reading the text. Despeckling can help with thick, dark letters. Use the Maximum speckle 

size setting to adjust how much to despeckle. It is recommended that you start with a 

small number to see how the image looks. (Applies to Primary and Legacy OCR only.) 

Auto rotate region 

image 

Mark this checkbox to automatically rotate the OCR region during recognition if the 

software is having difficulty reading the text. (Applies to MODI OCR only.) 

Limit OCR Character 

Set 

Mark this setting to choose the types of characters that are permitted: Numbers, Lower 

case text, Upper case text, Symbols or Custom character set. Limiting the character set 

can improve accuracy. If you do not wish to limit the character set, do not mark this 

option. When using a custom character set, you do not need to include a delimiter 

between items and there is a 256 character limit. (Applies to Primary and Legacy OCR 

only.) 

Include region in read 

operation 

Mark this checkbox to include data from this region when processing forms. If this 

checkbox is not marked the region exists in the form template, but no data is captured 

during form processing. This option is on by default. 

  

There are three ways to create any region type:  

Toolbar: Click the OCR toolbar button. This option creates a new OCR region after the item you currently 

have selected in the tree view (question list). 

Task Pane: Click Insert OCR Region from the task pane (you may need to click Draw Regions first). This 

option creates a new OCR region after the item you currently have selected in the tree view (question list). 

Menu: Click the REGION or PAGE menu (depending on your selection point) and then choose either OCR 

Region After or OCR Region before, depending on where you want the region placed in the tree view 

(question list). 

Remember that the order in which the regions appear in the tree view is the order in which they are read 

during form processing. 
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To create an OCR region 

1. Use one of the methods above to begin inserting an OCR region. 

2. In the image representation area, use the mouse to 

drag a box around the text or the location where the 

text will be on the forms (it is okay if the text is not in 

your template image yet as long as you know where it 

will be located on the filled in forms). The text may 

vary in length depending on the data that you are capturing. Be sure to make the OCR region 

large enough to capture the longest text you plan to recognize. If you do not get it perfect the  

first time, you can always adjust the box later using the image handles along the edges of the 

region in the image area. 

3. In the Properties window, enter the appropriate properties for the region, as described above. 

There are additional more advanced features that may be defined. 

4. Click the OK button.  

After creating an OCR region, you see the region in the image representation area and a new node is 

added to the tree view. Each OCR region is purple to differentiate the regions.  

Image Regions (Handwriting)  

Image regions are used for areas on a form that contain handwritten text (e.g. a person's name, 

comments, etc.). Remark Office OMR cannot read this type of information automatically, but does provide 

you with three options for capturing this information as an Image region. 

• Data Entry Image regions reserve space in the data grid for the manual insertion of text. You can 

type the information contained in the Image region into the data grid using image-assisted data 

entry (typing while viewing the image on-screen). You can also use default fill data, such as a date, 

to automatically populate the data set during form processing. 

• Image Clip Image regions save a snapshot image of the particular region to a user-specified 

location on your computer or network. The location is displayed in the data grid as the forms are 

being scanned. After collecting the Image region information, you may optionally run a Response 

report in Remark Quick Stats to view the results. 

• Qualitative response coding allows you to set up codes for the responses you expect to get from 

your returned forms. Instead of typing long responses, you can code them into categories or 

themes. When entering the data during form processing, you can select a pre-defined code from 

a drop-down list as you read the response on-screen. An additional benefit of qualitative 

response coding is when you analyze the data in Remark Quick Stats, you can run item analysis 

reports to see a breakdown of the codes chosen for the particular question. As an example of 

qualitative response coding, suppose you have a comment question on your survey form. You 

probably want to read those comments. However, you also might want to be able to quickly see 

how many responses were positive, negative or mixed. In the Remark form template, you could 



 

42 

 

enter pre-defined codes of Positive, Negative and Mixed. When you process the filled-in forms, 

you could read each comment on-screen and then choose whether it was a positive, negative or 

mixed response. When you analyze the data, you could quickly see the number of responses that 

fell into each category. You can also allow more than one coded response per comment. You can 

even combine image clipping and qualitative coding so that you can see a report of the 

handwritten comments and apply codes. 

 

An Image region has the following basic properties: 

  

Property Function 

Region name A name assigned to an Image region. Region names are used as grid column 

headers in the data grid window and are exported when saving data to common file 

formats. Region names are limited to 60 characters. The following characters cannot 

be used in region names: : . – Period, ! – Exclamation, ' - Singe quote, [ - Left 

bracket, ] - Right bracket, , - Comma, " – Doublequote, ( - Left paren, ) - Right paren. 

Region type Sets the type of Image region: Image Clip, Data Entry, or Data Entry and Image Clip. 

Use Image Clip to have Remark Office OMR capture an image of the region for later 

viewing in reports and output the location of the image in the data grid during form 

processing. Use Data Entry to hand enter the data that is captured in a region. Use 

Data Entry and Image Clip to both hand enter information (e.g. apply qualitative 

response codes or use a default fill) and store clipped images of the handwritten 

information. 

Data type 

(Data Entry Image region 

only) 

Sets whether the data should be considered textual or numeric when 

saved/exported. 

Default fill Sets a default entry to be used in the Image region. The information typed here is 

automatically output to the data grid when forms are processed. You may also 

select one of the following items from the drop-down list to be used as a default fill 

option: 

• Time Stamp 

• Date Stamp 

• Time and Date Stamp 

• Record Number 

• Page Number 

• Record and Page Number 

When selecting an item from this list, you can also insert text before or after the 

selected item if desired. 
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Property Function 

Auto increment fill value 

(Data Entry Image region 

only) 

When used in conjunction with Default Fill, Remark Office OMR assigns the next 

value in the range you define to the Image region in sequential order. For example, 

you can enter the number 1 as the default fill and then mark the Auto increment fill 

value checkbox. Remark Office OMR automatically places sequential numbers in the 

Image region during form processing. When using a default fill in this fashion, you 

can create the Image region anywhere on the form as a placeholder. 

Apply auto increment 

across auto form ID 

templates 

When used in conjunction with auto increment, this feature allows you to add a 

value in the range you define to the Image region in sequential order across every 

template you are using in auto form ID mode. For example, you can enter the 

number 1 as the default fill and then mark the Auto increment fill value checkbox 

and Apply auto increment across auto form ID templates checkbox. Remark Office 

OMR automatically places sequential numbers in the Image region during form 

processing in all of the templates you are using with auto form ID. When using a 

default fill in this fashion, you can create the Image region anywhere on the form as 

a placeholder. 

Prompt me for the fill 

value when reading 

Use this setting to enter a custom value for the image region at the time of reading 

the filled in forms. This fill value may be something that describes the forms you are 

processing. For example, if you are processing conference session evaluations, you 

could type in the name of each session and it is added to each data record. Do not 

use Attempt to detect the presence of handwriting in the region if you are using this 

feature. 

Attempt to detect the 

presence of handwriting 

in the region 

Use this setting to have Remark Office OMR attempt to determine whether 

handwriting is in the region. For Data Entry Image regions, when text is detected 

during form processing, the Image region’s cell in the data grid is colored blue. For 

Image Clip Image regions, the clip is captured when handwriting is detected and is 

not captured when handwriting is not detected. If you are not using this feature, 

image clips are captured for every Image region. 

Target folder Click the ellipsis (...) to select a location in which to store the Image Clips. You may 

also type or paste a location into this box. 
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Property Function 

Name builder Click the Name Builder... button to further customize the stored image clip names 

and locations. 

In the Image base name area, you may choose to add a region from the processed 

data to the image clip base name. Choose the region from the drop-down list and 

then click the Insert Data Into Base Name button. For example, if processing 

conference session evaluations, you could add a session name that is being 

collected from the form so that your processed image clips all have the session 

name them. 

In the Destination Folder area, you may choose to add a region from the 

processed data to the folder structure that holds the processed image clips. Choose 

the region from the drop-down list and then click the Append Data Onto Folder 

Path button. For example, if processing conference session evaluations, you could 

add a session name that is being collected from the form so that each image clip is 

stored in a folder containing the conference session number. 

In the Name Builder box, click the OK button to return to the Properties window. 

Begin names with 

(Image Clip Image region 

only) 

Use this box to enter a beginning (base) name to use when storing Image Clips. This 

name has numbers appended to it to allow for the greatest number of images to be 

stored. For example, if you are storing Image Clips of a comment question on a 

survey, you may wish to begin the clips with the name "Comments".” 

Clip file type (Image Clip 

Image region only) 

Select an image type to use for storing images. The choices are: PCX, PDF, TIF or 

JPG. 

Compression (Image Clip 

Image region only) 

When saving images to the PDF or TIF formats, you can choose the compression 

level under Compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and 

LZW. Group 4 creates the most compressed image (smallest file size that take up 

less space on your computer). 

Link Region to an Existing 

OMR Region 

(Data Entry Image region 

only) 

Use this setting to link a Data Entry Image region to one of the responses from 

another OMR region on the page (e.g. an "other" blank from a multiple choice 

question). The Image region is colored blue in the data grid if the linked mark is 

chosen so that you know which regions need attention for data entry. This feature is 

especially helpful when used in conjunction with Review Exceptions. 

OMR region 

(Data Entry Image region 

only) 

Use this drop-down list to select the region to which to link the Image region when 

using the Link Region to an Existing OMR Region option. 

Question 

(Data Entry Image region 

only) 

Use this drop-down list to select the individual question within the OMR region to 

which to link the Image region. Note that if the linked OMR region only contains 

one question, you only see this question in the list. 
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Property Function 

Answer 

(Data Entry Image region 

only) 

Use this drop-down list to choose an answer response (Label) from the linked 

question. Alternatively, you may type an answer choice in the box. When this 

answer choice is detected during form processing, the linked Image region's cell is 

colored blue in the data grid. 

Include region in read 

operation 

Mark this checkbox to include data from this region when processing forms. If this 

checkbox is not marked the region exists in the form template, but no data is 

captured during form processing. 

 

There are three ways to create any region type:  

Toolbar: Click the Image toolbar button. This option creates a new Image region after the item you 

currently have selected in the tree view (question list). 

Task Pane: Click Insert Image Region from the task pane (you may need to click Draw Regions first. 

This option creates a new Image region after the item you currently have selected in the tree view 

(question list). 

Menu: Click the REGION or PAGE menu (depending on your selection point) and then choose either 

Image Region After or Image Region before, depending on where you want the region placed in the tree 

view (question list). 

  

To create an image region 

1. Use one of the methods above to begin inserting an Image region.  

2. In the image representation area, use the mouse to drag a box around the location where the 

handwriting will be on the forms. Be sure to capture any lines or boxes in which the respondent 

will write. 

Comments: 
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3.  In the Properties window, enter the appropriate 

properties for the region, as described above.  

There are additional more advanced features that 

may be defined. 

4. [Optional] If you would like to enter response 

codes for qualitative analysis:  

a. Click the Question properties link in the 

task pane on the left side of the 

Properties window. 

b.  [Optional] If you want to use qualitative 

coding, enter the desired codes you wish 

to use for qualitative analysis in the Codes 

column. Assign a numeric value to each 

code for statistical analysis in the Values 

column (e.g. for calculating means). Note 

that you may also use pre-defined codes 

in the Available scales drop-down list to 

quickly fill the Codes and Values columns. 

c. [Optional] If you wish to allow multiple 

response codes to be applied to each 

question, click the Advanced Region 

Properties link in the task pane. Under 

Multiple Response Exceptions, select 

whether multiple responses are allowed by 

choosing Not Allowed or Allow All. 

d. [Optional] If you want to be able to tabulate the question with the qualitative codes (i.e. 

run statistical analysis on the question in Remark Quick Stats), while on the Advanced 

Region Properties screen, mark the radio button for Tabulate this item. Image regions 

are not set to tabulate by default. 

• Note: You can adjust qualitative codes from the Tools menu in the Data Center when 

processing forms as well. If codes are changed or added, they are also updated in the 

template. 

5. Click the OK button. 

  

After creating an Image region, a new node is added to the tree view. Image regions are blue in the image 

representation area. 
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Advanced Template Options 

There are many advanced properties that can be set to help you refine survey tabulation, test grading, 

form tracking and utilizing external databases for verification of information. Please read the following 

sections for more details.  

Advanced Region Properties 

Once you have defined the basics of a region, there are several additional options in the left task pane, all 

of which are optional. You can set up these additional options when you create a region or go back into a 

region's properties at any time to make changes. The Advanced Region Properties allow you to adjust 

the following items: 

  

Test Settings 

Choose whether or not to grade an item. By default, 

Multiple, Rank, Boolean and List regions have grading 

turned on by default. All other region types are off by 

default. In addition, if you are scoring multiple versions of 

the test you should have a region on the form that tells the 

software which version of the test is being scanned. You 

can mark the Designate as test version ID option to tell 

Remark Office OMR to look at this region to determine 

each student's test version. You can then use the available 

multiple answer key scoring options in the Advanced 

Grade feature of the Data Center. 

 

Survey Settings 

Choose whether or not to include an item when running survey analysis in Remark Quick Stats. By default, 

Multiple, Rank, Boolean and List regions have tabulating turned on by default. All other region types are 

off by default.  

 

Testing Point System 

Questions can be designated as Objective, Subjective or 

Rubric questions: 

An objective question is one where respondents choose 

one or more pre-defined answers on a form by darkening 

in a mark (e.g. bubble). These questions are typically 

multiple choice or true/false questions.  

A subjective question is one that is open ended and must 

be graded by a teacher, such as an essay or short answer 

question. Remark Office OMR cannot automatically read 

this type of question; however, you can include points from 
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a subjective question when grading. First, place a region on the form where the teacher can enter the 

appropriate amount of points earned on the subjective portion of the test. This is typically an OMR region 

where the teacher bubbles in the points earned. Then designate the region as a subjective item in the 

form template. This region must be set to the numeric data type in order to use the region as a subjective 

region. When setting up your answer key, enter the maximum number of subjective points that can be 

earned. When grading, Remark Office OMR displays the overall, objective and subjective scores.  

Rubric scoring is similar to subjective scoring in that the teacher awards the number of points to the 

student's answer. The major difference is that it may be a multiple choice style question with a defined 

number of answer choices (as opposed to grid style question with a wider variety of point possibilities). A 

rubric typically uses a range to rate performance on the question. As with a subjective question, you need 

a place on the form for the teacher to fill in the number of points to award. You typically define the OMR 

region as multiple, establishing the desired points scale in the Labels grid. However, regions used for 

rubrics can also be List or Boolean. The data type must be set to textual. 

Extra credit is available using the Treat awarded points as extra credit checkbox. This feature allows you 

to use Quick Grade to grade the tests and still designate a question as extra credit. When this checkbox is 

selected, any points awarded for the question are added to the total score (therefore it may be possible to 

score greater than 100%). 

 

Analysis Respondent ID 

You may also set a particular region as an Analysis 

Respondent ID region so that it can be used as an identifier 

on reports. This feature is useful when you are capturing 

items such as ID numbers or names. When set as an Analysis 

Respondent ID region, the resulting reports show the 

information captured in the region alongside of the results. 

For example, if you administer a test where the students 

enter their ID number, the grade report shows the ID number 

and then that student's grade. Or, you can capture the 

students’ handwritten name as an image clip and use it as the 

Analysis Respondent ID (note that you can only show one 

image clip as an Analysis Respondent ID in the reports). When exporting data to some gradebook 

packages, you may also be required to set an Analysis Respondent ID. 

• Note: Analysis Respondent IDs are included as identifiers in the analysis, but they are not 

tabulated or graded. In order to set a region as an Analysis Respondent ID, make sure it is set to 

Do not grade this item and Do not tabulate this item. 
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Recognition Threshold 

The Recognition Threshold setting allows you to compensate 

for degraded images and poorly marked forms, assists with 

the recognition of text in OCR regions and assists with the 

recognition of handwriting in Image regions. Use the 

Recognition Threshold setting to increase or decrease 

standards for mark and text recognition. 

You can set the Recognition Threshold on a region-by-region 

basis. For OMR and Image regions, the Recognition 

Threshold setting ranges from 1 to 6, with 3 being the default 

setting. It is recommended that you use the default values 

unless you encounter problems. Use a lower Recognition 

Threshold to compensate for errors when reading light pages, degraded images or pages where the 

respondent has not filled the marks completely. Use a higher Recognition Threshold to compensate for 

errors when reading dark pages or pages with many erasures. 

• Note: The Recognition Threshold can only be set on a region basis. If you have a region 

containing multiple OMR questions, the 

Recognition Threshold setting applies to all 

questions in the region. 

For OCR regions, the Recognition Threshold setting 

ranges from 1-100% (default setting is 70%). The 

threshold applies to each individual character. The 

software returns a confidence value for each character 

recognized (e.g. 70% certain it is a "G"). If any character 

returns a confidence value lower than the specified 

threshold, the OCR field is flagged as an exception for 

your review. 

Recognition Threshold settings can also be adjusted on a 

global scale in the Template Editor Preferences as well as 

on the fly when reading forms. 
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Blank, Multiple and Duplicate Exception Handling 

When people fill out forms, inevitably they will mismark them by leaving questions blank, filling in too 

many responses or leaving stray marks or erasures that might be interpreted as filled bubbles. You can 

specify how Remark Office OMR should handle blank, multiple and duplicate responses in OMR regions 

when processing forms and exporting data. The default 

settings are: 

• Blank responses: The word BLANK is inserted 

for items that are not answered. 

• Multiple responses: All responses are shown 

but flagged with green when more than one 

response is chosen and not permitted. 

• Duplicate responses: The word DUP is inserted 

for Rank questions when more than one 

response is chosen. 

Color coding is also applied to the data grid, making 

the exceptions easier to locate: yellow for blanks, green 

for mults and peach for duplicates. Also by default, only 

one answer response is allowed. You can replace these 

values on a region-by-region basis. You may choose one of the default options listed or type in a custom 

value. The default options include Asterisk (*), Nothing, Space Character and Tilde (~). In addition, the 

word VOID is available for blank responses. 

 

Additional Options for Blank Responses: For a blank response, you can choose how you want to flag 

the region. Sometimes there are intentional blank characters in grid regions, for example, that you 

wouldn't want flagged. Suppose you are capturing a name and allow 10 letters. If a person's name is only 

5 letters, you wouldn't want the region to appear as blank because they only used half of the allotted 

characters. Therefore, you have the following options available under Flag blanks: 

• Always: If any character in the region is left blank, or the entire question is left blank, 

regardless of the replacement characters 

being used, the region is considered blank. 

Replacement characters, if used, are still 

utilized, but the region contains the yellow 

BLANK exception color.  

• Ignore Leading/Trailing: If a leading or 

trailing character in the region is left blank, 

it is ignored. This allows you to capture 

data smaller than the allotted region 

without it being considered blank. You will 

see whatever data is captured and the 

region will not contain a yellow BLANK 

exception color. This setting applies to Grid 

regions only. 

• Never: If any character within the region is 

blank, or the entire question is left blank, Remark Office OMR ignores it. The region never 

appears with a yellow BLANK exception color in the data grid. 
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• Ignore Leading: If a leading character in the region is left blank, it is ignored. This allows you 

to capture data smaller than the allotted region without it being considered blank. You will 

see whatever data is captured and the region will not contain a yellow BLANK exception color. 

This setting applies to Grid regions only. 

• Ignore Trailing: If a trailing character in the region is left blank, it is ignored. This allows you to 

capture data smaller than the allotted region without it being considered blank. You will see 

whatever data is captured and the region will not contain a yellow BLANK exception color. 

This setting applies to Grid regions only. 

 

Additional Options for Multiple Responses: By 

default, questions only allow one response. If you wish 

to allow more than one response, you can choose the 

number of allowed responses in the Multiple 

responses drop-down list. Use Allow All if you do not 

any limitations on the number of responses people can 

choose. If you set a limit, anything marked above the 

limit forces the question to be considered a multiple 

response and is flagged as such in the data grid. There 

is also an option to choose Select most filled, which 

tells Remark Office OMR to determine the mark it 

thinks is the most filled when two or more responses 

are detected. Use caution when using this option, as 

you will never see a multiple response for your review.  

 

Mark Discrimination 

Remark Office OMR allows you to disable mark 

discrimination on an OMR region. Mark discrimination 

sets the value that determines the difference between 

two (or more) marks that are filled/partially filled. This 

allows the Remark software to determine which mark is 

actually filled. If you turn off mark discrimination, 

Remark Office OMR does not try to determine which 

mark is more filled when more than one mark is filled 

(whether or not they are allowed). The result is a 

multiple exception in the data grid that you can review 

and correct if multiple responses are not found. If 

multiple responses are allowed, all marks considered 

filled are reported. Disabling mark discrimination is 

considered an advanced option and not recommended 

for most applications.  
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Required Items 

Remark Office OMR allows you to make items required 

to be filled during processing. This feature is used in 

conjunction with Review Exceptions. If an item is 

marked as required in the form template and you are 

using the Review Exceptions feature, Remark Office 

OMR flags any items that are left blank. If you are using 

Review Exceptions during form processing, the 

processing stops so that you may review the 

unrecognized item. If you are using Review Exceptions 

after form processing, Remark Office OMR includes the 

unrecognized item during the review operation.  

Question Properties 

Once you have defined the basics of a region, there are several additional options in the left task pane, all 

of which are optional. You can set up these additional options when you create a region or go back into a 

region's properties at any time to make changes. The second item is Question Properties allow you to 

adjust the following items: 

  

Question Text 

Question text may optionally be added to make 

reports more meaningful. When question text is 

present, it is used on the reports to identify the 

question. If no question text is entered, the region 

names are used on the reports. 

You may manually type question text into the 

question text grid or paste text from the Windows 

clipboard by using the keyboard shortcuts (Ctrl + V) 

or by double clicking a cell, then right clicking and 

choosing Paste from the menu. In order to paste 

information, you must first copy it from another 

location (e.g. a Word document). You may select 

multiple rows in the grid to paste multiple lines of 

question text. There is one grid row for each question 

you have included in the region.  
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Question Names 

When defining an OMR region with multiple 

questions in the same region, you can specify 

individual question names for each question in the 

region. By using individual question names, it is easier 

to save data to existing databases and other file types 

that may already be set up with specific fields. 

By default, Remark Office OMR uses sequential region 

names for each question in the same region. 

Sequential region names consist of adding numbers 

sequentially onto the region name you provide in the 

Properties - window. For example, if you enter a 

region name of Question, Remark Office OMR calls 

the individual question names within the region 

Question1, Question2, Question3, etc. 

In contrast, if you use the Question Names section of the Question Properties window to enter individual 

question names, you are able to customize the question name for each question within the region. 

Question names are limited to 60 characters each. 

• Tip: The following characters are not allowed in region/question names due to the problems they 

could cause when exporting data to certain formats: 

. - Period 

! - Exclamation 

' - Singe quote 

[ - Left bracket 

] - Right bracket 

, - Comma 

" - Double quote    

( - Left paren 

) - Right paren 

 

Qualitative Response Codes 

When defining an Image region that uses data entry, 

the Question Properties window also includes a 

Qualitative Response Codes section. Using this 

feature allows you to read handwritten comments on 

the screen and then enter codes to categorize them 

(sometimes called "themes"). You can then analyze 

the qualitative coded data in Remark Quick Stats. 

Enter the desired codes you wish to use for qualitative 

analysis in the Codes column. Assign a numeric value 

to each code for statistical analysis in the Values 

column (e.g. for calculating means). Note that you 

may also use pre-defined codes in the Available 

scales drop-down list to quickly fill the Codes and 

Values columns. Don't forget to turn on tabulation in the Advanced Region Properties section of the 

Properties window if you want to include the codes in your reports. 
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Database Lookup 

Remark Office OMR has a Database Lookup feature that can: 1) verify that recognized data from a region 

appear in an external database, and 2) lookup and replace recognized data with additional fields from an 

external database. To use this feature, you link a region in the form template to an external database. As 

each form is processed, Remark Office OMR verifies that the recognized data appear in the selected 

database field. If the data are not present, Remark Office OMR flags the question as a Database Lookup 

error for correction. Database Lookup can be used with OMR, OCR, Image and Barcode regions. 

This feature is useful for validating names, identification numbers, zip codes, etc. It is also useful for 

pulling information you have already collected out of a database and inserting it into your processed form 

data. When you set up a Database Lookup region, you tell the software what field to validate, and whether 

to replace the output with a field from the external database and/or append additional fields from the 

external database. 

For example, suppose you are grading tests and you have the students fill in their ID numbers on the 

forms being processed. You could verify the ID numbers in a database to ensure the right forms are being 

scanned, and then specify another value that corresponds to the ID number (e.g. a name). If the ID 

number is found in the database, Remark Office OMR automatically displays the corresponding value 

(student name in this case) for that ID number in the data. When you run your grade reports, they are 

produced with each student's name, yet you did not have to type in that information (or have students 

bubble it in on the form). 

  

To use database lookup 

1. Create a region. 

2. From the Properties window, click the Database Lookup link in the left task pane.  

3. Mark the checkbox for Use Database Lookup. 

4. In the Database Selection area, use the Type drop-down list to select the type of database to 

which you want to connect this region (e.g. Access, Excel, etc.). 

5. Click the Browse... button to locate and select the database file. 

6. Select a file and then click the Open button (or double click the file name). 

If using an ODBC connection, perform the Steps 7-9 (you need to obtain specific information from your 

database administrator to complete these steps). Otherwise, skip to Step 10. 

7. [OPTIONAL]: Select your database type from the DSN drop-down list. 

8. [OPTIONAL]: Select the appropriate checkbox to indicate whether your database is Directory or 

DSN based: Directory based or DSN based. 

9. [OPTIONAL]: If your database utilizes password protection, use the Username and Password 

boxes to enter your login information. If the database is not password protected, you may skip 

this step. 

10. In the Lookup & Return section, click the Connect to Database button to link the database to 

the region. 
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11. Use the Table drop-down list to select the 

table in the database containing the fields to 

which you are linking the region. 

12. Use the Lookup drop-down list to select a field 

in the connected database to which you want 

to link this region. When the forms are 

processed, the respondents' answers are 

verified against the values in this database 

field. If the answer is found in the database 

field, Remark Office OMR outputs the Replace 

value. If the answer is not found in the 

database field, Remark Office OMR flags it for 

review. 

13. Use the Replace drop-down list to select a 

field in the connected database to return when the Lookup field is verified. If you only want to 

verify data and not replace it with anything else, use the same field in both the Lookup and 

Replace lists. If you want to look up the value and then replace it with a different database field's 

information, select the appropriate field in the Replace list. 

If you would like to pull other data out of your database to include in your Remark data, continue with 

steps 14-17. This is a quick and easy way to get information out of the existing database and into your 

processed data without having to put on the physical form. Otherwise skip to step 18. 

14. [OPTIONAL]: If desired, select database fields from the Additional Return Fields list to insert 

additional information from the database into the data grid during form processing. You may 

look up a field once but return several database fields' worth of information. Fields are listed in 

the data grid in the order in which they appear in the Additional Return Fields list. 

15. [OPTIONAL]: If desired, use the Return Names column to specify region names for the Return 

fields. By default, the name is taken from the external database to which the region is connected. 

You may type a new name in the Return Names cell if desired. 

16. [OPTIONAL]: Use the drop-down arrow to select Yes in the Respondent ID box to include the 

Return field in the reports as a respondent identifier. If this setting is set to Yes, the data 

collected from this region is used on the appropriate reports to identify the respondent. 

17. Click the OK button to save the changes and return to the tree view.  

When you process your filled in forms, Remark Office OMR looks up the captured data in the database 

and if found, returns your Replace and Additional Return Field data. If the captured data does not match 

what is in the connected database, Remark Office OMR flags it for your review. 

• Tip: If your database name or location changes once you have set up your database lookup, when 

you open the template in the Data Center for processing, you are prompted to restore the 

connection settings.  
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Tracking (Automatic Form Processing) 

Remark Office OMR offers three types of tracking to assist with the automation of forms processing: 

• Auto Form ID: Provides automatic identification of a form when processing multiple form 

types at the same time. 

• Auto Page ID: Provides automatic identification of pages within a form template. 

• Respondent Tracker: Provides automatic identification of respondent data. 

With Auto Form ID, Remark Office OMR can automatically recognize a form and match it to its template, 

allowing you to process various form types at once without pre-sorting the forms. With Auto Page ID, 

Remark Office OMR takes it a step further and identifies specific page order within a form template if the 

pages are processed out of order. With Respondent Tracker, Remark Office OMR recognizes a specific 

respondent's page and place it in the correct grid row with the rest of that respondent's data even if the 

pages are processed out of order. When you design your paper form, you add the tracking identification 

to each form (e.g. bubbles or barcodes indicating form or page numbers). These features can be used with 

OMR, OCR or Barcode regions. When combined, the three types of tracking allow you to process forms 

without pre-sorting and Remark Office OMR is able to match each page to the correct form (template), 

page number and respondent within the appropriate template grid. 

• Tip: You can use delimited barcodes as identifiers. Delimited barcodes contain multiple items 

within a single barcode. When set up in the Template Editor, you can tell the software which part 

of the barcode to use as the Form, Page or Respondent Identifier. 

Setting up the form, page or respondent identifier begins with the same process: 

1.   Create a region. 

2.   From the Properties window, click the Tracking link in the left task pane. 

3.   Mark the checkbox for Use Region Tracking. 

Form Identifiers (Auto Form ID) 

You must have a form identifier on each page of your form to use the Auto Form ID feature. When you 

create a paper form, place optical marks (e.g. bubbles), computer generated text (OCR) or barcodes on it 

that identify the form. If you already have an existing form you wish to process, add the bubbles, text or 

barcodes to the form so that they identify the form. These markings must be the same on each page of 

the same form. However, they should be unique from any other types of identifiers you are using, such as 

Page IDs or Respondent IDs on this form or other forms. An example could be the words "Form A" in 

barcode format. Alternatively, you could place bubbles on the form and mark them as A, B, C, etc. 

(depending on how many forms you want to automatically recognize) to identify each particular form. 

• Note: If using barcodes as identifiers and the barcodes contain multiple pieces of data within a 

single barcode (called Barcode Contains Multiple Items in the Barcode Properties window), you 

can set up tracking after creating the barcode region. Set up the barcode as usual. You then see it 

listed in the tree view with a plus sign (+). Click the plus sign to expand the barcode, showing its 

separate pieces of output. Then select the individual item from the tree view to which you want to 

apply the tracking. 
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To set up an Auto Form ID region 

1. Create an OMR, barcode or OCR region that captures the form identifier. 

2. From the Tracking section of the region's Properties window, mark the checkbox for Use Region 

Tracking. 

3. Select the radio button for Form Tracking 

(Auto Form ID). 

4. If using an OMR region, type in the ID value. 

Note that the ID value for an OMR region 

must be one of the labels you defined for 

the region. If using a barcode or OCR, click 

the Recognize button to have Remark Office 

OMR automatically recognize the region's 

value. This value acts as the identifier for this 

particular form. All forms that you wish to 

process with this form template (using Auto 

Form ID) must have this value present. 

5. If desired, mark the checkbox for Insert ID 

value into the data grid during the read 

process. Viewing the ID data captured along 

with the rest of the data can be useful for verification of processed data. 

6. Click the OK button to save the changes and return to the tree view. 

When you are ready to process forms, open any form templates containing Auto Form ID regions in the 

Remark Office OMR Data Center. In the Read window, turn on the Auto Form ID feature under Advanced 

Options. Remark Office OMR begins processing the forms, searching for the Auto Form ID regions first. 

When it matches a region on the form to the region in the form template, it automatically places that data 

in the corresponding data grid. Any regions that are not recognized are flagged for your review or placed 

in the Unrecognized Images queue.  

Page Identifiers 

You must have a page identifier on each page of your form to use the Auto Page ID feature. When you 

create a paper form, place optical marks (e.g. bubbles), computer generated text (OCR) or barcodes on 

the form pages that identify each individual page. If you already have an existing form you wish to 

process, add the bubbles, text or barcodes to the form to identify the individual form pages. These 

markings must be unique for each page on the form. They should also be unique from any other types of 

identifiers you are using, such as Form IDs or Respondent Tracking identifiers. An example could be the 

words "Page 1" in barcode format. Alternatively, you could place bubbles on the form and mark them as 

1, 2, 3, etc. (depending on how many pages you have in a particular form) to identify each particular page. 

• Note: If using barcodes as identifiers and the barcodes contain multiple pieces of data within a 

single barcode (called Barcode Contains Multiple Items in the Barcode Properties window), you 

can set up tracking after creating the barcode region. Set up the barcode as usual. You then see it 

listed in the tree view with a plus sign (+). Click the plus sign to expand the barcode, showing its 

separate pieces of output. Then select the individual item from the tree view to which you want to 

apply the tracking. 
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To set up a Page ID region 

1. Create an OMR, barcode or OCR region that captures the page identifier on the form. 

2. From the Tracking section of the region's Properties window, select the radio button for Page 

tracking. 

3. If using an OMR region, type in the ID value. 

Note that the ID value for an OMR region 

must be one of the labels you defined for the 

region. If using a barcode or OCR, click the 

Recognize button to have Remark Office 

OMR automatically recognize the region's 

value. This value acts as the identifier for this 

particular page. All form pages that 

correspond to this form template page must 

have this value present in order for the 

software to automatically recognize the page. 

Each page within a single form template must 

have a different page value. 

4. If desired, mark the checkbox for Insert ID 

value into the data grid during the read process. Viewing the ID data captured along with the 

rest of the data can be useful for verification of processed data. 

5. Click the OK button to save the changes and return to the tree view. 

6. Repeat steps 1-5 for the remaining pages of the form.  

When you are ready to process forms, open the form template containing Page ID regions in the Remark 

Office OMR Data Center. Use the Read window to process your forms. Remark Office OMR begins 

processing the forms, searching for the Page ID regions first. When it matches a region on the form to the 

region in the form template, it automatically places that data in the correct page order. Any regions that 

are not recognized are flagged for your review or placed in the Unrecognized Images queue. Note that if 

you are not using the Respondent Tracker feature, you must process all of the pages belonging to one 

respondent's form before beginning those of a different respondent. 

• Tip: Page IDs can be used alone if you only want to recognize various pages within the same 

form. If you want to be able to recognize various pages within different forms at the same time, 

you need to use Form IDs as well.  

Respondent Trackers 

Respondent Tracker regions can be setup to identify each respondent's form. To use Respondent Tracker, 

you must also have a page identifier on each page of your form. When you create a paper form, place 

optical marks (e.g. bubbles), computer generate text or barcodes on every form page to identify the 

individual respondents. For example, if the respondent fills in an identifier such as name or ID number on 

each page, or you have such information captured in a barcode, these regions could be used as 

Respondent Trackers. These markings must be unique from any other types of identifiers you are using, 

such as Form IDs or Page IDs. Each respondent identifier must also be unique among all respondents. 

However, the Respondent Tracker output must be the same for each page within a particular respondent's 

form. 
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• Note: If using barcodes as identifiers and the barcodes contain multiple pieces of data within a 

single barcode (called Barcode Contains Multiple Items in the Barcode Properties window), you 

can set up tracking after creating the barcode region. Set up the barcode as usual. You then see it 

listed in the tree view with a plus sign (+). Click the plus sign to expand the barcode, showing its 

separate pieces of output. Then select the individual item from the tree view to which you want to 

apply the tracking. 

  

To set up a Respondent Tracker region 

1. Create an OMR, barcode or OCR region that 

captures the form identifier. 

2. From the Tracking section of the region's 

Properties window, select the radio button for 

Respondent tracking. 

3. If desired, mark the checkbox for Insert ID 

value into the data grid during the read 

process. Viewing the ID data captured along 

with the rest of the data can be useful for 

verification of processed data. 

4. Click the OK button to save the changes and 

return to the tree view. 

When you are ready to process forms, open the form template containing Respondent Tracker regions in 

the Remark Office OMR Data Center. Use the Read window to process your forms. Remark Office OMR 

begins processing the forms, searching for the Page ID regions first. When it matches a region on the 

form to the region in the form template, it automatically places that data in the correct page order. It then 

searches for the Respondent Tracker and matches that respondent's data to an existing record or begins a 

new record. Any tracking regions that are not recognized are flagged for your review or placed in the 

Unrecognized Images queue. 

• Tip: If you want to be able to recognize various pages and respondents within different forms at 

the same time, you may want to use the Auto Form ID and Page ID features as well as 

Respondent Tracker. Use of all three features allows you to scan various form types without pre-

sorting and still keep pages and respondents together.  

Editing Regions 

Regions can be modified after they have been created in order to change properties such as region 

names, data types, orientation, labels, etc. If you select the entire region, you have access to all of the 

properties that are valid for that region. If you are editing an OMR region that contains multiple 

questions, you may only edit certain properties when selecting individual questions. The ability to edit 

individual questions allows you to change items such as test points, the ability to accept multiple 

responses and blank and multiple exception handling on an individual question basis, yet still only create 

one OMR region. 
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• Note: Changing regions in a form template does not change data that have already been 

processed. To update data that have been read you need to process the forms again, or use 

the Find/Replace option to change the existing data to match the revised form template. 

Changing a form template can also invalidate Grade/Survey analysis files. If you have already 

created these files, it is recommended that you recreate them based on the current form 

template settings. 

  

To edit regions 

1. Double click within the boundaries of the region you want to edit, or double click the item in the 

tree view, to display the Properties window. 

2. Make the desired changes and then click the OK button. 

3. Save the form template when finished editing. 

  

For OMR regions: 

  

To edit a region with multiple questions 

1. Double click within the boundaries of any region you want to edit, or double click a region node 

in the tree view to display the Properties window. You have access to the OMR region 

properties, Advanced Region properties and Question properties. 

2. Make the desired changes and click the OK button. Remember that changes made at this level 

apply to the entire region. 

3. Save the form template when finished editing. 

  

To edit individual questions within an OMR region 

1. Expand the region containing multiple questions by clicking the plus sign next to the region node 

in the tree view. 

2. Double click the question node representing the question you 

wish to change. You can also select multiple nodes by holding 

down Ctrl on the keyboard and clicking each region or by 

clicking a region, holding down Shift on the keyboard and then 

clicking another region; all items in between the selections are 

highlighted.  

• Note: If multiple questions are selected, you are not able to 

edit Question Text or Question Names. You are able to 

adjust the Labels for all selected questions, however. 

3. The Properties window appears. You are able to adjust 

Advanced region properties and Question properties.   

• Note: When viewing properties for individual questions 

within an OMR region, the Question text and names window changes to Question text, 
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names, and responses. You can find the question's labels on this screen. Question text and 

names are only displayed for the selected question(s). 

4. Make the desired changes. 

5. Click the OK button to save your changes and return to the tree view.  

Working with Regions 

Once regions are created, you can use basic Windows functions to make modifications, including: 

• Drag/drop 

• Cut, copy, paste 

• Delete 

• Zoom in/Zoom out 

• Spell check 

There are various ways to access these basic functions, including the keyboard, menus and toolbar. You 

can use whichever way is comfortable for you. 

 

Drag/Drop, Cut, Copy, Paste, Delete 

When you create templates, the tree view (question list) on the left defines the order in which the regions 

are read when the forms are processed. If you need to rearrange the order, simply drag the regions into 

the right order. Holding Shift while you drag places the item before the selected item. Alternatively, you 

can cut a region and paste it elsewhere. You can also utilize the Windows copy function to create similar 

regions. When you copy a region, you need to then drag it to its proper location on the image. You can 

double click the copied region to make any adjustments to the properties. If you want to remove a region 

entirely, click the Delete button on the keyboard. 

 

Auto Align 

The Auto Align feature attempts to adjust all regions on a page so that they are situated properly around 

the marks. This feature is useful if you need to scan a new image for the form due to form changes or a 

badly skewed image. It is also useful if you plan to share form templates with another user. Form 

templates created with one scanner should be realigned to new images when a different scanner is used. 

You can align one page or an entire form template. 

  

To use Auto Align for one page 

1. Select the page node you wish to align. 

2. Right click the page node, select the REGION menu or right click in a blank section of the image 

representation area. 

3. Choose Auto Align Page from the menu. The regions move to the appropriate positions on the 

form. 
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To use Auto Align for the entire form template 

1. Select the Tools menu and then click Auto Align Form Template. 

  

Once you have aligned pages or the entire form template, you should review the changes to make sure 

the regions are in the right position. You may need to do some additional moving of regions, particularly 

non-OMR regions, as the software is not able to tell exactly where you want these regions since there are 

no marks within them.  

Resetting Template Images 

There may be times when your form template images no longer match your actual form. For example, 

suppose that you create a form and then decide to remove one of the questions from the form. Or, 

perhaps you create the form template from a printed version of the form and then decide to make 

photocopies for distribution, which causes the entire form to be shifted. In either case, if you have already 

created your form template, you can use the Reset Images feature to bring in new images with your 

existing form template without having to recreate the entire form template. 

• Tip: If you receive forms back from multiple locations, have each location include a blank copy. 

That way if the location's forms are skewed or offset from their copier or printer, you can reset the 

template image with their specific blank copy and their forms will better match the template. 

 

To use Reset Images with a scanner 

1. In the Remark Office OMR Template 

Editor, select the Tools menu and then click 

Reset Images. 

2. In the Image Collection Method section, 

click the Scan button.  

• Note: If you need to configure your 

scanner, you may click the Scanner 

Properties link to view the Scanner 

Properties window. 

3. Place the page(s) to be scanned in the 

scanner. 

4. Click the Begin Scanning button to scan the page(s).  

5. The page(s) are scanned and then a thumbnail image of the form appears in the Image window. If 

scanning multiple pages at once, use the Previous Page and Next Page arrows under the image 

to view all scanned images. You may delete any images you do not wish to keep by clicking the 

Delete button or using the drop-down arrow on the Delete button to fine tune what you are 

deleting. 

6. If you are satisfied with the image(s), click the OK button. Otherwise, click Begin Scanning again 

to rescan a page. Once you click OK, You may be prompted to have the software attempt to move 
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your existing regions to the appropriate place on the new image. Review changes carefully after 

repositioning to ensure regions are in the right spots. 

   

To use Reset Images with an image file 

1. Scan a blank copy of the form and store it somewhere where you can access it in Remark Office 

OMR.  

2. In the Remark Office OMR Template Editor, select the Tools menu and then click Reset 

Images. 

3. Click the Read Images button. 

4. Click the Browse button to select an image 

file. 

5. In the Select Image File... window, use the 

Look in drop-down list to find the file(s) you 

wish to use for the form template. You may 

only select one image at a time; however, 

you can go back to this window to select 

more images in succession. 

6. A thumbnail image of the form appears in 

the Image window. If acquiring multiple 

images, use the Previous Page and Next Page arrows under the image to view all images. You 

may delete any images you do not wish to keep by clicking the Delete button or using the drop-

down arrow on the Delete button to fine tune what you are deleting. 

7. Repeat Steps 4-5 to add any other form images to the form template. 

8. If you are satisfied with the image(s), click the OK button. Otherwise, click Browse again to 

reselect an image. Once you click OK, you may be prompted to have the software attempt to 

move your existing regions to the appropriate place on the new image. Review changes carefully 

after repositioning to ensure regions are in the right spots. 

 

To reset a single page 

You may optionally reset the image for a single page instead of using the Reset Images function. 

1. Double click the page node in the tree view representing the page you want to reset. 

2. In the Page Properties window, reacquire the image via the scanner or an image file (same 

instructions as above). 

3. Click the OK button to save the updated image. Once the new image is acquired, the existing 

image is automatically overwritten.  

Once you have reset your images you see all of your existing regions with the new image(s). You may find 

that you need to adjust the existing regions so that they are in the right position on the new image(s). You 

may move or delete regions as needed to line them up with the new image(s). You may also use the Auto 

Align feature to have the software automatically try to readjust the regions. 
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Answer Response Scales 

Remark Office OMR allows you to save the response scales that you use as labels in your OMR regions or 

codes in your Image regions that use qualitative response coding. When you enter custom labels in the 

Region Properties window, you can save them for later use or to edit existing scales. From within the 

Properties window, you only have access to the response scales that fit the region you are defining. For 

example, if you have defined an OMR region that has five possible answer choices, you only have access 

to response scales that offer five answer choices. Therefore, the software allows you to access all of the 

saved response scales under the Tools menu. 

  

To view or modify response scales 

1. Select the Tools menu and then click Response Scales. 

2. Select a scale to view or modify from the Response scales drop-down list.  

3. To delete the scale, click the Delete button. 

4. To edit the scale, type the new information. To 

overwrite the scale, click the Save button. If you want 

to save the edited scale as a new scale, enter a new 

Scale name before clicking the Save button. 

5. To create a new response scale, click the New 

button, provide a Scale name and then enter the 

possible responses in the Labels grid and their 

corresponding numeric values in the Values grid, 

one per line. You may also click the down arrow on 

the New button and choose From Copy. This copies 

the selected scale and allows you to make 

modifications to the copy instead of starting over 

when you want to create similar scales. Click the 

Save button when you have finished creating your new scale. 

6. When you are finished, click the Close button. The scale is now available when you create new 

template regions. 

• Tip: You may right click the mouse within the Labels or Values grid to access cut, copy and 

paste functions. 
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Chapter 6: Template Editor 

Preferences  

Template Editor Preferences Overview 

The Remark Office OMR Template Editor comes with a set of preferences to help you use the software 

optimally. Use these preferences to customize the software to the way you use it. By setting defaults, the 

software works in a way that you use most often. Keep in mind that these are only default settings; you 

can change individual form templates at any time. There are five preference areas you can customize: 

General, OMR regions, Image regions, Barcode regions and OCR regions. 

  

Using the Template Editor preferences 

1. In the Remark Office OMR Template Editor, select the Tools menu and then click Preferences 

to access the preferences. 

2. Select the link in the task pane corresponding to the preference you wish to edit. 

3. Make the appropriate changes. 

4. Click the OK button to save the changes.  

Preferences are global changes and take effect the next time you use the applicable feature. Changing the 

preferences does not affect existing form templates and regions. You may click the Defaults button at any 

time to return the preferences back to their original installation state. 
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Template Editor Preferences - General 

The General window allows you to customize general features of the Template Editor. The following 

options are available: 

  

 

 

 

 

 

 

 

 

 

 

 

 

Section Option Description 

General Preferences Default region name Enter a default region name to be used for every new region 

created. For example, entering "Q" causes every region 

name to be called Q. Remark Office OMR automatically 

appends numbers to the end of the region name so that 

your regions are called Q1, Q2, Q3, etc. 

Spell Checker Folder location Use this setting to specify where the spell checker dictionary 

is located. The default location is the Windows\System32 

folder. 

  Active dictionary Use this setting to choose the dictionary you want to use for 

the spell checker. Any dictionaries installed on your system 

are displayed in the list. 
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Section Option Description 

  Perform application 

logging 

Mark this checkbox to have Remark Office OMR store log 

files that can be recovered if the software terminates 

unexpectedly. The log file contains the work you were doing 

so that it can be restored when you restart the software. You 

are prompted to load the log file in the event of an 

unexpected termination. Use of this feature is strongly 

recommended. 

 

 

 

Template Editor Preferences - OMR 

Regions 

The OMR Regions window allows you to set up 

default settings to be used when creating new 

OMR regions. When creating new OMR regions, 

the selected settings are used automatically. 

However, you can always change individual OMR 

region properties as you go. The following options 

are available: 
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Section Option Description 

Default OMR Region 

Definition 

OMR type Sets the default OMR region type to be used when creating new 

OMR regions: Multiple, Grid, Boolean, List, Add, Binary, Rank. 

  Data type Sets the default OMR region data type to be used when creating 

new OMR regions: Textual or Numeric. The data type is used 

when exporting data. 

  Orientation Sets the default orientation in terms of columns and rows: 

Column- the region contains questions that are oriented in 

columns. 

Row- the region contains questions that are oriented in rows. 

There is an option to read right to left (for column orientation) 

and read bottom to top (for row orientation) if your marks are 

oriented in such a pattern to support your language of choice. 

  Threshold Sets the default recognition threshold for OMR regions. Lower 

thresholds force the software to be more sensitive when reading 

light or less filled marks. Higher thresholds force the software to 

be stricter and therefore more discriminate when reading regions 

with multiple filled marks. Use the default setting of 3 unless you 

encounter problems when processing forms. Use caution when 

using extremely low or high thresholds. Low thresholds cause the 

software to be very sensitive, possibly picking up items such as 

erasures. High thresholds may cause the software to choose the 

most filled mark when two marks are encountered instead of 

outputting a multiple response for your review. 

  Read GRID 

regions in 

reverse 

Use this option if you want to read a grid region in reverse (right 

to left or bottom to top, depending on how it's oriented). 

  Regions to 

Grade 

Use the checkboxes to select the OMR region types that you want 

to be graded by default when performing a grade operation. 

  Regions to 

Tabulate 

Use the checkboxes to select the OMR region types that you want 

to be tabulated by default when performing a survey operation. 
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Section Option Description 

Multiple Response 

Exceptions  

Replace 

MULTIPLE, 

RANK and LIST 

Regions with  

Select the replacement option to be used by default when a 

multiple response occurs for a Multiple, Rank or List region during 

form processing. The text entered in this box appears as output in 

the data grid and is exported in any saved data files. The default 

replacement is All Responses [ALL], meaning that all responses are 

output and the data cell is flagged green. Other pre-defined 

options include MULT, Asterisk (*), Nothing, Space Character, and 

Tilde (~). You may also type characters into the Replace with box. 

  Replace GRID 

Regions with 

Select the replacement option to be used by default when a 

multiple response occurs for a Grid region during form 

processing. The text entered in this box appears as output in the 

data grid and is exported in any saved data files. The default 

replacement is Asterisk (*). Other pre-defined options include 

MULT, Nothing, Space Character, and Tilde (~). You may also type 

characters into the Replace with box. 

Blank Response 

Exceptions  

Replace 

MULTIPLE, 

RANK and LIST 

Regions with  

Select the replacement option to be used by default when a blank 

response occurs for a Multiple, Rank or List region during form 

processing. The text entered in this box appears as output in the 

data grid and is exported in any saved data files. The default 

replacement is BLANK. Other pre-defined options include Asterisk 

(*), Nothing, Space Character, Tilde (~) and VOID. You may also 

type characters into the Replace with box. 

  Replace GRID 

Regions with 

Select the replacement option to be used by default when a blank 

response occurs for a Grid region during form processing. The 

text entered in this box appears as output in the data grid and is 

exported in any saved data files. The default replacement is 

Nothing. Other pre-defined options include BLANK, Asterisk (*), 

Space Character, Tilde (~) and VOID. You may also type characters 

into the Replace with box. 
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Section Option Description 

  Flag GRID, 

MULTIPLE, 

RANK and LIST 

Region Blanks 

Use this setting to further customize how Remark Office OMR 

interprets blank responses: 

Always- If any character in the region is left blank, regardless of 

the replacement characters being used, the region contain a 

yellow BLANK flag.  

Ignore leading/trailing- If leading or trailing characters in the 

region are left blank, they are ignored. This allows you to capture 

data smaller than the allotted region without the data being 

flagged with a yellow BLANK flag. 

Never- If any character within the region is blank, Remark Office 

OMR ignores it. The region never appears with a yellow BLANK 

flag in the data grid. 

Duplicate Response 

Exceptions  

Replace RANK 

Regions with  

Select the replacement option to be used by default when a 

duplicate response occurs for a Rank region during form 

processing. The text entered in this box appears as output in the 

data grid and is exported in any saved data files. The default 

replacement is DUP. Other pre-defined options include Asterisk 

(*), Nothing, Space Character and Tilde (~). You may also type 

characters into the Replace with box. 

OMR Grid Format Delimiter Specify the character to use for the Define Format feature for Grid 

regions. Define Format allows you to format the output of a Grid 

region (e.g. put slashes in between numbers to produce a date: 

**/**/****). The Delimiter is the character displayed in the region 

properties window when you use this feature. Each asterisk 

represents a character in the region. Put the desired delimiter 

between these asterisks. 
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Template Editor Preferences - Image 

Regions 

The Image Region window allows you to set up default settings to be used when creating new Image 

regions. When creating new Image regions, the selected settings are used automatically. However, you 

can always change individual Image region properties as you go. The following options are available: 

 

 

  

 

 

 

 

 

 

 

 

 

Section Option Description 

Default Image Region 

Definition 

Image type Sets the default Image region type: Data Entry, Image Clip or 

Data Entry and Image Clip. Data Entry regions allow you to hand 

enter data from the region into your data grid with the 

assistance of image files. Image Clip regions capture a snapshot 

image of the information in the region and store it on your 

computer. Data Entry and Image Clip regions allow you to 

capture image clips but still use other Image region properties, 

such as default fills and qualitative coding. The information 

captured from all types of Image regions can be viewed in 

reports in Remark Quick Stats. 

  Data type Sets the default Image region data type to be used when 

creating new Image regions: Textual or Numeric. The data type is 

used when exporting data. 
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Section Option Description 

  Threshold Sets the default recognition threshold for Image regions. Lower 

thresholds force the software to be more lenient when reading 

light text or image regions with smaller amounts of text. Higher 

thresholds force the software to be stricter and therefore less 

likely to pick up stray or light markings within the region. Use 

the default setting of 3 unless you encounter problems when 

processing forms. Use caution when using extremely low or high 

thresholds. Low thresholds cause the software to be very 

sensitive, possibly picking up items such as erasures. High 

thresholds may cause the software to not detect handwriting 

within light or less filled Image regions. 

Image Clip Options Target folder Sets the default storage location for the images that are 

captured when using Image Clips. 

  Clip file type Sets the default image file format to use when capturing image 

clips. You may choose TIF, PCX, PDF or JPG. If using the TIF or 

PDF formats, you may also select the compression level. The TIF 

format is recommended. 

Default Grading & 

Survey Analysis 

Grade region Mark this checkbox to grade Image regions by default when 

performing a grade operation. This option is not common, 

unless you are using qualitative coding. 

  Tabulate region Mark this checkbox to tabulate Image regions by default when 

performing a survey operation. This option is not common, 

unless you are using qualitative coding. 
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Template Editor Preferences - Barcode 

Regions 

The Barcode Region window allows you to set up default settings to be used when creating new Barcode 

regions. When creating new Barcode regions, the selected settings are used automatically. However, you 

can always change individual Barcode region properties as you go. The following options are available: 

 

 

 

  

 

 

 

 

 

 

 

 

 

Section Option Description 

Default Barcode Region 

Definition 

Barcode orientation Sets the default orientation to be used when creating new 

Barcode regions: Horizontal or Vertical. 

  Data type Sets the default Barcode region data type to be used when 

creating new Barcode regions: Textual or Numeric. The data 

type is used when exporting data. 

Default Grading & 

Survey Analysis 

Grade region Mark this checkbox to grade Barcode regions by default 

when performing a grade operation. This option is not 

common. 

  Tabulate region Mark this checkbox to tabulate Barcode regions by default 

when performing a survey operation. This option is not 

common. 
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Template Editor Preferences - OCR 

Regions 

The OCR Region window allows you to set up default settings to be used when creating new OCR (optical 

character recognition) regions. When creating new OCR regions, the selected settings are used 

automatically. However, you can always change individual OCR region properties as you go. The following 

options are available: 

 

 

 

 

 

  

 

 

 

 

 

 

 

Section Option Description 

Default OCR 

Region 

Definition 

OCR type Sets the type of OCR to use. There are three options:  

Primary: Primary OCR is Remark Office OMR's built-in OCR engine. It tends 

be faster but may be less accurate. We recommend using this engine as the 

default. 

Legacy: The Legacy OCR option is for backward compatibility with templates 

created in Remark Office OMR 7. You should only use this option if you are 

using an older template and it is working correctly. For new templates, use 

Primary. 

Microsoft Office Document Imaging (MODI): MODI OCR comes with 

Microsoft Office and is only available if you have this software installed with 

the MODI option. Using MODI tends to be slower but yields high accuracy 

rates. 

  Language Sets the default language to use when performing OCR functions. Note that 

the available languages change based upon the type of OCR you are using. 
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  Data type Sets the default OCR region data type to be used when creating new OCR 

regions: Textual or Numeric. The data type is used when exporting data. 

  Orientation Choose the orientation in which to read the region: Left to Right, Right to 

Left, Top to Bottom or Bottom to Top. (Applies to Primary and Legacy OCR 

only.) 

  Auto rotate 

region image 

Mark this checkbox to have Remark Office OMR automatically rotate the 

image in order to read the text captured in the OCR region. If the software 

cannot read the text in one direction, it rotates the image to try again. 

(Applies to MODI OCR regions only.) 

  Threshold Select a threshold to use for the software to determine whether it recognizes 

the printed text. The threshold applies to each individual character. The 

software returns a confidence value for each character recognized (e.g. 70% 

certain it is a "G"). If any character returns a confidence value lower than the 

specified threshold, the OCR field is flagged as an exception for your review. 

Default 

Grading & 

Survey 

Analysis 

Grade region Mark this checkbox to grade OCR regions by default when performing a 

grade operation. This option is not common. 

  Tabulate region Mark this checkbox to tabulate OCR regions by default when performing a 

survey operation. This option is not common. 
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Chapter 7: Processing 

Forms  

Processing Forms Overview 

The Remark Office OMR Data Center is used to process your filled in forms. You can scan forms directly 

into the software with a desktop scanner or import images that you already scanned, such as those you 

scan with a multi-function printer (MFP). When you process forms, you use a grid that is similar to an Excel 

spreadsheet. It utilizes all the familiar functions, such as: 

• Cut, copy, paste 

• Delete data or delete entire grid row 

• Find and Replace 

• Spell Check 

• Sorting 

• Freezing columns or rows 

• Print 

• Save/Save As 

There are various ways to access these basic functions, including the keyboard, menus and toolbar. You 

can use whichever way is comfortable for you. 

The Read feature is used to process filled in forms.  You first choose whether to scan with a scanner or 

import images. Then the on-screen options walk you through the steps to take for each path. As each 

form is processed, there is an associated image for it in the Image Viewer at the bottom of the Data 

Center. You can use this image, as opposed to the paper form, to review results. Any problem areas are 

flagged for you with colors and special words, such as BLANK. You can click a cell to change a response or 

use the Review Exceptions feature for more automated data clean up. Once the data is cleaned, you can 

save it to various formats, including Excel, Access, SPSS, Oracle, SQL Server and CSV. You can also use 

Remark Quick Stats to grade tests and analyze surveys. 

To get started, choose the method that you are using to scan forms below: 

I use a desktop scanner connected to the computer running Remark Office OMR and scan directly into the 

software. 

I use an MFP or other scanning device to scan my forms to a file, and then import that file into Remark 

Office OMR. 
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Scanning Directly into Remark Office 

OMR 

Forms can be scanned with most TWAIN compliant scanners. Click here for more information about 

scanners and how to set them up in Remark Office OMR. As the forms are scanned, images of each form 

are stored on your computer. These images are used in the Image Viewer to review the data for easy clean 

up. There are many optional items when you scan forms that are mentioned below but discussed 

separately (click the related link to learn more about them). 

  

To read pages from the scanner 

1. In the Remark Office OMR Data Center, open 

the correct form template. 

2. Select the Tools menu and then click Read. 

Alternatively, you may select the Read link from 

the task pane or Read toolbar button. 

3. In the Office Read window, select the button for 

Scan. If the Scan button is not enabled, you do 

not have a scanner set up. Click Scanner 

Properties to configure your scanner. 

4. [OPTIONAL] If desired, click the Show Advanced 

Options button and mark the appropriate 

checkboxes under Advanced Data Collection 

Options. Click a link below to understand more 

about each option. 

  

Option Description 

Automatically associate data 

with the corresponding form 

template (Auto Form ID Mode)  

Allows the software to automatically recognize form templates, form 

pages and respondents through identifiers you place on the forms. 

Reset the auto-increment value 

for image regions using Auto 

Form ID 

This feature is used in conjunction with auto incrementing image regions 

across templates. When you scan your forms, the auto incrementing will 

automatically take place among all open auto form ID templates within 

the same session. If for some reason you want to start over, in the same 

session, you can mark this checkbox. Regardless of this checkbox, when 

you close Remark, the next time you use the feature it will start all over 

again. 

file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/Remark%20Office%20OMR%202014/Processing_Forms/Automatic_Form_Processing/Automatic_Form_Processing_Overview.htm
file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/Remark%20Office%20OMR%202014/Processing_Forms/Automatic_Form_Processing/Automatic_Form_Processing_Overview.htm
file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/Remark%20Office%20OMR%202014/Processing_Forms/Automatic_Form_Processing/Automatic_Form_Processing_Overview.htm
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Option Description 

Monitor the system for new 

images to be processed (Server 

Mode) 

Automates form processing by having Remark Office OMR run in the 

background using specific options. 

 

5. [OPTIONAL] If desired, modify the 

recognition settings being used by the 

software by clicking the Recognition 

Settings button. This option opens the 

recognition settings that apply to this form 

template. Note that you should not modify 

the recognition settings unless you 

experience recognition problems with your 

form. The default settings are optimized for 

general use of the software. If you do modify 

the recognition settings from the Read 

window, the settings are stored with the form 

template and therefore still remain in effect 

the next time you use the same form 

template. The settings do not apply to other templates. Click the OK button when finished 

modifying recognition settings. 

6. The first time you read forms you should click the Next button to configure how the related form 

images are stored. You can optionally skip this step on subsequent scans. 

7. The next window allows you to customize the images that are stored for every form that you scan. 

• The image archiving window allows you 

to specify options about the images that 

are automatically stored each time you 

scan forms. In the Begin image names 

with box, enter a file base name that the 

software can use to name the images 

stored for this form. The default base 

name is the form template name; 

however, you may use any name you like. 

We suggest using something that 

identifies to you that the images belong 

to a certain form. The images that are 

stored all begin with this base name and 

then have the page number (if scanning a 

multi-page form), date and time 

appended to them to keep track of the 

various images. You may optionally 

choose a region from the form template 

to use as the base name. The value that is collected from the form for the specified region is 

used as the base name for the corresponding stored image. For example, if scanning student 
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tests you could use a Student ID region with option to name the resulting image files by 

student. If you leave the Begin image names with blank, your images only have the page 

number (if applicable), date and time as the name of each image. 

• In the Destination folder box, click the ellipsis (...) button to select a location in which to 

store the images for this form.  

• Note: Choose the image location carefully. The images should remain in this location 

once the data is saved using the RMX/RMK formats if you want to retain the link between 

the processed data and each image file. This link allows you to view the forms on screen 

as you click through the data grid, making it easy to correct exceptions in your data. 

Therefore, you should plan ahead on how you will store these images when the forms are 

processed. 

• Tip: If you are sharing files with other Remark Office OMR users, you may wish to save 

the image files on a shared network drive that all users have access to in the same 

manner (e.g. through a mapped network drive). 

8. [OPTIONAL] If desired, click the Name Builder button to further customize the stored image 

names and locations. 

• In the Image base name area, you may 

choose to add a region from the 

processed data to the image base name. 

Choose the region from the drop-down 

list and then click the Insert Data Into 

Base Name button. If you already 

added a region in Step 7, the Name 

Builder allows you to add additional 

regions. For example, if processing tests, 

you could add a Student ID that is being 

collected from the form so that your 

processed images all have the Student ID number in them. 

• In the Destination folder area, you may choose to add a region from the processed data to 

the folder structure that holds the processed images. Choose the region from the drop-down 

list and then click the Append Data Onto Folder Path button. For example, if processing 

tests, you could add a Test ID that is being collected from the form so that each student's 

form images are stored in a folder containing the Test ID. 

9. Click the OK button to return to the Read window. 

10. In the Save image as box, select an image type to use for storing images. The choices are: 

PCX/DCX, PDF, TIF, PNG or JPG. 
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11. When saving to the PDF or TIF formats, you 

can choose the compression level under 

Compression level: Uncompressed, Group 3, 

Group 3 2d, Group 4 and LZW. Group 4 

creates the most compressed image (smallest 

file size that take up less space on your 

computer). 

12. Mark the checkbox for Save images in a 

subfolder based on the form template's 

name to have the Data Center automatically 

create a folder in which to store these images 

based on the template name. This is a handy 

way to store all images related to a specific 

form in one place. 

• Tip: We recommend using the Save 

images in a subfolder based on the 

form template's name feature for 

easier organization of image files. Use of this feature keeps all images associated with 

each form template in one folder for easy access. The unique date and time portion of the 

image names prevents images from being overwritten. 

13. Mark the checkbox for Save multi-page form templates as multi-page image files if you are 

scanning a multi-page form and would like all of the images for one complete form to be saved 

as one image file. Using this option creates fewer image files and is recommended.  

• Special Note if you do not have a duplex scanner: If you are reading double sided 

forms without a duplex scanner (uncommon), use the Collate Mode options in this 

window. 

14. If you would like to configure Review Exceptions options (whether to stop scanning when 

exceptions are found), click the Next button to continue. Otherwise click the Read button to 

begin scanning pages, ensuring the pages are in the scanner. 

• Note: If desired you can click the drop-down arrow on the Read button and choose Save 

to have your Read settings saved as an Automation file (.rez). The Automation Control 

Center is used to automate form processing.  

15. [OPTIONAL] If you have an Image region on the 

form that is set to prompt for a fill value, when 

the read process begins, a window appears 

where you can type the desired value. 

16. Remark Office OMR continues scanning pages 

until the scanner's sheetfeeder (ADF) is empty. 

17. After processing all of the pages, you are 

prompted to continue scanning. Click Yes to scan 

more pages or No to end the scanning process.   

Once you have run through the Read window's configuration settings, you may optionally use the Quick 

Scan button on the toolbar for future scans with this template and all of your template's Read settings are 

utilized. We recommend returning to the Read window for any new templates you use to scan. If the 
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Quick Scan button is not enabled, you may not have a scanner set up in the software (Tools|Scanner 

Properties).  

• Tip: You can overwrite specific grid rows of data by highlighting the row(s) first and then 

initiating the read process.  

Importing Images into Remark Office 

OMR 

Remark Office OMR can process image files that have already been scanned. For example, if you have a 

network multi-function printer (MFP) or a scanner that is not compatible with Remark Office OMR, you 

can scan your forms in another application and then save the resulting image files, which you then import 

into Remark Office OMR. The end result looks just as if you had scanned the forms directly in the Remark 

Office OMR Data Center. 

Remark Office OMR can read the following image file formats: 

• PCX (*.pcx) 

• Multipage PCX (*.dcx) 

• TIFF (*.tif, *.tiff) 

• JPEG (*.jpg, *.jpeg) 

• Portable Document Format (*.pdf) 

• PNG (*.png) 

• Windows Bitmap (*.bmp)   

• Tip: It is strongly recommended that you use the TIF/TIFF format for pre-scanned image 

files, particularly if you have a choice between TIFF and PDF (very common on multi-

function printers). PDF files are not native image files and require more processing time, 

making the reading process slower. TIFF Group 4 compression gives you the most 

compressed file for fastest processing. 

  

To import image files  

1. In the Remark Office OMR Data Center, open 

the correct form template.  

2. Select the Tools menu and then click Read. 

Alternatively, you may select the Read link from 

the task pane or Read button on the toolbar. 

3. Select the Read Images button if it is not already 

selected. 

4. [OPTIONAL] If desired, click the link for 

Processing Attributes. This link allows you to set 

the following options: Invert image, Auto deskew 
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images during recognition, Auto despeckle images during recognition and flatten fillable form 

fields on PDF images. The last option should be turned on if you are reading electronically filled 

PDF files (ones that were not scanned). 

• Caution: We do not suggest making changes to the Image Processing Attributes unless 

you encounter difficulties related to these settings.  

5. [OPTIONAL] If desired, click the Advanced Options button and mark the appropriate checkboxes 

under Advanced Data Collection Options. Click a link below to understand more about each 

option. 

 

Option Description 

Automatically associate data 

with the corresponding form 

template (Auto Form ID Mode)  

Allows the software to automatically recognize form templates, form 

pages and respondents through identifiers you place on the forms. 

Reset the auto-increment value 

for image regions using Auto 

Form ID 

This feature is used in conjunction with auto incrementing image regions 

across templates. When you scan your forms, the auto incrementing will 

automatically take place among all open auto form ID templates within 

the same session. If for some reason you want to start over, in the same 

session, you can mark this checkbox. Regardless of this checkbox, when 

you close Remark, the next time you use the feature it will start all over 

again. 

Monitor the system for new 

images to be processed (Server 

Mode) 

Automates form processing by having Remark Office OMR run in the 

background using specific options. 

Archive images after processing Allows you to archive the images in a different format and/or location. 

(See below for more information.) 

  

6.  [OPTIONAL] If desired, modify the recognition 

settings being used by the software by clicking 

the Recognition Settings button. This link 

opens the recognition settings that apply to 

this form template. The link is provided in the 

Read window for your convenience. Note that 

you should not modify the recognition settings 

unless you experience recognition problems 

with your form. The default settings are 

optimized for general use of the software. If 

you do modify the recognition settings from 

the Read window, the settings are stored with 

the form template and therefore still remain in 
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effect the next time you use the same form template. The settings do not apply to other 

templates. 

• Caution: We do not suggest making changes to the Recognition Settings unless you 

encounter difficulties related to these settings.  

7. Click the Next button to continue. 

8. In the Which images would you like to process area, use the drop-down list to locate the folder 

on your computer or network that contains the images you wish to process. 

9. Once you have located the correct folder, select the images you wish to process. You may make 

multiple selections by holding down the Ctrl key and clicking images or holding down the Shift 

key and selecting a range of images (click the first and last image and all images in between are 

selected). 

10. Click the Add Selected button to move the 

images into the bottom window. Alternatively, 

you can select an entire folder's set of images by 

clicking the bottom Add All button. The images 

are moved to the Image List (in Read Order) 

box. The selected images are processed in the 

order in which they appear in this box. 

11. If an image appears in the Images in Image List 

box and you wish to remove it, select the image 

and then click Remove Selected. You may make 

multiple selections by holding down the Ctrl key 

and clicking images or holding down the Shift 

key and selecting a range of images (click the 

first and last image and all images in between 

are selected). You can also remove all images by 

clicking the Remove All button. 

12. Click the Next button to continue.  

13. If you are using the Archive images after processing option from Step 1 of the Read window, 

proceed to step 14. If you are not using this feature, proceed to Step 15. 
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14. [OPTIONAL] If you chose the Archive images after processing option on the first step of the 

Read window, the image archiving window appears, allowing you to specify options for archiving 

the processed images.  

• In the Begin image names with box, 

enter a file base name that the 

software can use to name the images 

of each form. The default base name 

is the form template name; however, 

you may use any name you like. We 

suggest using something that 

identifies to you that the images 

belong to a certain form. The images 

that are stored all begin with this 

base name and then have the page 

number (if processing a multi-page 

template), date and time appended 

to them to keep track of the various 

images. You may optionally choose a 

region from the form template to 

use as the base name. The value that is collected from the form for the specified region is 

used as the base name for the corresponding stored image. If you leave the Begin image 

names with option blank, your images only have the page number (if applicable), date 

and time as the name of each image.  

• Note: If you are processing images for multiple form templates using the Auto 

Form ID feature, as long as all open form templates have a region name in 

common, you may use that region as your Begin image names with choice. 

Remark Office OMR names the images appropriately by pulling the data from the 

corresponding form template file. 

• In the Destination folder box, click the ellipsis (...) button to select a location in which to 

store the archived images for this form.  

• Note: Choose the image location carefully. The images should remain in this 

location once the data is saved using the RMX/RMK formats if you want to retain 

the link between the processed data and each image file. This link allows you to 

view the forms on screen as you click through the data grid, making it easy to 

correct exceptions in your data. Therefore, you should plan ahead on how you 

will store these images when the forms are processed. 

• Tip: If you are sharing files with other Remark Office OMR users, you may wish to 

save the archived image files on a shared network drive that all users have access 

to in the same manner (e.g. through a mapped network drive). 

• [Optional] If desired, click the Name Builder button to further customize the stored 

image names and locations. 

• In the Image base name area, you may choose to add a region from the 

processed data to the image base name. Choose the region from the drop-down 

list and then click the Insert Data Into Base Name button. If you already added 
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a region on the previous 

screen, the Name Builder 

allows you to add 

additional regions. For 

example, if processing 

tests, you could add a 

Student Name field that is 

being collected from the 

form so that your 

repackaged images all 

begin with the students' names. 

• In the Destination folder area, you may choose to add a region from the 

processed data to the folder structure that holds the archived images. Choose the 

region from the drop-down list and then click the Append Data Onto Folder 

Path button. For example, if processing tests, you could add teacher name and 

student ID fields that are being collected from the form so that each student's 

form images are stored in a folder containing the teacher's name and then a 

subfolder named by the student ID number. 

• In the Name Builder box, click the OK button to return to the Read window. 

• In the Saved image as box, select an image type to use for storing the repackaged 

images. The choices are: PCX/DCX, PDF, TIF or JPG. For example, you may be processing 

TIF images, but want to archive them as PDF files for others to view. 

• When saving to the PDF or TIF 

formats, you can choose the 

compression level under 

Compression level: 

Uncompressed, Group 3, Group 3 

2d, Group 4 and LZW. Group 4 

creates the most compressed 

image (smallest file size that takes 

up less space on your computer). 

• Mark the checkbox for Save 

images in a subfolder based on 

the form template's name to have 

the Data Center automatically 

create a folder in which to store 

these images. The folder name is 

the name of the form template and 

the folder is created in the directory 

you have selected in the Image target directory box.  

▪ Tip: We recommend using the Save images in a subfolder based on the form 

template's name feature for easier organization of image files. Use of this 

feature keeps all images associated with each form template in one folder for 

easy access. The unique date and time portion of the image names prevents 

images from being overwritten. 



 

87 

 

• Mark the checkbox for Save multi-page form templates as multi-page image files if 

you are processing a multi-page form and would like all of the images for one complete 

form to be saved as one image file. Using this option creates fewer image files and is 

recommended. 

• Mark the checkbox for Delete the original images once they are archived if you want 

to permanently delete the image files you processed, leaving you only with the archived 

images. 

15. If you would like to configure Review Exceptions options, click the Next button to continue. 

Otherwise click the Read button to begin processing image files. 

16. [OPTIONAL] If you have an Image region on the 

form that is set to prompt for a fill value, when 

the read process begins, a window appears 

where you can type the desired value. 

• Note: If desired you can click the drop-down 

arrow on the Read button and choose Save 

to save your Read settings as an Automation 

file (.rez). The Automation Control Center is 

used to automate form processing.  

  

The Data Center continues processing images until all of the specified images are read. You then see a 

spreadsheet of data. Each row represents one complete form and each column represents each question 

you defined in the form template. 

Using Batch Headers 

The Remark Office OMR Data Center includes a batch processing feature that allows you to process batch 

header forms along with your forms. Batch header forms provide further information about the group of 

forms being processed that make your data more meaningful. For example, if you are processing student 

tests or course evaluations, you can process a batch header form containing information such as 

instructor name, class name, class section, and so forth. The batch header form is processed once, at the 

beginning of each batch. Then the forms that correspond to that batch header form are processed 

subsequently. The data from the header form is pre-pended to (added to the beginning of) each data 

record. You can start processing a new batch and its corresponding forms at any time. The header data is 

also available when it comes time to report on the data in Remark Quick Stats. 

To create a batch, you create form templates for the batch header form(s) and the form you wish to 

process with that batch header form (called a primary form template). You can use multiple batch header 

forms but only a single primary form template. You then combine these form templates into a batch file. 

Both forms must have unique Page IDs on them. Remark Office OMR uses the page IDs to understand 

when a batch header form is being read versus a regular form. Therefore page IDs are required, even for 

single page forms. 
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To use batch headers 

1. Create a form template for the form you wish 

to process as a batch header form. Ensure the 

form has a Page ID. 

2. Create a form template for the form you wish 

to process along with the batch header form. 

Ensure the form has a unique Page ID. 

3. In the Remark Office OMR Data Center, 

select the File menu and then click Batch 

Creator.  

4. In the Batch Creator (Step 1) window, select 

the form template that is being used as the 

primary form template (not the header form). 

This is the form template that corresponds to 

the form you wish to process after each batch 

header form. Click the Add File(s) button to 

add the form template to the Primary Form 

Template box. 

5. Click the Next button to continue. 

6. In the Batch Creator (Step 2) window, select 

the form template corresponding to your 

batch header form. Click the Add File(s) 

button to add it to the Batch Header Form 

Templates box. You may select multiple 

batch header form templates if desired. 

7. Click the Next button to continue. 

8. In the Batch Creator (Step 3) window, enter 

a file name for the new combined batch file. 

The Data Center combines the form template 

and batch header form template(s) into one 

batch file. The new combined file has a .obf 

file extension. 

9. Click the Create Batch button to combine the 

templates and exit the Batch Creator. When 

the batch file opens in the data grid, a dark 

line defines the end of the batch header form template regions from the beginning of the primary 

form regions. 

10. Process the first batch header form (or forms) by starting the Read process and either scanning 

forms or reading image files. If you need information about how to use the Read window, click 

here if reading from a scanner or click here if importing image files. 

11. Follow the batch header form with the forms that correspond with the group identified on the 

batch header form. 
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12. When the first group of forms has been 

processed, insert a new batch header form 

and follow it with the corresponding 

forms. Continue processing forms in this 

fashion until you have processed all of 

your batches. In the end, you see an entire 

data set with all of the batch header 

information pre-pended to the records. 

• Tip: If you have already created a 

batch file and want to open it without 

using the Batch Creator, select the File 

menu and then select Open Form Template. Change the Files of type drop-down list to 

Remark Office Batch Files to view available batch files. Recently used batch header files are 

also included in the Recent list in the task pane.  

Collating Forms 

The Remark Office OMR Data Center provides Collate Mode to read duplex (double-sided) forms when 

you have a simplex (single side only) scanner. Therefore, if you do not have a duplex scanner (one that 

reads both sides of a form in a single pass) you can still process double-sided forms in the software. 

Collating forms only applies when you are reading forms with a scanner that is directly connected to the 

computer running Remark (not when importing image files from another scanner/MFP). Please note that 

most scanners have duplex capabilities and using Collate Mode is an uncommon situation. Use the 

Scanner Properties link to turn on and off duplex mode if your scanner has this capability. 

If you do not have a duplex scanner, to use Collate Mode you perform two basic steps: place a stack of 

forms in the scanner's automatic document feeder and scan the odd numbered pages, flip the stack over 

and then scan the even pages. The forms are placed in the scanner in regular page order. The Data Center 

reads all odd numbered pages first, regardless of how many sets of forms you place in the scanner. The 

software then reads the even numbered pages in reverse order so that the data are written to the correct 

position. For example, suppose you have a six page, double-sided form. You would first scan pages one, 

three and five, then flip the stack over and scan pages six, four and two. When scanning in Collate Mode, 

make sure the forms are in regular page order, with all pages belonging to one complete form together. 

• Note: If your form does not have an even number of pages (e.g. the last page has a blank 

backside), Remark Office OMR automatically compensates for the blank backside. You do not 

need to create a blank form template page. 

  

To process pages using Collate Mode 

1. Open the correct form template. 

2. Select the Tools menu and then click Read. Alternatively, you may select the Read link from the 

task pane or Read toolbar button. 

3. Select the button for Scan. If the Scan button is not enabled, you do not have a scanner set up. 

Click Scanner Properties to configure your scanner. 
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4. Click the Next button to continue. If you need 

assistance with general Read properties, please click 

here and then return to Step 5. 

5. In the image archive window, mark the checkbox for 

Automatically organize pages while processing 

(Collate Mode). Note that there is an option here to 

resume a the last collate session should you need it 

(e.g. you do two scanning sessions in a row or your 

scanning session is interrupted). 

• Note: Collate Mode is only enabled if you open 

a multi-page template and you do not have the 

Scan Duplex option marked in the Scanner 

Properties window. 

6. Place all double-sided forms you want to read in the 

automatic document feeder of your scanner in normal page order and then click the Read button. 

The Data Center begins reading the odd numbered pages (the front sides of the forms). When 

finished processing the odd numbered pages, you are prompted to read in the other direction. 

7. When prompted, turn the stack of forms over 

and place it back in the automatic document 

feeder of the scanner. Do not rearrange the 

forms. The Data Center collates the forms 

properly. 

8. Click the checkbox for Begin Scanning in the 

Other Direction.  

9. Click the Continue button. 

10. When finished reading the even pages (the 

backsides), you are prompted to start a new 

batch or finish processing. Continue reading 

forms in this manner until all forms have been 

processed. 

• Caution: When using Collate Mode, scan complete form sets in batches. Complete an entire 

set of odd and even pages before scanning more forms in a single direction. This way if the 

scanning process is interrupted unexpectedly, you are less likely to lose any data and it is 

easier to recover. 
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Respondent Detection 

Remark Office OMR includes the ability to determine which respondents' forms have been processed, as 

well as locating duplicate respondents. This feature, called Respondent Detection, is used in conjunction 

with Database Lookup. If a region is linked to an external database using Database Lookup, the software 

provides a report of which respondents listed in the external database have been processed, not been 

processed or have been processed more than one time. For example, suppose you have a region on your 

form where the respondent fills in an ID number. You can link this ID number region to an external 

database that has all of the ID numbers of your expected group of respondents. You can then use 

Respondent Detection to compare IDs collected in the data set to IDs in the external database. Any time 

you use the Respondent Detection feature, you also have the option to return additional data from the 

external database if desired (this is not required to use Respondent Detection). When you process your 

forms, Remark Office OMR confirms which ID numbers from the external database exist in the processed 

data. The software then provides a report showing found ID numbers, missing ID numbers and duplicate 

ID numbers. If you are returning additional fields, this information is also available in the report. You can 

save this report as a text file to use outside of Remark Office OMR. 

 

To use Respondent Detection 

1. Setup a form template that uses the Database Lookup feature. 

2. Process forms using the scanner or by reading from image file using the Read window. If you 

need information about how to use the Read window, click here if reading from a scanner or click 

here if importing image files. 

3. Once the forms have been processed and the data cleaned, select the Tools menu and then click 

Respondent Detection.  

• Note: You can run Respondent Detection with multiple data sets open. The Data Sets 

window opens, allowing you to choose the open files you wish to include in the save 

operation. Mark the checkboxes of all 

data sets you wish to include in the 

operation. You may use Select All to 

select all data sets in the list. Please note 

that the data set must correspond to the 

active form template in order for it to be 

included. 

4. Choose the template region identifying 

respondents from the Respondent region 

drop-down list. 

5. If the region is linked to a database 

containing additional fields, you may 

optionally select those fields from the 

Database Field List. Use the arrow to move 

the desired fields into the Additional Fields 

box. Any fields moved to the Additional 
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Fields box are also used for detecting respondents. 

6. Click the Search button to continue. The Detection Results window appears. 

7. Use the Detection Results window to view 

your results. The main region on which you 

are basing the detection is listed first. You 

then see a Detected column that marks the 

values that were detected. The Duplicates 

column is next, which marks any duplicate 

values that are found. After the Duplicates 

column, you see any additional return fields 

from the external database that you 

selected in Step 5 (if you selected any). 

8. If desired, use the Export button to save the 

results to an external file. You may click the 

Export button to export the entire set of 

results, or use the arrow on the Export 

button to select which portions of the 

results to export. The export options are as 

follows: 

Option Function 

Export Exports all results (region, detected, missing, duplicates and additional fields). 

Export 

Missing 

Exports only the missing respondents, those that exist in the external database but were 

not processed as part of the data file. 

Export 

Detected 

Exports only the detected respondents, those that both exist in the external database 

and were processed as part of the data file. 

Export 

Duplicates 

Exports only the duplicate respondents, those that appear more than once in the data 

file. The software only detects duplicate entries that have also been verified as existing in 

the linked database. 

Print Results Prints all results to the default printer on your computer. 

  

9. Click the Close button to return to the Remark Office OMR Data Center.  
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Server Mode 

Server Mode is a mode of operation in which Remark Office OMR runs in the background, processing 

pages or image files according to your instructions. Server Mode allows you to simultaneously use your 

computer for other things while using Remark Office OMR to process forms. Server Mode can also be 

used to process completed forms that are received as image files over a network or by fax. You can use 

Server Mode in conjunction with Auto Form ID to process a variety of form types. 

Server Mode works in two ways: continuously polling the scanner for pages and/or checking a folder on 

your computer or network for image files. The following table summarizes how each event works. 

Reading from a scanner: If you have a scanner set up in Remark Office OMR, you may use this option. 

Your scanner must have an Automatic Document Feeder (ADF). The Data Center polls your scanner for 

pages at a user-specified interval. If pages are found, they are scanned automatically with the open 

template(s). The Data Center stores images of these scanned forms for later correction. Note that some 

computer performance degradation should be expected while a page is being scanned 

Reading from image files: You may have the Data Center process image files from a folder that you 

specify on your computer or network. Supported image files are processed in the order of file creation 

date. This feature allows you to use scanning software that came with just about any input device to scan 

your pages. Then save these scanned images to a folder and the Data Center automatically processes 

them. 

  

To use server mode: 

1. Open a template and then open the Read window. 

2. After choosing whether to Scan or Read Images, click the Advanced Options button. 

3. Mark the option for Monitor the system for new images to be processed (Server Mode).  

4. Click the Next button.  

5. If you are polling a folder for images: 

• In the next window, choose the folder 

that contains the images you wish to 

read. Use the Add Folder and Delete 

Folder buttons to ensure you have the 

right folder(s) listed. 

• Choose the image types you want to 

read in the Image Filters box. For 

example, if your forms will all be TIF 

files (recommended), mark the 

checkbox for *.tif. If you are expecting 

a mix of image types you can select *.* 

for all supported types. 



 

94 

 

• [OPTIONAL] You may use a custom image filter to further define your image reading list. 

You can set up specific cases here by using wildcards. For example, if you wanted to 

process all images that start with 

"English 101" you could enter "English 

101*.*" as a custom filter. Only images 

that start with this text are processed. 

Type the custom filter into the 

Custom Filters box and then click the 

Add Filter button. The filter is added 

to the Image Filters list and 

automatically selected. Unused 

custom filters are removed from the 

list automatically the next time you 

run the Read operation. Note that 

when specifying image types, an 

asterisk (*) can be used to indicate 

any number of characters (e.g. .jp* 

would allow any number of characters 

after the "jp" such as .jpg and .jpeg), 

and the question mark (?) can be used to indicate any single character in addition to the 

specified file extension (e.g. .jp? would only allow three character extensions such as .jpg). 

When using a custom filter, it is executed separately from any other filters you may have 

applied, so make sure you include the extension type if needed. For example, do not turn 

on the generic PDF filter and add a wildcard such as "English101" or else you will get all 

PDFs and all files beginning with "English101. Instead, if you want English101 PDF files, 

specify "English101.pdf". 

• If you want the original images deleted once they have been processed, mark the Clean 

them up; delete the images from my system checkbox. Note that if you use this option 

you cannot get the images back. You may want to consider combining Server Mode with 

the Archive Images option on the first step of the Read window so that once the images 

are processed, you have a copy of them. If you do nothing with the images, Remark 

Office OMR continues to re-read the same images over and over again.  

6. If you are scanning forms: 

• Simply follow the normal steps in the Read window; you do not have to do anything 

special to accommodate server mode. 

7. Complete the remaining steps in the Read window. These steps are not outlined here; if you need 

assistance with the general Read window settings, click here if reading from a scanner or click 

here if importing image files. 

8. Click the Read button to start Server Mode. Remark Office OMR searches for images or checks 

the scanner for pages, per your instructions. 

9. When you are reading to end Server Mode, select the End Server Mode button on the toolbar or 

select the Tools menu and click End Server Mode.  

• Important Note About Using Server Mode and Page IDs: If you are using Page IDs with 

Server Mode, form processing stops if a Page ID cannot be recognized. You need to sort your 
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forms/images so that each respondent's form is scanned in its entirety before another form is 

processed.  

Reviewing Duplicate Responses 

Remark Office OMR includes a feature to detect duplicate responses even when not using the Database 

Lookup feature with Respondent Detection. The Review Duplicates feature allows you to choose any 

region in the data grid in which to search for duplicates. When a duplicate entry is found, you are 

prompted to take one of four possible actions: review the duplicates, keep only the first duplicate record, 

keep only the last duplicate record or delete all duplicate records. During the review process, the data grid 

is automatically sorted on your duplicate identifier region so that you can easily review the data. This 

feature is useful if you accidentally process a form multiple times, or someone fills out a form multiple 

times when this is not permitted. 

  

To use Review Duplicates 

1. Open a form template and process forms by either scanning or importing images with the Read 

option. If you need information about how to use the Read feature, click here if reading from a 

scanner or click here if importing image files.  

2. Once the data is collected and cleaned, select the Tools menu and then click Review Duplicates, 

or select the Review Duplicates link in the task pane.  

3. In the Review Duplicates task pane on the left side of the window, use the Which column 

contains the respondent ID drop-down list to choose a region or image files from your data that 

you want to check for duplicate entries. 

Using the Image Names option is useful 

if an entire set of forms was accidentally 

processed twice. If the same set of 

images exists more than one time 

(based on the image file names), the 

images are flagged as duplicates. 

4. Click the SEARCH button to begin the 

search for duplicate entries. Remark 

Office OMR tells you how many 

duplicate records are found. 

5. Determine the action you wish to take: 

• Review: If you want to review the duplicates before taking action, choose Review 

Duplicate Records and then click the REVIEW button. Remark Office OMR highlights any 

sets of duplicate records it finds. The NEXT button takes you to the next duplicate record 

within the same group. The Go To Next Group drop-down arrow on the NEXT button 

takes you to the next group of duplicates (you may have more than one set of duplicates 

within the same region). Similarly, the PREVIOUS button takes you back to the previous 

duplicate record within the same group, and the Go To Previous Group drop-down 

arrow on the PREVIOUS button takes you back to the previous group of duplicate 
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records. During the review, you can click the DELETE RECORD button to delete the 

highlighted record. 

• Keep First Duplicate Record Only: If you select this option, the first record in every set 

of duplicate records found is kept and any duplicates are deleted. Click the PURGE 

button to take this action. 

• Keep Last Duplicate Record Only: If you select this option, the last record in every set of 

duplicate records found is kept and any duplicates are deleted. Click the PURGE button 

to take this action. 

• Delete All Duplicate Records. If you select this option, all duplicate records are deleted. 

Click the DELETE button to take this action. 

6. If you choose any action that causes records to be deleted, you receive a warning message to 

ensure that you want to delete the records. Note that once the records are deleted, they cannot 

be recovered (unless you process the forms again). If you are sure you want to proceed, click the 

Yes button. The requested action is taken. 

7. If you wish to search for more duplicates in other regions, repeat step 5. 

8. When you are finished reviewing duplicates, click the FINISH button. 

9. Click the Back arrow underneath Review Duplicates to return to the full task pane. 

Recognition Tools 

When form recognition errors occur, Remark Office OMR offers tools to help you diagnose and 

troubleshoot why the errors are occurring. The Recognition Tools feature allows you to view form 

template region offset, giving you an opportunity to reset your form template to the processed image on 

the fly and re-recognize the form. You can also save revised form templates as new form template files. 

This feature is useful, for example, if you receive forms from various sources and they are all offset from 

the original used to create the form template. Instead of resetting the form template for every batch, you 

can reset it to the batch in the Data Center. Another example where this feature is useful is if you 

photocopy forms. Suppose you run out of forms and photocopy more forms from a photocopy. It is very 

likely that the new batch will be offset compared to the old batch. Using the Recognition Tools, you can 

reset the form template to the new batch on the fly. 

The Image Viewer is required to use the Recognition Tools feature. If the Image Viewer is not visible, click 

View|Image Viewer to turn it on. You may also find it helpful to close the Graph Viewer when using the 

Recognition Tools so that you have more room for the Image Viewer. 

The Recognition Tools feature can only be used on data where the links to the images are intact. You can 

use the feature with data you just scanned or read from image files as well as with data saved to the RMK, 

RMX, ROA or ROX formats. If the data is saved to a different format, where the link to the processed 

images is no longer present, the Recognition Tools feature has no effect on the data. 

The Recognition Tools draw feature allows for three basic activities, all of which are visible in the Image 

Viewer: 

• Highlight Recognized Question: Highlights the recognized (active) question so that you can see 

where Remark is attempting to find data on the image. Recognized questions display in a blue 

color. 
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• Highlight and Adjust Recognized 

Regions: Highlights all regions on 

the image so that you can see 

where Remark is attempting to find 

data on the image. These regions 

display in a dark gray color with a 

solid border. 

• Highlight Template Regions: 

Highlights all of the form template 

regions as they were defined when 

you created the form template. By 

viewing the defined form template 

regions and the current form template regions on the selected image, you can easily see any 

offset. Form template regions display in a light gray color with a dashed border. 

When viewing regions, if you notice that the image is significantly offset compared to the form template 

image, you can move regions, optionally save your changes and then re-recognize the data. Original form 

template regions cannot be moved, but you can move the gray regions that display when you select 

Highlight and Adjust Recognized Regions. 

Once you have the regions moved to the 

correct place on the specific image, you 

have three options for rereading forms: 

• Reread Region: The Reread Region 

option reads only the active region 

for the selected image. This option 

is best when you are having 

problems with only a specific region 

on a specific image.  

• Reread Page: The Reread Page 

option reads all of the regions on 

the active page. The entire page is 

reread regardless of the Highlight options chosen. This option is best when an entire image within 

a batch is shifted. 

• Reread Batch: The Reread Batch option reads all of the images corresponding to the data in the 

data grid. The entire batch is reread regardless of the Highlight options chosen. If you would only 

like to select a portion of the records to reread, choose the grid rows and then select the Reread 

Batch option. This option is best when you know an entire batch of forms is offset in the same 

way (e.g. all from the same photocopied form that is shifted to the left/right/top/bottom). 

When you make changes to the positioning of the regions, you may optionally save the form template 

(overwrite existing or as a new form template) by clicking Save Region Position Changes. This feature is 

helpful if you want to reread an entire batch of forms using the adjusted positions. Suppose you discover 

that the new batch of forms was created off of a different printer or photocopied from a new photocopier. 

You may wish to save the adjusted form template so that you can continue using it with the newly offset 

forms or to reread the current batch with the modified form template. If you attempt to reread a batch 

without saving your modifications, the changes are lost and not applied while reading. 
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• Note: The newly saved templates have the new region locations saved with the original form 

template images. Therefore, if the newly modified template is opened in the template editor, the 

regions may or may not line up correctly. Ideally, you should replace the image with a more 

appropriate one if you want to edit the template in the template editor. 

  

To use Recognition Tools 

1. After processing data or opening an RMK/RMX/ROA/ROX data file, click the DATA tab in the task 

pane (if it is not already active). 

2. Select the link called Recognition Tools. The task pane changes to reflect the available options. If 

the Image Viewer is not showing, click View|Image Viewer. 

3. Determine what you want to view, based on the descriptions above: Highlight Recognized Region, 

Highlight and Adjust Recognized Regions and/or Highlight Template Regions. 

4. Once you have viewed the desired regions, make adjustments to the regions by clicking them 

with the mouse and dragging them to the desired place on the image. Remember that only the 

Highlight and Adjust Recognized Regions option allows you to move regions in order to re-

recognize them. 

5. If you wish to save the changes to a new form template, click the Save Region Position Changes 

link in the task pane. Select a template name and location for the new file. We do not recommend 

overwriting the original template file. If you do not save the form template, all changes are lost. 

• Tip: If you are working from a saved data file and save the new form template, when you 

open the new form template with the old data file together, you receive an error stating that 

the files do not match. As long as you did not change the structure of the form template file 

(in the Template Editor), you should be able to click OK to attempt to open the data file 

anyway. Remark Office OMR is only displaying an error because the data was not originally 

saved with the new form template. 

6. If you want to reread the images, choose one of the available options based on the previous 

descriptions: Reread Region, Reread Page or Reread batch. 

7. You receive a warning message allowing you to choose whether to continue and overwrite the 

existing data in the grid. Click Yes to continue or No to stop the rereading process. 

• Note: If you choose to reread the batch, a preliminary warning asks if you want to save the 

changes to a new form template file. Click Yes to save a new form template and then reread 

the batch, click No to revert to the original form template settings (thus canceling any 

changes you made) and click Cancel to stop the rereading process (the changes you made 

using Recognition Settings are still intact). Then you can click Yes or No to the data overwrite 

warning if you choose to continue with the rereading process. 

8. Once the rereading process completes, a message appears telling you if it was successful. 

9. You may continue to make adjustments as needed. 

10. To return to the regular task pane, click the Back link within the task pane or the DATA tab at the 

top of the task pane.  
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Database Connection Settings 

If you set up a database connection in the form template, you can adjust the settings from the Data 

Center by using the Database Connection Settings link in the task pane. This feature allows you to change 

the database connection, the lookup criteria and save the settings to the existing or a new form template. 

This feature is useful if the database filename or file location changes. It also is useful if you want to save a 

connection for different users; you can set up the connection once, and then modify it for each user. 

 

To use Database Connection Settings 

1. Open the desired form template. 

2. In the task pane, click Database Connection Settings. The Database Connection Tool window 

appears. 

3. This window is the same as the window for setting up 

the database connection in the template editor. You 

can change the Type, Lookup & Return Fields and 

Additional Return Fields. Make the desired 

adjustments. 

4. Choose whether to save the changes to the form 

template by clicking the Save changes to the form 

template file checkbox. 

5. If you would like to rerun the lookup with an open 

data set, click the Rerun lookup checkbox. When you 

close this window, Remark Office OMR will cycle 

through your data and apply the new database 

connection to the open data set. 

6. [Optional] If you want to save the changes to a new 

form template (e.g. for a different user) click the Save 

As… button. Enter a file name and choose a 

location for the form template file, and then click the Save button. You are automatically 

returned to the Data Center. 

7. If you did not use the Save As option, click the OK button to return to the Data Center and 

process your forms. 

Automatic Form Processing Overview 

Remark Office OMR allows for three types of automatic tracking and detection to assist with form 

processing: Auto Form ID, Auto Page ID and Respondent Tracker. With Auto Form ID, Remark Office OMR 

can automatically recognize a form and match it to its form template, allowing you to process various 

form types at once without pre-sorting the forms. With Auto Page ID, Remark Office OMR takes it a step 

further and identifies specific page order within a form template if the pages are scanned out of order. 

With Respondent Tracker, Remark Office OMR recognizes a specific respondent's page and places it in the 

correct data grid row with the rest of that respondent's data if the pages are processed out of order. 

Form, Page or Respondent IDs can be OMR, OCR or Barcode regions. 
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• Tip: You can use delimited barcodes as identifiers. Delimited barcodes contain multiple items 

within a single barcode. When set up in the Template Editor, you can tell the software which part 

of the barcode to use as the Form, Page or Respondent Identifier. 

Using automatic identification is a two part process. You must first set up the template to include the 

identifier of your choice (form, page or respondent). If using form IDs, when you process forms you turn 

on the Auto Form ID feature. For page and respondent tracking, you simply process forms as usual. 

Using automatic form identification is an advanced feature. Make sure you understand how to create 

templates and how to read forms before attempting to use this feature. 

Automatic Form Identification 

Remark Office OMR provides an Auto Form ID option for automatically matching a form with its 

corresponding form template. This type of form recognition allows you to process many different form 

types without pre-sorting the forms. 

• Note: You cannot use the Collate Mode option with Auto Form ID. If you wish to process double-

sided forms using Auto Form ID, you need to use a duplex scanner. 

Each form type you want to use with Auto Form ID must contain an ID region on every form template 

page. The ID region can be an OMR, OCR or Barcode region. 

• Note: For backwards compatibility, forms with an ID region on the first page only still work in 

Auto Form ID mode, when using Auto Form ID by itself. If you wish to use Auto Page ID or 

Respondent Tracker in conjunction with Auto Form ID, you must have identifying regions on every 

page of the form. 

  

To use Auto Form ID 

1. Outside of Remark Office OMR, create a form that contains a unique identifier on each page that 

can be captured as an OMR, OCR or Barcode region in the Remark Office OMR form template. 

• Tip: The Auto Form ID region could be a series of bubbles that represent form numbers, such 

as 1-4. Or it could be a barcode or OCR area that identifies a specific form, such as "Form A".” 

2. Create a form template in the Remark Office 

OMR Template Editor for each form you wish 

to process in Auto Form ID mode. When 

creating the form template, set the region to 

be used as the Form ID region in the Tracking 

section of the region's properties. Mark the 

checkbox for Use Region as a Unique 

Identifier. Then select the radio button 

marked Form ID. Click here for further details 

on setting up the form ID in the template. 

3. When you are ready to start processing forms, 

open the form templates you wish to use in 

Auto Form ID mode in the Data Center. Only 

open form templates that contain Auto Form 

ID regions. 
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4. Read forms from either scanner or image file by 

selecting the Tools menu and then clicking 

Read. If you need information about how to use 

the Read window, click here if reading from a 

scanner or click here if importing image files.  

5. In the Read window, go to the section titled 

Advanced Data Collection Options, click the 

Advanced Options button and then mark the 

checkbox for Automatically associate data 

with the corresponding form template (Auto 

Form ID Mode). 

6. Click the Next button to configure remaining 

Read window options.  

7. On the final step, you can determine whether to 

stop the process if a form is not recognized by 

marking the Review unrecognized images 

during the read process. If this checkbox is not 

marked, any unrecognized images are stored in 

the Unrecognized Image Queue for later 

review (see below).  

8. Make your selections and then click the Read 

button. 

• Caution: When using Auto Form ID alone, 

the Data Center processes multiple page 

forms sequentially. After recognizing the 

first page of a multiple page form, Remark 

Office OMR assumes the following pages 

belong to the same form template. You may 

optionally use the Auto Page ID and/or 

Respondent Tracking features to process 

pages out of sequential order. 

After recognizing the form type, the Data Center places the data into the appropriate data grid window. 

Any images that the Data Center cannot recognize enter a queue of unrecognized images. You can review 

these images during or after form processing. 

Unrecognized Form Images 

If a form is not recognized, you use the Unrecognized Images window to rectify the problem. You may be 

able to match the form (in the case of the ID region just not being recognizable) or you can discard the 

image if it truly doesn't match any open form templates. You can use the Unrecognized Images window 

during form processing or wait to review all unrecognized forms after the Read operation finishes, as 

mentioned in Step 7 above. Regardless of how you display the unrecognized images, using the window is 

the same process. 
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1. When the Unrecognized Image window appears for an unrecognized image, the Form 

Templates list is empty. Use the image viewer in the right portion of the screen to assist with 

understanding which form has been processed. Then decide whether the form matches an open 

template or if you want to discard it all together. 

• To keep the form image, click the drop-

down list to choose the correct form 

template for this image.  

• To remove the form image, click the 

Discard button, which removes it from 

the queue. This might be appropriate if 

the wrong form was scanned (or the 

wrong image was processed). Note that 

if you do this during processing the 

image is completely deleted. If you are 

using the queue after processing, the 

image no longer appears in the queue 

but is not deleted.  

• Note: You also have a Skip button to move to 

the next unrecognized image (if reviewing post-processing) and an Abort (stops the read process 

if reviewing during form processing) or Cancel (stops the image review process if reviewing post-

processing) button to end the process. 

2. Once you have matched a form to its form template or discarded it, click the Read button to 

continue processing. 

3. If using the Unrecognized Image Utility during form processing, forms continue to be read until 

you end the read process. If reviewing unrecognized images after form processing, once all forms 

have been identified, the Unrecognized Image Utility closes automatically.  

Automatic Page Identification 

The Auto Page ID feature allows you to process form pages out of normal page order. The Data Center 

searches for the page identifier region on each page first, and places the data in the proper order. Auto 

Page ID can be used alone or in conjunction with Auto Form ID and/or Respondent Tracker. When used 

alone, you must process only those forms associated with one specific form template and be certain that 

all pages belonging to each respondent are grouped together for processing. Without the use of 

Respondent Tracker, if pages from differing respondents are mixed together, you are prompted and form 

processing stops. You need to re-sort your forms so that each respondent's pages are processed together; 

an individual respondent's pages can be out of order within the same form, but a single respondent's 

pages cannot be interspersed with another respondent's pages. Auto Page ID regions can be OMR, OCR 

or Barcode regions. 

  

To use Auto Page ID 

1. Outside of Remark Office OMR, create a form that contains a unique identifier on each page that 

can be captured as an OMR, OCR or Barcode region in the Remark Office OMR template. 
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Remember that if you are also using Auto Form ID, you need a second unique identifier to be 

used as the Page ID. Each Page ID must be unique from page to page. 

• Tip: The Page ID region could be a series of bubbles that represent page numbers, such as 1-

4. Or it could be an OCR area or barcode that identifies a specific page. 

2. In the Remark Office OMR Template Editor, 

create a form template for each form you 

wish to process using automatic page 

detection. When creating the form template, 

set the region to be used as the Page ID 

region in the Tracking section of the region's 

properties. Mark the checkbox for Use 

Region Tracking. Then select the radio 

button marked Page tracking. Click here for 

further details on setting up the page ID in 

the template. 

3. When you are ready to start processing 

forms, open the form template(s) you wish to 

use with Auto Page ID in the Data Center. 

4. Read forms from either scanner or image file 

by selecting the Tools menu and then clicking Read. If you need information about how to use 

the Read window, click here if reading from a scanner or click here if importing image files. 

5. [OPTIONAL] If you are using the Auto Form ID 

feature, remember to go to Advanced Data 

Collection Options, click the Advanced 

Options button and then mark the checkbox 

for Automatically associate data with the 

corresponding form template (Auto Form ID 

Mode).  

6. On the final step, you can determine whether 

to stop the process if a form is not recognized 

by marking the Review unrecognized images 

during the read process. If this checkbox is 

not marked, any unrecognized images are 

stored in the Unrecognized Image Queue for 

later review (see below).  

7. Make your selections and then click the Read 

button. 

8. After recognizing the page, the Data Center places the data into the appropriate template grid 

section. Any images that the Data Center cannot recognize enter a queue of unrecognized 

images. You can review these images during or after form processing. 

After recognizing the form type, the Data Center places the data into the appropriate data grid window. 

Any images that the Data Center cannot recognize enter a queue of unrecognized images. You can review 

these images during or after form processing.  
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Unrecognized Page Images 

If a page is not recognized, you use the Unrecognized Images window to rectify the problem. You may be 

able to match the form (in the case of the ID region just not being recognizable) or you can discard the 

image if it truly doesn't match any open form templates. You can use the Unrecognized Images utility 

during form processing or wait to review all unrecognized images after the reading process finishes, as 

mentioned in Step 5 above. Regardless of how you display the utility, using it is the same process. 

  

1. [Optional] If you are using the Auto Form ID feature, when the Unrecognized Image Utility 

appears, the Form Templates list may be empty if the form was not recognized. If necessary, click 

the drop-down list to choose the correct form template for this image. Use the Image Viewer in 

the right portion of the screen to assist with understanding which form has been processed. 

2. Once the correct form is identified (or if you are not using Auto Form ID), you may select the page 

being processed. 

• Click the Pages drop-down list and then 

select the correct page for the form being 

processed. Use the Image Viewer in the 

right portion of the screen to assist with 

understanding which form page has been 

processed. 

• To remove the form image, click the 

Discard button, which removes it from the 

queue. This might be appropriate if the 

wrong form was scanned (or the wrong 

image was processed). Note that if you do 

this during processing the image is 

completely deleted. If you are using the 

queue after processing, the image no 

longer appears in the queue but is not 

deleted.  

• Note: You also have a Skip button to move to the next unrecognized image (if reviewing post-

processing) and an Abort (stops the read process if reviewing during form processing) or Cancel 

(stops the image review process if reviewing post-processing) button to end the process. 

3. Once you have matched a page to its form template page, click the Read button to continue. 

4. If using the Unrecognized Image Utility during form processing, forms continue reading until you 

end the read process. If reviewing unrecognized images after form processing, once all images 

have been identified, the Unrecognized Image Utility closes automatically. 
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Automatic Respondent Tracking 

The Respondent Tracker feature allows you to scan respondents' form pages in any order. Remark Office 

OMR uses the respondent identifier region of the form template to determine the appropriate record for 

each respondent. This feature is only useful for multi-page forms. Therefore, you need to also use the 

Auto Page ID feature along with Respondent Tracker. Remark Office OMR first identifies the page being 

processed, and then the respondent. Optionally, you may use Auto Form ID as well. Using all three 

features allows you to process various forms, form pages and individual respondent pages in any order 

and still have Remark Office OMR record the data properly. Respondent Tracker ID regions can be OMR, 

OCR or Barcode regions. 

• Note: If you are only processing one multi-page form, use of Auto Form ID is not necessary. If 

you would like to process more than one form type at once and use the Respondent Tracker 

feature, you need to also use Auto Form ID. 

  

To use Respondent Tracker 

1. Outside of Remark Office OMR, create a form that contains a unique identifier on each page that 

can be captured as an OMR, OCR or Barcode region in the Remark Office OMR form template. 

Remember that if you are using Auto Form ID and Auto Page ID, you need a third unique 

identifier to be used as the Respondent Tracker. 

• Tip: The Respondent Tracker region can be a bubble region where the respondent marks 

identifying information, such as name, ID number, etc. It can also be a Barcode or OCR region 

that contains similar information and is 

pre-printed. The information must 

appear on every page of the form. 

2. Create a form template in the Remark Office 

OMR Template Editor for each form you wish 

to process using the Respondent Tracker 

feature. When creating the form template, 

set the region to be used as the Respondent 

Tracker region in the Tracking section of the 

region's properties. Mark the checkbox for 

Use Region Tracking. Then select the radio 

button marked Respondent tracking. Click 

here for further details on setting up the 

Respondent Tracker in the template.  
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3. When you are ready to start processing forms, open the form template(s) you wish to use with 

Respondent Tracker mode in the Data Center. 

4. Read forms from either scanner or image file by 

selecting the Tools menu and then clicking 

Read. If you need information about how to use 

the Read window, click here if reading from a 

scanner or click here if importing image files. 

Make your selections and then click the Read 

button. 

5. On the final step, you can determine whether to 

stop the process if an image is not recognized 

by marking the Review unrecognized images 

during the read process. If this checkbox is not 

marked, any unrecognized images are stored in 

the Unrecognized Image Queue for later 

review (see below).  

6. Make your selections and then click the Read 

button. 

After recognizing the page and respondent, Remark Office OMR places the data into the appropriate data 

grid section. Each unique respondent tracker produces a new row of data in the data grid. There may be 

times when you are presented with overwrite options if a respondent tracker data value is already present 

in the data grid. The message tells you that the region's value has already been read. You may Overwrite 

what has been read, Ignore it (skip the page) or choose End Read to stop the read process (e.g. in the case 

where you think incorrect forms might be being processed).  

Unrecognized Respondent Tracker Images 

If the Data Center cannot automatically read a Respondent Tracker region the image is added to the 

Unrecognized Images queue. If you have chosen to review unrecognized images during form processing, 

the Unrecognized Image window appears for each unrecognized Respondent Tracker region. If you have 

chosen not to review unrecognized images during form processing, the images are stored in a queue so 

that you can review them all at once. 

• Note: If you are using the Review Exceptions feature to correct exception cases (either during 

form processing or before reviewing unrecognized images), it is possible to provide a valid 

respondent tracker value before the image is added to the Unrecognized Images queue. 

Depending on the types of exceptions you are reviewing, Review Exceptions may show you 

exceptions in your Respondent Tracker regions (e.g. BLANK, MULT, etc.). Once corrected, the 

software matches data records based on the Respondent Tracker region. Exceptions that have not 

been corrected in Review Exceptions cause the image to be added to the Unrecognized Images 

queue. 

1. [OPTIONAL] If you are using the Auto Form ID feature, when the Unrecognized Image Utility 

appears, the Form Templates list may be empty if the form was not recognized. If necessary, click 

the drop-down list to choose the correct form template for this image. Use the image viewer in 

the right portion of the screen to assist with understanding which form has been processed. 
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2. [OPTIONAL] Once the correct form is identified (or if you are not using Auto Form ID), you may 

select the page being processed, if it is not recognized. Click the Pages drop-down list and then 

select the correct page for the form being processed. Use the image viewer in the right portion of 

the screen to assist with understanding which page has been processed.  

• Note: If the page is automatically recognized, you do not see this step. 

3. Once the correct page is identified, you may determine what to do with the unrecognized 

respondent. The Respondent Tracker box shows an exception color indicating why the software 

could not recognize the region (e.g. BLANK, MULT, etc.). Use the image viewer in the right portion 

of the screen to assist with understanding which form has been processed. Then decide whether 

the form matches an open template or if you want to discard it all together. 

• To keep the page image, enter the 

correct response for this image in the 

Respondent Tracker box. Once the 

response is entered, the software 

either matches the record to an 

existing data record or begins a new 

record if the Respondent Tracker is 

unique to the existing data.  

• To remove the page image, click the 

Discard button, which removes it 

from the queue. This might be 

appropriate if the wrong form was 

scanned (or the wrong image was 

processed). Note that if you do this 

during processing the image is 

completely deleted. If you are using 

the queue after processing, the image 

no longer appears in the queue but is not deleted.  

• Note: You also have a Skip button to move to the next unrecognized image (if reviewing 

post-processing) and an Abort (stops the read process if reviewing during form 

processing) or Cancel (stops the image review process if reviewing post-processing) 

button to end the process. 

4. Once you have entered the correct respondent identifier or discarded it, click the Read button to 

continue processing. 

5. If using the Unrecognized Image Utility during form processing, forms continue to be read until 

you end the read process. If reviewing unrecognized images after form processing, once all forms 

and pages have been identified, the Unrecognized Image Utility closes automatically. 
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 Reviewing Exceptions Overview 

As forms are processed, exception cases can occur. You should edit cells containing exception cases to 

validate your data before performing any analysis operations or exporting the data to another application. 

Each exception case is assigned a specific color so that you can easily distinguish different types of 

exceptions. The following table summarizes the types of exception cases and their possible causes. 

  

Error Type Text Color Possible Causes 

Multiple Responses 

(Too Many Responses) 

All multiple 

responses or 

MULT (depending 

on your template 

settings) 

Green More than one answer selected when multiple 

responses are not permitted. 

Partially erased forms. 

Carelessly marked forms. 

Blank Responses 

(No Response) 

BLANK Yellow Unanswered questions. 

Response not completely filled. 

Recognition Errors 

(Form Error 

ERROR… 

(various code 

numbers may 

appear) 

Red Forms that have been enlarged, reduced, offset or 

skewed by more than 3/8 inch; could result from 

photocopying or reprinting. 

Improperly or carelessly placed forms in the 

automatic document feeder of the scanner, where 

they are pulled in crookedly and skewed images 

result. Could also be a result of a mechanical issue 

with the scanner, in which case you should have 

your scanner cleaned and serviced. 

Forms that have text or lines placed too close to 

markable areas, causing the text or lines to be 

interfere with the marks (bubbles, checkboxes). 

Images scanned with brightness setting too high or 

low. 

Carelessly marked forms. 

Forms processed with wrong form template file. 

Forms that do not follow the recommended design 

guidelines. 

Image Regions None Light Blue Signifies a data entry image region where 

handwriting was found. You need to type the 

information found in the region, or apply a code if 

using qualitative coding. 
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Error Type Text Color Possible Causes 

Database Lookup Errors Selected 

Responses 

Purple Response not found within the selected database to 

which the region is linked. 

Barcode Errors ??? Dark Orange Used a barcode type that Remark Office OMR 

cannot recognize. 

Used the Code 3 of 9 barcode type without using 

beginning and ending asterisks (*). 

Barcode does not fit within region definition area. 

Barcode is printed too small on the form. 

Extraneous marks are located within the Barcode 

region. 

Scanning resolution is too low (300 DPI 

recommended). 

OCR Region 

(Optical Character 

Recognition) 

Miscellaneous 

characters 

Dark Blue The font used for the text does not create readable 

text (e.g. a handwriting style font). 

Text is too small to be read. 

Region border created in the form template does 

not properly encapsulate the text. 

OCR region threshold setting in the form template 

or program preferences is too high or too low. 

Printed text on form is in an unsupported language. 

Trying to recognize handwriting (ICR) instead of 

machine printed text. 

Scanning resolution is too low (300 DPI 

recommended). 

Repeated Rank 

Responses 

DUP Pale Orange A duplicate rank was given to a Ranking style 

question. For Ranking questions, each response can 

only have one rank assigned, and each rank can 

only be used once. 
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Error Type Text Color Possible Causes 

Required item None Exception 

Color 

Signifies that a required region was not properly 

answered. Typically, this means that another 

exception occurred, such as a Blank, Mult or Error. 

The data grid cell takes on the color of this 

exception (e.g. yellow for a blank response), but 

there is no text, indicating that the question was 

required. Flagging required questions is particularly 

useful when you use the Review Exceptions function 

during form processing (meaning the processing 

stops so that you can review the problem). Note 

that you should use caution when making questions 

required and using the "Flag Blanks" setting. If Flag 

Blanks is set to Never, anything left blank does not 

display as a required item exception. 

Multiple exceptions None Gray Signifies that multiple exceptions were found in the 

region. For example, an OCR region that is also 

being used as a Database Lookup region might not 

be recognized properly. In this case, it is both an 

OCR recognition exception and a Database Lookup 

exception. The gray color lets you know that more 

than one issue was found. 

  

Remark Office OMR offers image-assisted exception reviewing using the Image Viewer, which eliminates 

searching through paper forms to make corrections to the data. You can resolve exception cases in one of 

two ways: editing individual cells or using the Review Exceptions feature during or after form processing. 

Review Exceptions can be accessed on the last step of the Read window when processing forms or after 

forms are processed from the task pane, Tools menu, REVIEW button or toolbar. 

• Note: The exception colors in the grid are only retained if you save data to the Remark or Remark 

Office Archive data formats. Once you export your data to another format, if you reopen that 

format, the grid colors are not present. 

Using Review Exceptions 

Remark Office OMR provides the Review Exceptions feature as a method to validate data. You may use 

the Review Exceptions feature to review the following exception cases: blank responses, multiple 

responses, form errors, barcode errors, database lookup errors, required items, OCR regions, repeated 

rank responses, multiple exceptions or data entry Image regions. 

The Review Exceptions feature can be used in one of two ways: 
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After Form Processing: Review Exceptions can be used after the forms have been processed; therefore, 

you are not required to have the software stop processing forms when exceptions are encountered. When 

reviewing after processing, the software cycles through the data file to find exception cases and then 

allows you to make the appropriate changes. To use Review Exceptions after form processing, select the 

REVIEW button in the data header bar across the top of the data grid. You may also select Review 

Exceptions from the task pane, toolbar or Tools menu.  

• Tip: When using Review Exceptions after form processing, you can review the entire data set or 

sections of the data set. To review sections of the data set, select the column or row header(s) of 

the area you wish to review, or highlight a group of cells. For example, if you only want to review 

a specific comment region (Image region) so that you can hand enter data, select the column 

header of the comment region so that the entire column is highlighted. Then click Review 

Exceptions; only the selected column is reviewed. 

During Form Processing: If used during the reading process, whether scanning forms or processing 

saved image files, Review Exceptions provides an option to have the Data Center pause after encountering 

selected exception types. You can then select or enter the correct response. To use Review Exceptions 

during form processing, turn it on in the Read window and choose the exceptions you want to correct. 

Regardless of how you use Review Exceptions, the software shows you the question/region containing the 

exception case in the Image Viewer at the bottom of your screen. You may use the image to guide you in 

making the appropriate updates in the data header bar. The following table details the available Review 

Exceptions options: 

  

Review Option Function 

Blank Responses Review when a respondent fails to answer a question. 

Multiple Responses Review when a respondent chooses more responses than were permitted. 

Image Regions Review when a flagged Image region is encountered. Allows the hand entry or speech 

recognition of information into the data grid, or the ability to choose a qualitative 

response code. 

Region Errors Review when a recognition error occurs and Remark Office OMR cannot properly 

recognize the region (e.g. image is skewed, form is poorly marked, spacing is too tight on 

the form). 

Database Lookup 

Errors 

Review when a database lookup error is encountered, meaning that the response is not 

located in the database that was specified during the form template creation process. 

Once you correct the Database Lookup exception, if you are returning other fields from 

the database, they are updated automatically. 

Barcode Errors Review when Remark Office OMR cannot read the barcode properly. 

OCR Errors Review when the text in an OCR region cannot be properly recognized. 
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Review Option Function 

Repeated Rank 

Responses 

Review when a respondent chooses the same rank for different questions in the same 

region. 

Required Items Review when a required item has not been answered. 

Multiple exceptions Review when multiple exceptions occur. For example, an OCR region utilizing Database 

Lookup could be unrecognized, which would generate both an OCR exception and a 

Database Lookup exception. 

  

To use Review Exceptions 

1. Choose whether to review during or after processing, as outlined above.  

2. Once you access Review Exceptions, use the task pane to select the exception cases you would 

like to review: Blank responses, Multiple Responses, Recognition Errors, Image Regions, Database 

Lookup Regions, Barcode Regions, OCR Regions, Repeated Rank Responses or Required Items. 

You can also choose whether to search by rows or columns in the data grid. 

3. Click the NEXT button to start the review process. 

• Note: You can optionally use speech recognition to assist you with reviewing exceptions. 

4. The Data Center searches the data for the specified exception cases. When a selected exception 

case is found, it appears in the data 

header bar at the top of the data grid. 

The bar is color coded to match the 

exception type (e.g. yellow for a BLANK 

response). Use this window to make 

changes. You can use the drop-down list 

if applicable, or type a response. Note if 

there is a list of answer choices defined, 

as you begin typing, Remark Office OMR 

will attempt to auto-fill your answer 

based on your possible answer choices. 

5. Once you have selected the appropriate 

response, press Enter on the keyboard or click the NEXT button. If you want to move to the next 

row of data instead, click the down arrow on the NEXT button and choose Go To Next Record. If 

you need to revisit the previous exception, click the PREVIOUS button. To go to the previous data 

record, click the down arrow on the PREVIOUS button and choose Go To Previous Record. 

6. Continue reviewing exceptions in this manner. 

7. Once you have finished reviewing, or if you click END REVIEW, if you made changes to the data, 

you are prompted to save the changes (note that if you did not make any changes, you are simply 

prompted to end the review process). Click the Save Changes button to save your changes. Click 

the Discard Changes button to undo all changes made during the Review Exceptions session. 

Click the Cancel button to return to Review Exceptions. 
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Additional Things to Know About Review Exceptions: 

There may be times when you are reviewing exceptions and the exceptions are legitimate, e.g. a question 

is left blank. By default, if you leave the exception as is, it always retains the color coding and exception 

text. If you prefer to remove the color coding once an item has been reviewed, go to Tools|Preferences 

and mark the checkbox for Clear exceptions after they have been reviewed in the section called 

Review Exceptions. After a cell is reviewed using Review Exceptions, the color disappears even if you did 

not make a change to the cell. If Review Exceptions is run again, the cell is not flagged as an exception. 

Note that Review Detections will prompt you to skip review if it finds that all questions are blank after a 

certain point in your data set (e.g. you are using 25 questions on a 50 question test, and questions 26-50 

are all blank). 

If you review data and then either start a new read process or open a data file, when you run Review 

Exceptions again, the software prompts you to read all the exceptions or begin from the last review 

session. This feature can be a nice time saver if you have already reviewed the data, in which case you can 

choose Yes when the message appears to read from where you last read data. 

In order to retain the link between the data and the corresponding image in the image viewer, you must 

save the data to the Remark (RMK/RMX) or Remark Office Archive (ROA/ROX) formats. If you plan on 

continuing your data review at a later point, save the data to one of these formats so that when you 

resume Review Exceptions, you'll still have the form images in the image viewer. 

If you need to review Data Entry Image regions, you can use the speech recognition portion of Review 

Exceptions by clicking the microphone. 

Speech Recognition 

Remark Office OMR includes the ability to use speech recognition when running Review Exceptions. This 

feature is particularly helpful if you have Image regions on your form that have long comments. Instead of 

clipping or typing the comments, you can use the Image Viewer on-screen and read the comments into 

the data grid. You can also use speech recognition to review other data types during Review Exceptions 

(e.g. actual answer choices from an OMR region). Ensure that you understand how to use Review 

Exceptions before attempting speech recognition. 

Speech recognition relies on the Microsoft Windows built-in speech technology. Gravic has no control 

over the effectiveness of speech recognition. We strongly suggest you train your computer to recognize 

your voice using the Microsoft speech training options in the Windows Control Panel. If you encounter 

difficulties with speech recognition, ensure you have a good quality microphone and that you have 

conducted the speech recognition training. For speech recognition troubleshooting, consult the Microsoft 

website. 

You may use the following commands when using speech recognition in Review Exceptions: 

  

Next: Moves to the next exception 

Previous: Moves to the previous exception 

Finish: Ends the review process 
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To use speech recognition 

1. In the Remark Office OMR Data Center, process forms or open a data file. 

2. To begin speech recognition, first ensure you 

have a microphone attached to the 

computer and configured in the Windows 

Control panel. Then click the REVIEW button 

in the data header bar. 

3. Click the microphone next to the red END 

REVIEW button.  

• Note: If you want to enter comments 

into a specific Image region, highlight 

the column representing the Image 

region before starting speech.  

4. If necessary, choose the exception types to review in the left task pane. 

5. When you are ready to start speech recognition click or say the word NEXT. Remark Office OMR 

locates the first exception based on the types of exceptions you are reviewing and any portions of 

the grid you have selected (if applicable). 

• If reviewing a multiple choice style question, speak the correct answer choice. You must say a 

valid answer choice for the question, as defined in the Labels in the template, for Remark 

Office OMR to record your response. 

• If reviewing an image region, use the Image Viewer to read what you see on the screen. 

• Note: If something is not interpreted correctly, you can place your cursor in the data 

header bar and re-read information. 

6. Click or say NEXT to continue. 

7. Continue in the same manner until you wish to end Review Exceptions. If you need to end 

reviewing early, click END REVIEW or say Finish. 

8. If you made changes to the data, you are prompted to save the changes. Click the Save Changes 

button to save your changes. Click the Discard Changes button to undo all changes made during 

the Review Exceptions session. Click the Cancel button to return to Review Exceptions.  

Saving Data 

You can save the data in the data grid to dozens of different file formats. The Remark file format was 

specifically designed to optimize the data storage process in the Remark Office OMR software. Saving 

data is also sometimes referred to as exporting data. 

• Tip: When working with data in Remark Office OMR, use the Remark file format (RMK or RMX). 

This is the only format that preserves the link between the data and the corresponding images, as 

well as exception colors. Export data to other formats after you have collected and cleaned all of 

your data. 
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When saving data, you have the option of using Save Data or Save Data As. The Save Data option can be 

used to save a data set for the first time or to overwrite the current data set. The Save Data As option 

allows you to save the current data set with new parameters (e.g. new file name, different directory, 

different file type, etc.).  

• Tip: If you open a data set and add new records to it, make sure you overwrite the data file if 

using Save Data As (you are prompted to overwrite or append). Do not append in this case, or the 

old data will be repeated in the data file. Ideally once your new records are added to the old data, 

simply click File|Save or the Save toolbar button, which overwrites the data file with exactly what 

you see on the screen. 

The following table lists the different save file formats, their extensions and a brief description: 

  

File Format Extension Description 

Remark Extended RMX Remark Office OMR extended format; saves grid exception colors 

and image links; includes information about changed responses for 

associated reports in Remark Quick Stats 

Remark RMK Remark Office OMR format; saves grid exception colors and image 

links 

Remark Extended Office 

Archive  

ROX Remark Office OMR Archive extended format; combines template, 

data and stored image files into one file; saves grid exception colors 

and image links; existing files may only be overwritten (there are no 

append options); optionally includes support information for 

troubleshooting; includes information about changed responses for 

associated reports in Remark Quick Stats 

Remark Office Archive  ROA Remark Office OMR Archive format; combines template, data and 

stored image files into one file; saves grid exception colors and 

image links; existing files may only be overwritten (there are no 

append options); optionally includes support information for 

troubleshooting 

SQL Server MDF Microsoft SQL Server format 

Oracle 7.4 and later *.* Oracle format 

Access 2007-2016 ACCDB Microsoft Access 2007 - 2013 format (only available if the 32-bit 

Access 2007, 2010 or 2013 database engine is installed) 

Access 2000-2003 MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format 

Access 2.0 MDB Microsoft Access 2.0 format 
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File Format Extension Description 

Access 1.0 MDB Microsoft Access 1.0 format 

Excel 2007-2016 XLSX Microsoft Excel 2007 through 2016 formats  

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Opinionmeter ASC ASCII format for Opinionmeter application 

Questionmark QSF Perception Questionmark format (save only) 

SPSS SAV SPSS 16 format 

SPSS Legacy SAV SPSS 6 format 

Survey Pro SRV Survey Pro standard format (Apian Software) 

Survey Pro STL STL Survey Pro STL format (Apian Software) 

CSV CSV Comma separated values format 

Text TXT Tab delimited text format 

ExamSoft CSV Specialized CSV format for importing into ExamSoft testing software 

StatPac DAT StatPac format for StatPac Survey Software 

Survey System DAT The Survey System format (Creative Research Systems) 

dBase V DBF dBase V format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 7-8 DB Paradox 7-8 format; requires the Borland Database Engine (BDE) to 

be installed 

Paradox 5.X DB Paradox 5.X format; existing files may only be overwritten (there are 

no append options) 

Paradox 4.X DB Paradox 4.X format; existing files may only be overwritten (there are 

no append options) 
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File Format Extension Description 

Paradox 3.X DB Paradox 3.X format; existing files may only be overwritten (there are 

no append options) 

Lotus WK3 WK3 Lotus Works 3 format 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus WJ3 WJ3 Lotus 1-2-3 version 3 format 

Lotus WJ2 WJ2 Lotus 1-2-3 version 2 format  

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated to specified record 

length 

Data Interchange Format DIF Standard format using file header and data section 

CCI Assessment DAT CCI Assessment format; existing files may only be overwritten (there 

are no append options) 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language 

ODBC *.* Open Database Connectivity 

Custom  ASC, TXT Custom Text format 

Database Update  XLS, XLSX, 

MDB, ACCDB 

Updates an existing database with new data (e.g. adds missing 

information, overwrites existing information). 

ODBC Database Update  *.* Updates an existing ODBC database with new data (e.g. adds missing 

information, overwrites existing information). 
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To save data 

Before saving data to another data format, we suggest saving a copy of the data to the Remark (RMK or 

RMX) format to preserve exception colors and links to stored images. Once your project is complete, you 

may delete or archive the Remark file, or save all of your files to the Remark Office Archive (ROA) format. 

• Note: When exporting to a specific format (e.g. Access, Excel, etc.) make certain your data 

meets the format's specific requirements. 

1. After processing forms, select the File menu 

and then click Save Data if saving the data 

set for the first time or to overwrite the data. 

Click Save Data As to save the data with 

new parameters. 

• Note: Clicking the toolbar button for 

Save Data overwrites the current data 

set. 

2. If saving for the first time or using Save Data 

As, the Save Data window opens, allowing 

you to choose a file name, a file type, the 

folder in which you would like the file saved 

and Advanced saving options. 

3. Select the desired folder location using the 

Look in drop down box. 

4. Enter a name in the box titled File name. 

5. Select the desired output format in the box titled Save as type. 

6. If saving to a database type that supports internal table names, enter a table name in the box 

titled Table name. 

• Note: Each database format has different table name limitations. Refer to your database 

documentation for information on table name limitations. When saving to a database where 

one or more fields are too small to hold the data being saved, Remark Office OMR attempts 

to resize the database column so that it can hold the data being saved. 

7. When exporting, you can save the column headers for certain formats by selecting the Save 

headers checkbox. The Save headers checkbox only displays when appropriate. 

8. Click the OK button to save the file. The data is saved to the format and location of your choice.  

• Tip: If you use Google Drive or Dropbox, once you select the format and give the file a name, 

you can click the Google Drive or Dropbox icons in the Save window to place the file right in 

your Google Drive or Dropbox folder. If your computer is set up to automatically poll this 

folder for files, Google Drive or Dropbox will "see" the file and upload it to the cloud 

automatically. You must have Google Drive or Dropbox installed on your computer for this 

save to work. 

• Note: The Remark products are not affiliated with or otherwise sponsored by Dropbox, Inc.  
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Advanced Data Saving Options 

When saving data to certain formats, you have the option of setting advanced parameters. The Advanced 

Save window shows you each question and pertinent information about the question (region). You can 

then choose options about the region that you want included in your database. This feature can be useful 

if you are saving to a database format that has specific requirements. You can temporarily override the 

form template settings by using the advanced parameters. The Advanced Save window also allows you to 

save either the scanned form image or path to the scanned form images to your data file. 

• Note: Setting parameters in the Advanced Save window does not make any changes to the form 

template. 

  

To use advanced saving options 

1. Select the File menu and then click Save Data As. The Save Data window opens, allowing you to 

choose a file name, a file type, the folder in which you would like the file saved and advanced 

saving options. 

2. Select the desired folder location using the Look in drop down box. 

3. Enter a name in the box titled File name. 

4. Select the desired output format in the box titled Save as type. 

5. If saving to a database type that supports internal table or sheet names, enter a table name in the 

box titled Table/Sheet name. 

6. Click the Advanced button. 

7. [OPTIONAL] If you have previously saved a definition file for this data set, click the Load... button 

to locate the appropriate INI file containing your settings. Otherwise, continue to Step 8 to build a 

new data file. 

8. Make any desired changes in the Include, Name, Data Type or Size columns, as described here: 

 

Option Description 

Include Mark this checkbox to include the region (question) in the data file. Note that you may include 

the paths to the stored images of each processed form. The last item(s) in the Name list is the 

form image(s) listed by page (e.g. Page 1 Image). 

Name Use this column to enter a new field name to be used in the exported data file, if desired. 

Changing the field name in this window does not affect the region's name in the form 

template. 

Data Type Use this column to change the data type for this question. 

Size Use this column to specify a field size for the data for this question. Do not specify a size that 

is smaller than what is in your data. 



 

120 

 

 

• Note: You can save the path of the form images or the actual form images to the file 

by using the Advanced options. 

Scroll to the bottom of the Names 

list to mark the form images. If you 

want the actual image to be stored, 

change the data type to binary. If the 

data type is not binary, the path to 

the images is stored. 

9. [Optional] If desired, click the Save button to 

save the settings to a configuration file (.ini file). 

You can then open this configuration file for 

future save operations with this same form 

template. This feature can save time when saving 

future data sets. 

10. Click the OK button to save the changes. 

11. In the Save Data window, click the OK button to save the data.   

Save All Data 

The Save All Data feature allows you to save multiple open data sets to one combined file (as long as the 

data sets correspond with the same Remark template). This feature is useful if you need to store and 

analyze data both on an aggregate and individual level. By maintaining separate files you can easily report 

on an individual data set. However, by combining the individual data files into one, you can also report on 

the data as a whole without having to open each data set individually any time you want to analyze all the 

data. 

  

To use Save All Data 

1. After reading forms or opening multiple data sets, select the File menu and then click Save All 

Data. The Data Sets window opens, allowing you to choose the open files you wish to include in 

the save operation. 

2. Mark the checkboxes of all data sets you wish to include in the save operation. You may use 

Select All to select all data sets in the 

list. Please note that the data set must 

correspond to the active form 

template in order for it to be included 

in the save operation. 

3. If needed, drag the row header area to 

move data sets into a different order. 

The order in which the files appear on 

the Data Sets window is the order in 

which they are saved. 
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4. If any of the open data sets had changes made to them prior to the save operation and were not 

saved, you receive a warning. The warning lets you know that during the save operation, all of the 

data sets being combined are closed. Click Yes to continue or No to cancel the operation, 

allowing you to go back and save the individual files first.  

• Note: If you made changes to your original data files and want those changes to be saved, 

save the individual files before using Save All Data. If you choose to ignore the warning, the 

changes to the individual data sets are 

not saved.  

5. Click the OK button. 

6. Select the desired folder location using the 

Look in drop down box. 

7. Enter a name in the box titled File name. 

8. Select the desired file format in the box 

titled Save as type. 

9. If saving to a database type that supports 

internal table or sheet names, enter a table 

name in the box titled Table/Sheet name. 

10. Click the OK button to save the file. All 

selected data sets are saved to the file 

specified and closed in the data grid. The combined data set is opened.  

Saving Data - Organize & Save 

The Organize & Save feature allows you to fine tune the data saving process by building dynamic file, 

folder and table names. Using the Organize & Save options, you can use information directly from your 

data set to name the data file, storage folder or table within the file. This functionality is similar to the 

Name Builder, accessed when reading forms, that is used to name scanned and archived image files. 

  

To use Organize & Save  

1. Select the File menu and then click Organize & Save. The Organize & Save window opens, 

allowing you to choose a file name, a file type, the folder in which you would like the file saved 

and table name saving options. The first step is to choose a file type and location for the data. 

2. Under Save File, click the ... (ellipsis) button to select a file name and format for your data. 

3. Select the desired folder location using the Look in drop down box. 

4. Enter a file name in the File name box.  

5. Choose the file format in the Save as type box. 

6. If choosing a database format, also enter a Table/Sheet Name. 

7. Click the OK button. 
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8. In the Build Saved Data File area, go to the File base name area of the window. The name you 

set in the previous screen is listed as the file name. You may modify it by typing in the box. You 

may also use the drop-down list to add a region from the processed data to the file base name. 

Choose the region from the drop-down list and then click the Insert Data Into File Name button. 

For example, if processing student test 

forms, you could add a student name region 

that is being collected from the form so that 

your data file name includes the name of 

each student (each time the student name 

changes, a new data file is created). 

Remember to place your cursor in the 

appropriate spot for where you want the 

region information to be inserted.  

9. In the Destination folder area, you may 

choose to add a region from the processed 

data to the folder structure that holds the 

data file. Choose the region from the drop-

down list and then click the Append Data 

Onto Folder Path button. Continuing with 

our example, if processing student test forms, you could add a teacher name or ID region that is 

being collected from the form so that your folder names include teacher identifiers. Each 

student's data from the data set would be stored in a separate folder based on teacher name or 

ID number. 

10. If using a database format that requires a table name, go to the Table Name area of the window. 

The name you chose for Table Name when initially setting up the file in Step 6 is listed as the 

Table Name. You may modify it by typing in the box. You may also use the drop-down list to add 

a region from the processed data to the file base name. Choose the region from the drop-down 

list and then click the Insert Data Into Table Name button. Continuing with our example, if 

processing student test forms, you could add a teacher name region that is being collected from 

the form so that your data file table name includes the name of the teacher administering the 

test. Remember to place your cursor in the appropriate spot for where you want the region 

information to be inserted. 

11. If desired, mark the checkbox for Overwrite existing files or tables, in which case anything that 

exists in the same location, with the same name and format, is overwritten.  

12. Click the Save button to save the data. The data file(s) is saved based on your specifications. If 

you named files or folders based on data from your data set, you may see separate folders and 

files. For folders, there is a separate folder for each unique entry in your data set. Within each 

folder you find the appropriate data file. For data files, the data file names begin with the region 

data you chose during the set up process. 
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Remark Office Archive Format 

The Remark Office Archive format saves the form template, data file and stored images in one zipped file. 

By having all items stored together, the information becomes portable. For example, this feature is useful 

if you own and use multiple copies of the software. One person can scan forms on one system and then 

save the data to the Remark Office Archive Format. Another person can then open that Remark Office 

Archive file, which provides the form template, data file and stored images, and run Review Exceptions to 

clean the data. This process makes sharing the workload easier. There is also a Remark Extended Office 

Archive format, which stores information about changed responses. When using this format, Remark 

Quick Stats can display reports related to how many times responses were changed, which can be useful 

when grading tests. 

• Caution! Please read the Remark license agreement carefully before installing Remark Office 

OMR on multiple computers. Licensing is computer-based, meaning that one copy of the 

software may only be installed on one computer. 

  

To save data to the Remark Office Archive format 

1. Select the File menu and then click Save Data As. The Save Data window opens, allowing you to 

choose a file name, a file type and the directory in which you would like the file saved. 

2. Select the desired directory location using the Look in drop down box. 

3. Enter a name in the box titled File name. 

4. Select the Remark Office Archive (*.ROA) or 

Remark Extended Office Archive (*.ROX) 

format in the box titled Save as type. 

• Note: If you want to store information 

about changed responses, choose the 

Remark Extended Office Archive (*.ROX) 

format. Remark Quick Stats can then 

display reports related to how many times 

responses were changed. 

5. [OPTIONAL] If desired, mark the checkbox for 

Delete original images after archiving to 

delete the original images that are stored 

during form scanning. These images are 

included in the archive format in case you need to access them at a later point. 

6. [OPTIONAL] If Remark Support has requested an ROA file for troubleshooting, mark the Include 

support files checkbox. This action includes additional information for support personnel to 

correctly troubleshoot your issue. 

7. Click the OK button to save the file. 
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To open a saved Remark Office Archive file 

1. In the Remark Office OMR Data Center, select the File menu and then select Open Form 

Template. 

2. Set the Files of type to Supported Files or Remark Office Archive Files or Remark Extended 

Office Archive. 

3. Highlight the ROA/ROX file you wish to open and 

then click the OK button. 

4. A Select the archive extract location... window 

appears. Use this window to select a location in 

which to unzip the files associated with this data file 

(form template, data and stored images). We suggest 

putting them in a folder based on the form template 

name so that you can easily associate the files with 

the right form. 

5. Click the OK button once you have selected a folder. 

The files are automatically be unzipped to the 

location specified. The form template and data load 

normally into the data grid. All associated image files 

are available so that you can click in a cell and view 

the corresponding image or use Review Exceptions 

to clean the data.  

Custom Format for Saving Data 

The Custom format allows you to create a customized text file. This format is useful for exporting data 

into a database or other program that has very specific requirements. The format can also be used to 

break apart rows of data into multiple records. For example, if you are processing an attendance sheet 

containing records for multiple students in a single row, you can use the Custom format to separate the 

data into one record for each student. 

 

To use the Custom format 

1. Select the File menu and then click Save Data As. The Save Data window opens, allowing you to 

choose a file name, a file type, the folder in which you would like the file saved and advanced 

saving options. 

2. Select the desired folder location using the Look in drop down box. 

3. Enter a name in the box titled File name. 

4. Select the Custom (*.ASC, *.TXT) format in the box titled Save as type. 

5. Click the OK button. 

6. If you have used the Custom format previously and have a saved configuration file that applies to 

this data set, click the ellipsis (...) button to locate the configuration file. Otherwise, continue to 

the next step 
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7. Select the options you wish to use to customize your data set. Each option is described here: 

  

Option Description 

Start export at row Enter the row number that you want to use as the first record in the exported data 

file. All rows from this point forward are included in the data file. Enter 0 to include 

region (field) names as the first record. 

File Type Delimited: Fields are separated by a delimiter, such as a comma or tab. 

Fixed-Width: Fields are aligned at fixed character spaces. 

Record Delimiter Sets the delimiter to be used to separate records: Carriage Return/Line Feed, 

Carriage Return, Line Feed or any other string. 

Column Delimiter Select the character to use to separate the columns in the data file: Comma, Tab, 

Semi-colon, Space or any other string. 

Text Qualifier Select the character to use to qualify text. Textual responses are encapsulated within 

these characters. Options include: None, double quote ("), single quote ('). 

Multiple Response 

Qualifier 

Select the character to use qualify multiple responses. Reponses are encapsulated 

within these characters. Options include: Parenthesis (( )), Curly Braces ({ }), Square 

Braces ([ ]), Angle Brackets (< >) or any other single character. 

Multiple Response 

Delimiter 

Select the character to use to separate multiple responses. Options include Comma 

(,), Hyphen (“), Colon (:), Semi-colon (;), Space or any other single character. 

Fixed Width Files Only: 

Automatically 

format questions 

that allow multiple 

responses 

Mark the Automatically format questions that allow multiple responses checkbox to 

automatically set formatting for questions that allow more than one answer choice 

(e.g. (1,2,3) becomes 123). Note that Remark looks at the longest answer choice and 

any answer choices that are shorter have padding added to them to make them the 

same length. For example, if the answers are 5, 10 and 3, it would look like 5 103. 

One space of padding is added after the 5 because 10 is the longest answer choice 

with two characters. This setting only applies to Fixed Width files. 

Field Size The maximum number of characters allowed in the field. 

Start Position The position, in characters, where the field begins. For example, if your field sizes are 

25, the first field starts at position 1 and the second field starts at position 26 (25 

characters later). This field is for reference only and cannot be changed. 

Pad Character Enter the character to use to pad the field (typically a space character). 
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Option Description 

Pad On Select whether to pad the field on the left or right of the text that resides in the field. 

 

8. Click the Next button to go to the next step. 

9. Use this step if you need to break your data apart into multiple records. This option is useful for 

things like attendance forms, session evaluations and any other forms that evaluate more than 

one person on a single form. If you do not need to break apart data, simply click the Finish 

button (step 14). 

10. Choose how many records you want in your data set. For example, if you are processing an 

attendance sheet and there are 20 students per form (row of data), you would enter 20. Click the 

Update button. The number of desired records are created on the right side of the window. 

11. You have three options for formatting the file: 

• Add to Every Record: Choose this option to add a question (or questions) to every record in 

the data set. In our attendance example, this might be a class name or teacher name 

(something that is static for everyone). 

• Add to Selected Records: Use this option to add questions to only the records you have 

selected on the right side of the window. This option lets you fine tune what goes into each 

record. 

• Split Among Records: Use this option to select questions and then have them equally split 

across all records. In our attendance example, this would be the questions that are used to 

track attendance (e.g. days of the week). For example, suppose you have students listed down 

the left side of the form and options for Monday-Friday for each student. If a student is in 

attendance, the corresponding bubble is filled. If the student is absent, the bubble is left 

blank (this is a Boolean region). You can split the students among all the records. Then split 

each day among all the records. See screen shot at right. If your data was not split, you might 

have something like this: 

 

Notice how the students and attendance are listed in one long row. 

However, if you split your data, you have this: 
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Notice how each student is now occupying one record of data, along with his/her attendance. 

12. Using the above descriptions, parse your data as needed.  

13. Use the Preview button to preview how your data will look once exported. 

14. When finished, click the Finish button. 

15. When the Save Configuration window appears, click the Yes button to save your settings to a 

file that you can use later when saving data. If you do not wish to save this configuration file, click 

the No button. If you are not saving the configuration file for later use, the data file is saved when 

you click the No button. Continue with the next steps if you are saving the configuration file. 

Otherwise you are finished saving your data. 

• [Optional] If saving the configuration file, in the Save Text Export Configuration As box, 

select a location in which to save the configuration file in the Save in box. 

• Enter a name for the file in the File name box. 

• Leave the Save as type box set to Text Export Configuration Files (*.tec). 

• Click the Save button to save the TEC file and create the data file.  

The data is saved according to your specifications and you can reuse the TEC file in the future. The 

resulting text file can be taken to the application of your choice. 

Creating a Data Transform 

If you want to use Remark Quick Stats to analyze a subset or customized configuration of your data, you 

can use the Data Transform option. This option allows you to set up the same custom parameters and 

pass them into Remark Quick Stats so that your data can be analyzed. Normally the newly formatted file 

would require a new template to match, but the transform option does that for you. Note that if you want 

to analyze your data on multiple occasions, you will need to perform the transform option each time. You 

can use a saved custom text configuration file (.tec) when using the data transform option (you do not 

have to start from scratch). Note that the data transform option does not output a data file. If you want a 

saved data file you should use the Custom Format first (File|Save Data|Custom… see section above). 

 

To create a custom transform 

1. Scan forms or open a data file. 

2. If analyzing a survey, click the drop-down arrow on Advanced Survey and choose Create Data 

Transform. If grading a test, click the drop-down arrow on Advanced Grade and choose Create 

Data Transform. 

3. [Optional] If you previously created a transform file or saved data using the Custom Text option, 

you may use the ellipsis (…) to open the existing .tec file. The remainder of these instructions will 

focus on creating a new data transform. 

4. Click the Next button. 

5. Use this step if you need to break your data apart into multiple records. This option is useful for 

things like attendance forms, session evaluations and any other forms that evaluate more than 

one person on a single form. If you do not need to break apart data, simply click the Finish 

button (step 11). 
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6. Choose how many records you want in your data set. For example, if you are processing an 

attendance sheet and there are 20 students per form, you would enter 20. Click the Update 

button. The number of desired records are created on the right side of the window. 

7. You have three options for formatting the file: 

• Add to Every Record: Choose this option to add a region (or regions) to every record in the 

data set. In our attendance example, this might be a class name or teacher name (something 

that is static for everyone). 

• Add to Selected Records: Use this option to add regions to only the records you have 

selected on the right side of the window. This option lets you fine tune what goes into each 

record. 

• Split Among Records: Use this option to select regions and then have them equally split 

across all records. In our attendance example, this would be the regions that are used to track 

attendance (e.g. days of the week). For example, suppose you have students listed down the 

left side of the form and options for Monday-Friday for each student. If a student is in 

attendance, the corresponding bubble is filled. If the student is absent, the bubble is left 

blank (this is a Boolean region). You can split the students among all the records. Then split 

each day among all the records. See screen shot at right. If your data wasn’t split, you might 

have something like this: 

 

Notice how the students and attendance are listed in one long row. 

However, if you split your data, you have this: 

 

 

 

 

 

 

Notice how each student is now occupying one record of data, along with his/her attendance. 

8. Using the above descriptions, parse your data as needed.  

9. Use the Preview button to preview how your data will look once exported. 

10. When finished, click the Analyze or Grade button. 

11. When the Save Configuration window appears, click the Yes button to save your settings to a 

file that you can use later when saving data or creating a data transform. If you do not wish to 

save this configuration file, click the No button. Continue with the next steps if you are saving the 

configuration file. Otherwise you are finished creating your data transform. 

• Note: No data is saved. You are only saving the configuration settings to be used at another 

time. 

• [Optional] If saving the configuration file, in the Save Text Export Configuration As box, 

select a location in which to save the configuration file in the Save in box. 
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• Enter a name for the file in the File name box. 

• Leave the Save as type box set to Text Export Configuration Files (*.tec). 

• Click the Save button to save the TEC file. 

13. Depending on your operation, Advanced Survey or Advanced Grade opens. Make the desired 

selections to analyze your data and run Remark Quick Stats. Please see the Remark Quick Stats 

User’s Guide PDF to learn more about these options (Start|All Programs|Remark Classic OMR 

5|Documentation). 

Database Update Format for Saving Data 

The database update format allows you to update an existing database based on the data in the Remark 

Office OMR data grid (Access or Excel). The data are matched to the existing database by the region 

names and a mapping process. When saving to this format, you map the regions in the Remark Office 

OMR data to the fields in the existing database. You also choose a question to be the record identifier. If 

data corresponding to the unique record identifier exists in the database it is updated with what is in 

Remark Office OMR when the identifiers are matched. For example, if you are conducting a survey that 

collects demographic information, and include for a respondent identifier on your form, you could use the 

identifier as the record ID to update an external database using the Database Update format. During the 

save process, Remark Office OMR attempts to find the ID in the database and then updates the data fields 

associated with that respondent. If the ID is not found, you have the option of adding the record to the 

external database. 

• Note: The ODBC Database Update format works just as described here, but you can save to a 

database using an ODBC connection. 

  

To use the Database Update format 

1. Select the File menu and then click Save Data As. The Save Data window opens, allowing you to 

choose a file name, a file type, the folder in which you would like the file saved and advanced 

saving options. 

2. Select the desired folder location using the Look in drop down box. 

3. Select a file to update, which fills the File name box. 

4. Select the Database Update (*.ACCDB, *.MDB, *. XLSX, *.XLS) format in the box titled Save as 

type. 

5. Click the OK button. A window opens to walk you through the next few steps. 

6. If you have used the Database Update format previously and have a saved configuration file that 

applies to this data set, click the Load... button to locate the configuration file. Otherwise, go on 

to step 7. 

• Note: You are prompted to save a configuration file with your settings after saving the data. 

7. In the Update Options area, select the number of records contained in each row of the data set 

(e.g. if multiple respondents' answers are on a single form, you would have more than one record 

per data row). If each record in the data set corresponds to one respondent’s submission, use 1 

for the value. 
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8. In the Update Options area, mark the Add database records for missing record identifiers 

checkbox if you would like to create new records in the database when an identifier is not found. 

9. In the Field Mapping area, map the regions from Remark Office OMR to the fields in the external 

database. The target database fields are listed in the first column, called Database Field, and the 

Remark Office OMR regions (questions) are listed in 

the second column, called Grid Column. Use the 

down arrow in the Grid Column section to choose 

the appropriate field to map to the corresponding 

database field. 

• Note: Remark Office OMR attempts to 

automatically map the fields based on the 

field/region names. Review the field mapping 

first and then make changes if necessary. 

10. Choose a field or fields to use as an identifier by 

marking the appropriate checkbox next to the field 

name. The identifier fields are used to match data 

from Remark Office OMR to the external database. 

If a match is not found, the data is not added to the 

database (unless you selected this feature in step 8) 

and you receive a message. You may select more 

than one field to use as the identifier, in which case the data from all identifier fields must be a 

match for the record to be updated in the external database. 

11. Click the OK button to save the data. 

12. If any problems are encountered when updating the selected file, a message appears detailing the 

problems. If the database is updated successfully you receive a message telling you how many 

records were updated and asking you if you want to save the configuration file for later use (if 

you use this same template and external database again, you can save a configuration file and 

skip the mapping process). If you do wish to save the file, click the Yes button. Enter a file name 

and choose a location for the .ini file in the Save window that appears.  

Opening Data Files  

The Remark Office OMR Data Center can open data saved in dozens of different file formats. We 

specifically designed the Remark file format to optimize the data storage process in the Remark Office 

OMR software. The software is designed to work with data that is collected using a form template in 

Remark Office OMR. Therefore, you must first open a form template and then open the corresponding 

data file. Once the data file is opened, you can save it to another format or location, or use Remark Quick 

Stats to analyze it. 

• Tip: When working with data in Remark Office OMR, use the Remark file format (RMK or RMX). 

This format saves the link to the image files and exception case colors. Only save data to other 

formats when exporting. 

The following table lists the different file formats the Data Center can open, their extensions and a brief 

description: 
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File Format Extension Description 

Remark Extended RMX Remark Office OMR format; saves grid exception colors and image 

links; includes information about changed responses for associated 

reports in Remark Quick Stats 

Remark  RMK Remark Office OMR format; saves grid exception colors and image 

links 

Remark Extended Office 

Archive  

ROX Remark Office OMR Archive format; combines template, data and 

stored image files into one file, Saves grid exception colors and 

image links; optionally includes support information for 

troubleshooting; includes information about changed responses for 

associated reports in Remark Quick Stats 

Remark Office Archive  ROA Remark Office OMR Archive format; combines template, data and 

stored image files into one file, Saves grid exception colors and 

image links 

SQL Server MDF Microsoft SQL Server format 

Oracle *.* Oracle format 

Access 2007-2016 ACCDB Microsoft Access 2007-2013 format (only available if the 32-bit 

Access 2007 or greater database engine is installed) 

Access 2000-2003 MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format 

Access 2.0 MDB Microsoft Access 2.0 format 

Access 1.0 MDB Microsoft Access 1.0 format 

Excel 2007-2016 XLSX Microsoft Excel 2007-2013 format (only available if the 32-bit Access 

2007 or greater database engine is installed) 

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Excel 95 XLS Microsoft Excel 95 format 

Excel 4.0 XLS Microsoft Excel 4.0 format 

Excel 3.0 XLS Microsoft Excel 3.0 format 
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File Format Extension Description 

SPSS SAV SPSS 16 format 

SPSS Legacy SAV SPSS 6 format 

Survey Pro SRV Survey Pro standard format (Apian Software) 

Opinionmeter ASC ASCII format for Opinionmeter application 

CSV CSV Comma separated values 

Text TXT Tab delimited text format 

StatPac DAT StatPac format for StatPac Survey Software 

dBase 5.0 DBF dBase 5.0 format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 5.X DB Paradox 5.X format 

Paradox 4.X DB Paradox 4.X format 

Paradox 3.X DB Paradox 3.X format 

Lotus WK4 WK4 Lotus Works 4 format (open only) 

Lotus WK3 WK3 Lotus Works 3 format 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus WJ3 WJ3 Lotus 1-2-3 version 3 format 

Lotus WJ2 WJ2 Lotus 1-2-3 version 2 format  

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated to specified record 

length 

Data Interchange Format DIF Standard format using file header and data section 
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File Format Extension Description 

CCI Assessment DAT CCI Assessment format 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language 

ODBC *.* Open Database Connectivity 

  

To open grid data 

1. Open the correct form template. 

2. Select the File menu and then click Open 

Data to display the Open Data window. 

Alternatively, use the Open data file link 

from the task pane or Open Data button 

from the toolbar. 

3. Select a file from the list. Use the Look in 

box to locate saved data files. You may need 

to adjust the Files of type list to find the 

desired file. 

• Note: The data contained in the file 

must correspond to the currently active 

form template or an error may occur. 

4. If opening a database file, select the 

appropriate table from the Table name drop-down list. 

5. Click the OK button to open the data file. 

• Caution: When opening a database file type, the Data Center attempts to match grid column 

headers (region names) to the database's field names. If any column headers cannot be 

matched, an error occurs. Grid column headers do not need to appear in the same order as 

the database fields. 

You may now read more forms, save the data to a new format or location or run Remark Quick Stats for 

analysis.  
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File Formats  

The following sections contain detailed information about each file format supported in Remark Office 

OMR. 

Remark Format (RMK, RMX) 

There are two Remark formats: Remark (RMK) and Remark Extended (RMX). The Remark formats are 

proprietary to the Remark software and, therefore, can only be used in Remark applications. We 

recommend that you use the Remark file format as your default file format and only save to other file 

formats when exporting data to other applications. These formats save data grid exception colors and the 

link between the data and the corresponding image. In addition, the Remark extended format saves 

information about changed responses so that you can run reports in Remark Quick Stats to view how 

many times a response was changed or respondents who change responses frequently, which could be 

useful when grading tests.  

• Tip: The Remark and Remark Office Archive formats are the only formats that preserve the link 

between each grid cell and the corresponding image, as well as exception case colors. If you 

export data to another format you are not able to click in a cell and view the corresponding 

image when using that format. We recommend exporting data to other formats only after you 

have fully cleaned your data. 

  

Extension • RMK, RMX 

Options (automatic) • Saving Images: The RMK and RMX formats automatically save the link between 

store images and the data. You may then refer to the image files to review data 

later. 

• Saving Grid Colors: The RMK and RMX formats automatically save the exception 

colors in the data, which are used in conjunction with Review Exceptions to 

clean your data. 

• Storing Changed Responses: The RMX format stores information about how 

many times a response was changed and how many times a respondents 

changed responses, which can be reported on Remark Quick Stats. 

Limitations • Proprietary to Remark software and cannot be used in other products. 

 

 

 

 



 

135 

 

Access Formats (ACCDB, MDB)  

The Access file formats are proprietary to the Access database program by Microsoft Corporation. Remark 

Office OMR supports the Access version 1.0 through 2016 file formats. Column (region) names in Remark 

Office OMR are used as field names when saving to an Access database. Remark Office OMR can save 

data to a new Access database, add new tables to existing Access databases and append data to existing 

Access tables. 

  

Extension • ACCDB, MDB 

Options • Table Name: When saving to an Access database, you must select a table name 

to which to save the data. 

Limitations • Field (region) and table names can contain a maximum of 60 characters 

(including spaces). Field (region) and table names cannot include: leading 

spaces, periods (.), exclamation points (!), accent graves (`) and brackets ([]). 

• An Access table can hold a maximum of 255 fields. 

• All region (field) names must be unique. 

• An Access table record can hold a maximum of 2000 characters (excluding 

Memo and OLE object regions). 

• If saving data to an existing table, grid column headers (region names) in 

Remark Office OMR must match table field names. 

• When Remark Office OMR creates an Access table, textual fields can contain a 

maximum of 255 characters. If you would like a field to support more than 255 

characters, edit the database in Microsoft Access and change the field type 

from a Text field to a Memo field. Alternatively, click the Advanced button in the 

Remark Office OMR Save Data window and change the field type to Memo. 

Comma Separated Values (CSV) Format 

The CSV file format is a generic textual format and can therefore be used by many different applications. 

Grid cells are delimited by commas. Grid rows are delimited by a carriage return line feed sequence. CSV 

is a good choice for importing data into other applications. It is important to know the type of CSV file 

your application expects before choosing the options listed below. 
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Extension • CSV 

Options • Save Headers: The Save Headers option in the Save Data window saves the grid 

column headers (region names) as the first record in the file. 

• Encoding: The Encoding lists allows you to choose the type of character 

encoding you want to use. You should find out the requirements of your data 

analysis package before choosing an encoding type. Choices include: 

o System Default: Use the Windows default encoding type (if you are 

uncertain about encoding, we recommend you use this setting). 

o ASCII: Standard encoding scheme that encodes 128 specified characters 

into 7-bit binary integers. 

o Big Endian Unicode: UTF-16 variable-length encoding capable of encoding 

1,112,064 possible characters into Unicode. 

o Unicode: Consistent encoding option that encodes 110,000+ plus 

characters. It is especially good for international characters, such as those 

found in the Arabic and Hebrew languages. 

o UTF32: Fixed length encoding that uses exactly 32 bits per Unicode code 

point. 

o UTF7: Variable length encoding for representing Unicode text in a stream of 

ACSII characters. It was often used in email, but has lost popularity. 

o UTF8: Variable length encoding capable of encoding all possible characters 

in Unicode. Designed for backward compatibility with ASCII. 

Limitations • When saving a CSV file, which is comma delimited, other applications may have 

difficulty opening the file if the data contain multiple responses. Multiple 

responses typically contain commas, which are also used as cell delimiters. 

Consider using the Custom format if you have questions that allow more than 

one response in the same data cell. 

Data Interchange Format (DIF) 

The Data Interchange file format is a "standard" method of exchanging data between non-compatible 

programs. By its nature DIF cannot support program-specific information, such as cell formats. 

  

Extension • DIF 

Options • None 

Limitations • None 
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dBase Format (DBF) 

The dBase file formats are commonly used database file formats used to transfer information between 

applications. Remark Office OMR supports dBase version III, IV, and V file formats. Column (region) names 

in Remark Office OMR are used as field names when saving to a dBase table. A dBase database is 

represented by a directory. A dBase table is represented by a DBF file within a dBase database. Remark 

Office OMR can save data to a new dBase table and append data to existing dBase tables. 

  

Extension • DBF 

Options • None 

Limitations • Region (field) names can contain a maximum of 10 characters (including 

underscores). 

• Spaces in region (field) names will be automatically converted to underscores. 

• All region (field) names must be unique. 

• Region (field) names cannot include punctuation. 

• A dBase table can hold a maximum of 255 fields. 

• If saving data to an existing table, grid column headers (region names) in 

Remark Office OMR must match table region names. 

• When Remark Office OMR creates a dBase table, textual fields can contain a 

maximum of 255 characters. If you would like a field to support more than 255 

characters, edit the database table in the dBase software program and change 

the region type from a Text region to a Memo region. Alternatively, click the 

Advanced button in the Remark Office OMR Save Data window and change the 

field type to Memo. 

ExamSoft Format 

The ExamSoft format is a specialized CSV file that imports into the ExamSoft testing software. It requires a 

Student ID and can optionally include a Test Version Identifier (if using multiple test versions). You should 

mark the Student ID as an "Analysis Respondent ID" in the form template region's properties. If you are 

using multiple test versions, you should also mark the appropriate region in the form template as 

"Designate as Key Identifier." Note that if these items are not marked in the form template, you are 

prompted for them when saving the data file. 

  

Extension • CSV 

Options • None 
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Limitations • A student identifier region is required. You may designate a student ID region 

as the Analysis Respondent ID in the form template. This property helps match 

students to the ExamSoft software. If you do not designate a Student ID 

region, you are prompted for one when saving the data. 

• If using multiple test versions, a version region is required. You may mark the 

region with Designate as Key Identifier in the form template or specify one 

during the data saving process. 

Excel Format (XLS, XLSX) 

The Excel file formats are proprietary to the Excel spreadsheet program by Microsoft Corporation. When 

saving data, Remark Office OMR supports the Excel version 97-2016 file formats. When opening data, 

however, you can go back as far as Excel 3.0. Column (region) names in Remark Office OMR are used as 

field names when saving to an Excel spreadsheet. Remark Office OMR can save data to a new Excel 

spreadsheet, add new sheets to existing Excel spreadsheet and overwrite existing Excel files. 

• Note: Older versions of the Excel formats have limitations, such as character limits and a 255 field 

limit. Use the 2013 format to avoid these limitations.  

 

Extension • XLSX, XLS 

Options • Sheet Name: When saving to an Excel spreadsheet, you must select a sheet 

name to which to save the data. 

Limitations • If saving data to an existing sheet, grid column headers in Remark Office OMR 

must match spreadsheet field names. 

HTML Format (HTM, HTML) 

HTML stands for Hyper Text Markup Language. Use HTML to publish data and results from Remark Office 

OMR to the Internet or an intranet. Remark Office OMR saves data as well as graphs (from analysis 

reports) for inclusion in web based documents. 

  

Extension • HTM, HTML 

Options • None 

Limitations • None 
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Lotus Format (WKS, WK1, WK3, WK4, WJ2, WJ3) 

The Lotus file formats are proprietary to the Lotus 1-2-3 program by Lotus Development Corporation. 

Remark Office OMR supports the Lotus 1-2-3, WK1, WK3 and WK4 formats. 

  

Extension • WKS, WK1, WK3, WK4, WJ2, WJ3 

Options • None 

Limitations • Data saved to a Lotus 1-2-3 version 2.0 format can have a maximum of 240 

characters per cell. Remark Office OMR displays an error message (listing the 

cell location) if any cell exceeds 240 characters when saving to a Lotus 1-2-3 

file format. 

• If a cell contains any textual data, the entire column is saved as a string (text) 

rather than numeric data. 

• Data in the WK4 format can only be opened (not saved). 

LXR Format (MRG) 

The LXR Test format by Logic Extension Resources is a tab delimited ASCII file made for exporting data to 

LXR Test. The file contains a custom header followed by the data. Grid rows are delimited by a carriage 

return line feed sequence. 

 

Extension • MRG 

Options • None 

Limitations • None 

Open Database Connectivity (ODBC) 

Open Database Connectivity, or ODBC, is a standard format independent of database and operating 

systems. ODBC works using an ODBC driver, which must be installed and configured correctly. Consult 

your database documentation for configuration and installation instructions. Once the ODBC driver is 

configured, you can select it in the Remark Office OMR Save Data window during a regular save 

operation. For example, you can save to MySQL and MariaDB using the ODBC driver. 
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Extension • *.* 

Options • None 

Limitations • Consult your database documentation for specific format limitations. 

 Opinionmeter Format (ASC) 

The Opinionmeter file format creates a text file for importing into the Opinionmeter application. Grid cells 

are delimited by commas. Multiple responses are encapsulated in parentheses. Grid rows are delimited by 

a carriage return line feed sequence.  

Extension 
• ASC 

Options 

• Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the first record in the file. 

Limitations 
• None 

SQL Server  

The SQL Server driver is proprietary to the SQL Server database program by Microsoft. Remark Office 

OMR can add new tables to existing SQL Server databases and append data to existing SQL Server tables. 

  

Extension • NA 

Options • Server: The SQL Server driver saves data to the server you specify. 

• Table Name: The SQL Server driver saves data to the table within the database 

you specify. You may create new tables or save to existing tables. 

• Login: You may log in to the database for security purposes. 

Limitations • Consult the SQL Server database documentation for specific format limitations. 
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Oracle 

The Oracle driver is proprietary to the Oracle database program by Oracle. Remark Office OMR can add 

new tables to existing Oracle databases and append data to existing Oracle tables. 

  

Extension • NA 

Options • Server: The Oracle driver saves data to the server you specify. 

• Table Name: The Oracle driver saves data to the table within the database you 

specify. You may create new tables or save to existing tables. 

• Login: You may log in to the database for security purposes. 

Limitations • Consult the Oracle database documentation for specific format limitations. 

Paradox Format (DB) 

The Paradox file formats are proprietary to the Paradox database program by Borland International, Inc. 

Remark Office OMR supports Paradox version 3.X, 4.X, and 5.X, 7 and 8 file formats. Column (region) 

names in Remark Office OMR are used as field names when saving to a Paradox database. Remark Office 

OMR can save data to a new Paradox database or overwrite existing tables. 

  

Extension • DB 

Options • Primary Index: When saving to a Paradox database, you must select a field to 

use as the primary index. 

Limitations • Primary Index: You must select a field to use as a primary index. A primary 

index must contain a unique value for every record. 

• For Remark Office OMR to save data to a Paradox table, the ParadoxNetStyle 

must be set to the selected Paradox save format. (See your Paradox database 

documentation for more information on the ParadoxNetStyle property.) 

• All region (field) names must be unique. 

• A Paradox table can hold a maximum of 255 fields (columns). 

• A Paradox record can hold a maximum of 10,800 bytes. 

• If saving data to an existing table, grid column headers (region names) in 

Remark Office OMR must match table field names. 
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• When Remark Office OMR creates a Paradox table, textual fields can contain a 

maximum of 255 characters. If you would like a field to support more than 255 

characters, edit the database in Paradox and change the field type from a Text 

region to a Memo field. Alternatively, click the Advanced button in the Remark 

Office OMR Save Data window and change the field type to Memo. 

Questionmark Format (QSF) 

The Questionmark format is proprietary to the Questionmark Perception assessment software program. 

This format has specific parameters that must be defined, including a Snapshot ID (the value that uniquely 

identifies the assessment) and the Participant (the region that identifies each respondent). Additionally, 

there are optional parameters you may specify, including the Group, Details, Date and Monitor. This 

information should closely match what was originally defined in Perception. For example, the Snapshot ID 

used should already be defined in Perception as the ID for this particular form, the Participant IDs should 

already be defined in Perception as the student identifiers, Group should already be defined, Questions 

should already be defined in the same order as they appear in this form, Special fields should already be 

defined in the appropriate order and Details should already be defined (as to what type of information the 

field should contain). Please see the table below for further details. 

 

Extension • QSF 

Required Parameters • Snapshot ID: A value that uniquely identifies the assessment. Each record in 

the data file must contain the same Snapshot ID. The Snapshot ID must be a 

numeric value from 1 to 99999999. Choose a field containing the Snapshot 

ID or enter one manually. 

• Participant: Participant, student or respondent identifier. This field uniquely 

identifies each respondent. Every record in the data file must contain a 

unique Participant identifier. Choose the field containing this information. 

Optional Parameters • Group: Group, category, course or department. This entry should match the 

groups defined in your Questionmark application. Choose the field 

containing the group or enter a group name manually. 

• Details: Optional demographic data. Choose the field containing the details 

or enter a value manually. 

• Date: Date the assessment took place. Choose a field containing the date or 

enter one manually. 

• Monitor: Monitor, teacher or instructor name. Choose the field containing 

the monitor name or enter one manually. 

Limitations • The Questionmark format is only available when saving data. You may create 

new files or overwrite existing files, but you cannot open the files in Remark 

Office OMR. 
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• Region names cannot contain double quotes ("). 

• Spaces entered before or after a region name or data label will be ignored. 

However, spaces in the middle of a region name or data label will be 

counted. ” 

• Graded questions MUST use region names of "Q1, Q2, Q3..." or "Question1, 

Question2, Question3..." 

• You may optionally define questions called "Special1 - Special10" that can 

contain more optional demographic data. 

• The following fields can contain a max of 50 characters (any more will be 

truncated): Participant, Group, Details, Monitor, Special1 - Special10. 

• All exceptions should be corrected before exporting to this format. Any 

exception found in the graded questions when exporting is treated as an 

unanswered question. 

Report Format (RPT) 

The Report file format is a fixed width ASCII file. Each cell is padded, if necessary, to the specified length. 

Grid rows are delimited by a carriage return line feed sequence. The specified record length is written to 

the beginning of the file followed by the actual data. 

  

Extension • RPT 

Options • Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the first record in the Report data file. 

• Record Length: The Record Length option in the Save Data window allows 

you to choose the fixed length of each piece of data written to the file. 

Limitations • If any cells contain data longer than the specified record length, Remark 

Office OMR displays an error message that lists the cell location. 

SPSS Format (SAV) 

The SPSS file format is proprietary to the SPSS statistical software program by SPSS, Inc. The column 

headers (region names) in Remark Office OMR are saved as SPSS variable names. The question text, if 

entered, is saved as SPSS variable labels. Remark Office OMR uses the Labels and Values defined when 

creating the form template as SPSS value labels and value numbers, respectively. Missing, invalid or 

unrecognized responses in Remark Office OMR are assigned an SPSS missing value of -1 by default. 

• Note: The SPSS file format outputs numeric data for each of your Labels. By default, Remark 

Office OMR uses a sequential numbering scheme, called Values, which begins with 1 for the first 

Label. You may change these values in the form template by selecting a question's properties. 
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 Extension • SAV 

Options • Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the header names in the SPSS data 

file. If Save Headers is not selected, default variable names are used (e.g. v1, 

v2, etc.). 

Limitations • Data saved to an SPSS format can have a maximum of 255 characters per 

cell. Remark Office OMR automatically truncates any cell text that is greater 

than 255 characters when saving to an SPSS file. 

• Labels (Value Labels in SPSS) can have a maximum of 60 characters. 

• Values: If custom Values are not defined during form template creation, 

Remark Office OMR assigns Values in sequential order to use as SPSS Values. 

• Region names (Variable Names in SPSS) can have a maximum of 60 

characters. If a region name has more than 60 characters, it is truncated. 

• Region names cannot begin with a number. 

• Region names (Variable Names in SPSS) must be unique. If a region name is 

used more than once, SPSS converts the name to a standard naming 

convention (e.g. v1). 

• Question text (Variable Labels in SPSS) can have a maximum of 120 

characters. 

• Questions that allow more than one response are broken into separate 

Boolean questions for each answer option and the answers are saved as a 

dichotomy of 1 representing selected and 0 representing not selected. The 

question is then defined as an SPSS multiple response set that can then be 

analyzed. (You do not have to set the question up as Boolean in the 

Template Editor; it is handled behind the scenes). 

SPSS Legacy Format (SAV) 

The SPSS file format is proprietary to the SPSS statistical software program by SPSS, Inc. We strongly 

recommend using the SPSS format (non-legacy) but if you require an older version of the format, you may 

use the legacy format. The older version does have more limitations. The column headers (region names) 

in Remark Office OMR are saved as SPSS variable names. The question text, if entered, is saved as SPSS 

variable labels. Remark Office OMR uses the Labels and Values defined when creating the form template 

as SPSS value labels and value numbers, respectively. Missing, invalid or unrecognized responses in 

Remark Office OMR are assigned an SPSS missing value of -1 by default.  

• Note: The SPSS file format outputs numeric data for each of your Labels. By default, Remark 

Office OMR uses a sequential numbering scheme, called Values, which begins with 1 for the first 

Label. You may change these values in the form template by selecting a question's properties. 
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Extension • SAV 

Options • Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the header names in the SPSS data 

file. If Save Headers is not selected, default variable names will be used (e.g. 

v1, v2, etc.). 

Limitations • Data saved to an SPSS format can have a maximum of 255 characters per 

cell. Remark Office OMR will automatically truncate any cell text that is 

greater than 255 characters when saving to an SPSS file. 

• Labels (Value Labels in SPSS) can have a maximum of 60 characters. 

• Values: If custom Values are not defined during form template creation, 

Remark Office OMR assigns Values in sequential order to use as SPSS Values. 

• Region names (Variable Names in SPSS) can have a maximum of eight 

characters. If a field name has more than eight characters, it will be 

truncated. 

• Region names cannot begin with a number. 

• Region names (Variable Names in SPSS) must be unique. If a region name is 

used more than once, SPSS will convert the name to a standard naming 

convention (e.g. v1). 

• Question text (Variable Labels in SPSS) can have a maximum of 120 

characters. 

• Remark Office OMR can open and save to an uncompressed SPSS format 

only. Remark Office OMR cannot open compressed SPSS files. If you need to 

uncompress your SPSS file, first open the file in SPSS. Select the File menu 

and click Save As. Enter a file name and then click the Paste button. In the 

Syntax Editor window, change the word "COMPRESSED" to 

"UNCOMPRESSED". Press Ctrl+A to select the text, then select the Run menu 

and click Current. 

• SPSS cannot import multiple responses (e.g. (A,B,C)) as numeric data. 

Questions that allow multiple responses in Remark Office OMR will be 

formatted as a string when exported to the SPSS file format, which will not 

import properly. To import questions that allow multiple responses into SPSS 

as numeric data, set the questions up as Boolean OMR regions in the form 

template. As a result, Remark Office OMR will output the responses to 

separate cells (each answer choice will be treated as a individual question in 

the data grid). Once the data have been opened in SPSS, you can combine 

the data for each answer in the question back into one question. Refer to the 

SPSS User's Guide for more information. 
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StatPac Format 

StatPac data files are fixed format sequential ASCII files with a carriage return and line feed at the end of 

each line. When saving to the StatPac format two files are created: .dat and .cod. You import the .dat file 

into StatPac but the .cod file is also required. Both files should have the same name up to the period 

before the extension. StatPac imports both Question Names and Question Text.  

  

Extension • DAT 

Options • None 

Limitations • You need both the .dat and .cod files when importing into StatPac. Ensure 

that the names up to the period are the same (Remark Office OMR does this 

automatically for you when saving). 

• The StatPac format imports both Question Names and Question Text 

(optional). 

Text Format (TXT) 

The Text file format is generic and can therefore be used by many different applications. The text format 

similar to the CSV format with one difference: 

• All text files are tab delimited 

  

Extension • TXT 

Options • Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the first record in the Spreadsheet 

data file. 

Limitations • All text files are tab delimited. 

The Survey System (DAT, CRS) 

The Survey System file format is proprietary to The Survey System survey design and analysis software 

program by Creative Research Systems. When saving to the Survey System file format, Remark Office 

OMR creates two files: a data file and a questionnaire definition file. To import the data into The Survey 

System, first import the questionnaire definition file (CRS extension) and then open the data file (DAT 

extension) within that questionnaire. Consult The Survey System user's guide for additional information. 

Data may only be saved to The Survey System format (not opened in Remark Office OMR). 
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Extensions • DAT, CRS 

Options • None 

Limitations • You may create new data files or overwrite existing files only (not open data 

files in Remark Office OMR). 

XML Format (XML) 

The XML format is used to save data to an XML file, which stands for Extensible Markup Language and is 

widely used for the exchange of data on the Internet. 

  

Extension • XML 

Options • None 

Limitations • Region (field) names can contain a maximum of 60 characters (including 

spaces). 

• Region (field) names cannot include: leading spaces, periods (.), exclamation 

points (!), accent graves (`) and brackets ([]). 

• An XML file can hold a maximum of 255 fields. 

• All region (field) names must be unique. 

• An XML record can hold a maximum of 2000 characters (excluding Memo 

and OLE object regions). 

• If saving data to an existing file, grid column headers (region names) in 

Remark Office OMR must match field names. 

• When Remark Office OMR creates an XML file, textual fields can contain a 

maximum of 255 characters. If you would like a field to support more than 

255 characters, edit the file and change the field type from a Text field to a 

Memo field. Alternatively, click the Advanced button in the Remark Office 

OMR Save Data window and change the field type to Memo. 
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Emailing Data Overview 

You can email data files in their native formats or in ZIP format from the Remark Office OMR Data Center. 

You have a choice of using Microsoft Outlook 2007 or greater or your own SMTP server (Custom) to send 

the emails.  

• Note: When emailing data, a local copy of the data is not saved. If you need to save a data file, 

make sure you take that step in addition to using the email function.  

  

Microsoft Outlook: 

If you plan to use Microsoft Outlook 2007 or greater, you do not need to set up anything outside of 

telling the software to use Outlook. When you email a data file, Outlook opens a new email with the data 

attached.  

 

Your SMTP Server: 

If you use your own SMTP server, you must have a valid SMTP server set up independently of Remark 

Office OMR. SMTP stands for Simple Mail Transfer Protocol and is the Internet standard for transmitting 

email across networks. It is likely your organization has a running SMTP server already set up. You just 

need to find out general information about the server. You will need to consult with your network/email 

administrator to obtain information about your SMTP server. 

Click here to see how to choose your default email program. 

Using Outlook to Email Data 

Once you have set up your email preferences in Tools|Preferences, you are ready to start emailing data 

files.  

  

To email data files using Microsoft Outlook 

1. After processing forms, saving data or opening a data file, select the File menu and click Email.  

• Note: If you choose the toolbar option or task pane option to send email, the file is always in 

zipped format. 

2. Choose Data as Attachment to attach the native file to an outgoing email message. Choose 

Data as ZIP Attachment to first zip the native data file (compress it into a .zip file) and then 

attach it to an outgoing email. The Email Data window appears. 

• Note: Your organization, or the recipient's organization, may have restrictions on the types of 

files that can be sent via email. If the file is restricted and you do not zip it, the email may 

never reach the intended recipient. If you are unsure whether the selected file type is 

restricted, use the ZIP option. The recipient must have a Zip program to unzip the file and 

view it. 
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3. Choose the File name, file format 

using Save as type and if using a 

database format, the Table or Sheet 

name. You do not need to specify a 

location for the file, as it is 

automatically attached to an email 

message. 

4. Click the OK button. 

5. Outlook automatically opens a new 

email message with your file attached. You may now enter recipients and a message and send 

your file.  

• Note: if you chose to zip the file, it appears with a .zip extension. 

Using SMTP to Email Data 

Once you have set up your email preferences in Tools|Preferences, you are ready to start emailing data 

files.  

  

To email data files using your SMTP server (Custom) 

1. After processing forms, saving data or opening a data file, select the File menu and click Email.  

• Note: If you choose the toolbar option or task pane option to send email, the file is always in 

zipped format. 

2. Choose Data as Attachment to attach the native file to an outgoing email message. Choose 

Data as ZIP Attachment to first zip the native data file (compress it into a .zip file) and then 

attach it to an outgoing email. The Email Data window appears. 

• Note: Your organization, or the recipient's organization, may have restrictions on the types of 

files that can be sent via email. If the file is restricted and you do not zip it, the email may 

never reach the intended recipient. If you are unsure whether the selected file type is 

restricted, use the ZIP option. The recipient must have a Zip program to unzip the file and 

view it. 

3. Choose the File name, file format 

using Save as type and if using a 

database format, the Table or Sheet 

name. You do not need to specify a 

location for the file, as it is 

automatically attached to an email 

message. 

4. Click the OK button. 

5. The Email Message window appears. 

6. Enter the recipient(s)' email address in the To box. Separate multiple recipients with a semi colon 

(;). 
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7. Enter your return email address in the From box. 

8. Accept the default subject, which is the file name, 

or enter a new one in the Subject box.  

9. In the rich text box, type your message to the 

recipient(s). You may use the toolbar to format 

your message as desired. 

10. If you have already configured your SMTP settings 

in Remark Office OMR you do not need to click 

the SMTP Settings tab. However, if you have not 

entered your SMTP settings or need to modify 

them, click the SMTP Settings tab to enter the 

SMTP server information. You will need to obtain 

this information from your network/email 

administrator. 

11. Click Send when you are ready to send your message. 

  

Your email message is automatically sent. The file is only saved as an email attachment; there is no 

permanent copy of the file saved on your computer when using the email functionality. If delivery 

problems occur, delivery reports are routed to the address listed in the From box of the email message 

(this may depend on how your SMTP server is configured to handle message failures).  
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Chapter 8: Software 

Recognition Settings  

Recognition Settings Overview 

Out of the box, Remark Office OMR comes with the recognition settings that are optimal for a well 

designed and tested scannable form. However, circumstances can introduce recognition problems. Here 

are few things that can potentially interfere with proper recognition of your forms: 

• Respondents who do not fill bubbles completely or use light marks, cross out responses, erase 

responses or use white out to change responses 

• Forms that are scanned upside down 

• Forms that are accidentally scanned with the wrong batch, including blank forms 

• Form images that are compressed or expanded as compared to the original form template image 

(possibly due to photocopying, using different printers, saving as PDF files or changing scanner 

settings) 

• Forms that are much lighter or darker than the original (possibly due to photocopying) 

Remark Office OMR has several recognition settings that can help you compensate for these issues. Please 

note that you may have to try a few adjustments to get the right settings for your particular form. 

Recognition Settings can be either software based or form template based. 

You can access the Recognition Settings in three ways: 

1. Select Tools|Recognition Settings|Default Settings or Tools|Recognition Settings|Template 

Settings. 

2. From the Data tab in the left task pane, under Advanced Recognition. 

3. From the Read window click the Recognition Settings button.  

The Recognition settings apply throughout the software whether you are reading forms directly from a 

scanner or reading image files. The link called Image Pre-Processing only applies when reading image 

files you already scanned to a folder. 

Recognition settings are stored in two places: as global software defaults and with the form template to 

which they were applied. Choose the option that best meets your needs. If a specific form template is 

causing problems, open it in the Data Center first, then adjust only its recognition settings using either the 

Tools|Recognition Settings|Template Settings option, clicking the appropriate setting in Advanced 

Recognition in the task pane or clicking the Recognition Settings link within the Read window. When 

recognition settings are adjusted for a particular form template, those settings override any global 

settings. If you wish to change recognition settings across the board for all new form templates, use the 

Tools|Recognition Settings|Default Settings option. Global settings apply to any form templates that 
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have never been used. The first time you use the form template, the global settings are in effect and 

remain in effect until you make changes while the form template is active. 

• Note: The settings you apply to a form template are stored in each user's preferences file on the 

computer. Therefore, if you share form templates or have different users accessing the same form 

template on the same machine, the settings could vary. Be sure to coordinate any changes you 

make to the recognition settings on the form template level with any other Remark users if you 

plan to share templates. 

The Recognition Settings window has a Defaults button. If you are in the global software defaults, clicking 

the Defaults button returns the software to the original installation defaults. If you have a form template 

open and are viewing the recognition settings for that form template, clicking the Defaults button resets 

the settings to the global default settings. 

• Note: The recognition settings are not a substitute for good form design and proper procedures 

for processing forms. It is very important that you follow the recommended form design 

guidelines when creating scannable forms, as well as the best practices laid out in the user's guide 

(e.g. creating a form template image from the same quality form you are distributing to 

respondents and maintaining scanner settings from the form template to the filled in forms). 

These recognition settings are intended to supplement good form design and best practices.   

Recognition Settings - Threshold 

Overrides 

There are three types of threshold overrides: OMR Region, Image Region and OCR Region. Thresholds are 

used behind the scenes to define tolerance levels when determining if a mark is filled (OMR regions, text 

is recognizable (OCR regions) or if handwriting is present (Image regions). When setting thresholds in the 

Recognition Settings, you are setting them globally, meaning they override the form template settings 

you may have applied to individual regions for the same feature. Threshold Overrides are off by default. 

You should only change the threshold from the default setting if you encounter recognition problems, as 

described in the next three paragraphs. 

OMR Threshold: The OMR Threshold is a value from 1 to 6, with 3 being the default. Using a lower value 

makes the software more sensitive. Lower values can be used to help pick up lighter markings (e.g. pencil), 

or when respondents do not fill a large portion of the mark. Use caution as you go lower; a value of 1 may 

cause erroneous marks, such as erasures, to be seen as filled marks. 

Higher values for the Recognition Threshold can be used to make the software more discriminating when 

multiple marks are filled. For example, if two marks are filled and one is erased, leaving some marking 

behind, or one is partially filled, a higher Recognition Threshold can help Remark Office OMR figure out 

which mark is filled. Very high Recognition Thresholds cause the software to be quite discriminating, 

meaning that it may choose a mark that is X'd out as the most filled when that was not the intention of 

the respondent. (Be sure to look at the Ignore Large Marks feature if you want to avoid this problem.) 

Image Threshold: The Image Threshold is a value from 1 to 6, with 3 being the default. Using a lower 

value makes the software more sensitive. Lower values can be used to help pick up lighter markings (e.g. 

pencil), or when respondents do not fill a large portion of the area in which they can hand write 

responses. Use caution as you go lower; a value of 1 may cause false positives during form processing. 

http://www.gravic.com/remark/support/office/formdesign.html
http://www.gravic.com/remark/support/office/formdesign.html
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Higher values for the Recognition Threshold can be used to make the software more discriminating when 

looking for handwriting in an Image region. Very high Recognition Thresholds may cause the software to 

not pick up some handwriting (e.g. if only a few words are written in a large space or light writing is used, 

such as pencil). However, it reduces the likelihood that unintended marks are picked up (e.g. stray marks 

and erasures). 

OCR Threshold: The OCR Threshold setting ranges from 1-100% with a default setting of 70%. The 

threshold applies to each individual character in the text you are trying to recognize. The software returns 

a confidence value for each character recognized (e.g. 70% certain it is a "G"). If any character returns a 

confidence value lower than the specified threshold, the OCR region is flagged as an exception for your 

review. If you find that regions are being flagged as blue during processing, indicating an OCR exception, 

but the text is read correctly, you can lower the Recognition Threshold. If you find that text is not being 

flagged but is being incorrectly interpreted, you can raise the OCR Threshold. 

Before adjusting thresholds, remember to determine whether you want to adjust them for the software in 

general or just the active template, as described in the Recognition Settings Overview. Then click 

Tools|Recognition Settings and make your selection. 

  

To change thresholds 

1. Determine the threshold you wish to 

override. 

2. Mark the appropriate checkbox for OMR 

Threshold, Image Threshold and/or OCR 

Threshold. 

3. Choose the desired value (1-6 for OMR and 

Image Regions, a percentage for OCR 

regions, as previously described). 

4. Click the OK button.  

The adjusted settings apply to your next Read 

operation and stay in place until you change them 

again. 

Recognition Settings - Auto Rotate 

The Auto Rotate feature causes the software to try to rotate form images if it cannot properly read the 

form during the first pass. If a form is accidentally scanned upside down, the Auto Rotate feature flips the 

scanned image right side up and tries the recognition again. This feature is on by default, and it is 

recommended that you keep it on. The default threshold is 25%, meaning that if the percentage of 

questions on the page contains 25% or more errors, Remark Office OMR tries to rotate the image and re-

recognize the page. If the error rate is not better than the original pass, no new results are recorded and 

the image is not rotated. 25% is generally a good number to use. Use a lower percentage if you want the 

software to find fewer errors before it tries to rotate the page (less error tolerance). Use a higher 

percentage if you want the software to find more errors before it tries to rotate the page (more error 

tolerance). 
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Before adjusting auto rotate, remember to determine 

whether you want to adjust it for the software in 

general or just the active template, as described in the 

Recognition Settings Overview. Then click 

Tools|Recognition Settings and make your selection. 

 To use Auto Rotate  

1. Mark the checkbox for Automatically Rotate 

Images. 

2. Choose the desired percentage of questions 

in which errors are found that should trigger 

the rotation (25% is recommended). 

3. Click the OK button.  

The adjusted settings apply to your next Read 

operation and stay in place until you change them again.  

Recognition Settings - Advanced Settings 

The Advanced Settings features include some behind the scenes advanced processing techniques and the 

ability to compensate for degraded marks. Enhanced Reading Mode, Compression Compensation and 

Rigorous Search are on by default, and we recommend keeping them on. Compensate for Missing and 

Damaged Marks is not on by default. You should turn it on when you encounter forms that have 

degraded images, such as optical marks (bubbles) that have been "whited" out or erased. 

Enhanced Reading Mode: Enhanced Reading Mode allows the software to do more in depth recognition 

of uncertain regions. 

Compensate for Missing and Damaged Marks: The Compensate for Missing and Damaged Marks 

setting allows Remark Office OMR to still recognize responses when marks (bubbles) are missing or 

partially missing. For example, respondents may have tried to erase an incorrect response, erasing some 

of the bubble along the way. Or they may have used white out to remove a bubble altogether. Without 

this feature, these cases would result in recognition errors. 

You can set a tolerance for missing and damaged marks on a region basis and on a question basis. The 

default setting for regions is 30%. This setting means that if 30% or more of a single region's marks are 

missing or damaged, a recognition error is output. The default setting for questions is 50%. This setting 

means that if 50% or more of a single question's marks are missing or damaged, a recognition error is 

output. Once the number of errors exceeds the specified threshold, the errors are reported (e.g. as 

recognition errors in the data grid). If the number of errors does not exceed the threshold, then the 

missing or damaged marks are considered unfilled. 

• Note: The software must be able to recognize at least one complete OMR region consisting of 

four or more bubbles in order for the Compensate for Missing and Damaged Marks feature to be 

active. 

Compression Compensation: Compression compensation attempts to compensate for images that are 

either compressed or expanded as compared to the image that was used to create the form template.  

Compression can happen during printing, scanning or copying forms.  
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Rigorous search: Rigorous search attempts to locate OMR regions when they are not found where they 

are expected to be found, based on how you set up the form template. Rigorous search can help with 

badly skewed or offset forms, but can also greatly increase the time it takes to process each image. A 

timeout value is available, which tells the software how long to try to locate the regions before giving up 

(3 seconds is the default). 

Before adjusting advanced settings, remember to determine whether you want to adjust them for the 

software in general or just the active template, as described in the Recognition Settings Overview. Then 

click Tools|Recognition Settings and make your selection. 

  

To use Enhanced Reading Mode, Compression Compensation or Rigorous Search  

1. Locate the item you wish to turn on and mark the corresponding checkbox.  

• Note: All three of these options are on 

be default and we recommend leaving 

them on unless you encounter 

difficulties. 

2. If using Rigorous Search, you may choose a 

timeout value. 

3. Click the OK button.  

The adjusted settings apply to your next Read 

operation and stay in place until you change them 

again. 

  

To use Compensate for Missing and Damaged 

Marks 

1. Mark the checkbox for Compensate for 

Missing and Damaged Marks.  

2. Region damage threshold: Choose the 

desired percentage of each region's marks 

above which recognition errors should be 

reported (30% is recommended as a starting 

point). 

3. Question damage threshold: Choose the 

desired percentage of each question's marks 

above which recognition errors should be 

reported (50% is recommended as a starting 

point). 

4. Click the OK button. 

The adjusted settings apply to your next Read operation and stay in place until you change them again. 
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Recognition Settings - Ignore Large 

Marks 

The Ignore Large Marks option lets you allow respondents to put large marks, such as an X, through a 

response that was marked by mistake (as opposed to erasing it or trying to use white out to remove it). If 

the software finds a large X or slash through a bubble, it tries to ignore it. If you want to use this feature, 

you should tell respondents how to mark bubbles they did not mean to fill, and include a graphic 

representation with the X or slash through the mismarked bubble. The Ignore Large Marks feature is off 

by default. 

Use the Large mark threshold to tell the software how to interpret the large marks. The default value is 2. 

Use a lower value to have the software be more likely to recognize a large X or slash and ignore the mark. 

Use a higher value to have the software be less likely to recognize a large X or slash and therefore include 

the mark in the recognition process. 

Use the Only ignore large marks if the question contains multiple responses option to only turn on this 

feature when Remark Office OMR detects multiple responses and one or more (but not all) of the 

responses is a large mark. Questions that contain only large marks report all of the responses selected. 

Therefore if a respondent uses all X's or slashes on the form, they are not accidentally misinterpreted as 

large marks. This option is on by default when the Ignore Large Marks feature is turned on. 

• Note: If you are using this feature and respondents' large X or slash go into or very close to an 

adjacent bubble you risk that Remark Office OMR also ignores the adjacent bubble. When 

designing your form, be sure to allow enough space in between bubbles, both vertically and 

horizontally to allow respondents to make a large mark. 

There is a set of reports called Changed Answer Reports in Remark Quick Stats that reports on responses 

that were changed using Ignore Large Marks (along with data grid changes).  

Before adjusting the ignore large marks feature, remember to determine whether you want to adjust it for 

the software in general or just the active template, as described in the Recognition Settings Overview. 

Then click Tools|Recognition Settings and make your selection. 

 

 To use Ignore Large Marks 

1. Mark the checkbox for Ignore Large Marks.  

2. Choose the desired Large mark threshold (2 

is the default) as previously described. 

3. If desired, mark the checkbox for Only ignore 

large marks if the question contains 

multiple responses, as previously described 

(recommended). 

4. Click the OK button. 

The adjusted settings apply to your next Read 

operation and stay in place until you change them again.  
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Recognition Settings - Dynamic 

Brightness Compensation 

The Dynamic Brightness Compensation feature automatically compensates for processed form images 

where the brightness of the image differs from that of the form template image. It is always 

recommended that you a) use the same quality form that you distribute for your form template image, 

and b) use the same scanner settings, such as brightness, for the form template image and the scanned 

forms. However, due to real world circumstances that may be beyond your control, the filled in forms 

returned for processing may have some differentiation in brightness. For example, they may have been 

photocopied or printed at a lighter density setting. Or they may have been scanned on a different scanner 

or with different scanner settings than those that were used for the form template. While Dynamic 

Brightness Compensation cannot compensate for every instance of form differences, it can help you in 

these situations. If the filled in form image is darker or lighter than the template image, the software tries 

to still recognize the regions on the form. The Brightness Compensation Threshold determines when to 

compensate. If the brightness of the filled in form image is more than the specified percentage lighter or 

darker, Remark Office OMR attempts to compensate for it when producing data. The default percentage is 

5%. Use a lower percentage to make the software more sensitive to lightness/darkness changes 

(compensating more frequently). Use a higher percentage to make the software less sensitive to 

lightness/darkness changes (allowing larger differences in image brightness before compensating). 

Before adjusting brightness compensation, remember to determine whether you want to adjust it for the 

software in general or just the active template, as described in the Recognition Settings Overview. Then 

click Tools|Recognition Settings and make your selection. 

  

To use Dynamic Brightness Compensation 

1. Mark the checkbox for Dynamic 

Brightness Compensation.  

2. Choose the desired Brightness 

compensation threshold (5% is the 

default) as previously described. 

3. Click the OK button.  

The adjusted settings apply to your next Read 

operation and stay in place until you change them 

again. 
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Recognition Settings - Blank Page 

Detection 

The Blank Page Detection option allows you to automatically detect when a blank page is scanned and 

remove it from the recognition process. For example, suppose you have the duplex option turned on for 

your scanner but are scanning a single sided form. Using Blank Page Detection, the backsides that the 

duplex scanner picks up are ignored. Or, if a blank page is accidentally scanned with valid pages, it is 

ignored. This feature is also useful if your form has an odd number of pages (e.g. three double sided 

pages). You do not have to create a blank backside in the form template; you can simply ignore the blank 

pages. 

The Blank Page Fill Threshold determines how much of the page must be filled in order for it to be 

ignored. The default setting is 10%, meaning that if the page's fill percentage is less than 10% of the 

template's lowest fill percentage the page is ignored. Use a lower percentage to require less fill on the 

page in order for the page to be considered blank (less sensitive). Use a higher percentage to require 

more fill on the page in order for the page to be considered blank (more sensitive). 

Before adjusting blank page detection, remember to determine whether you want to adjust it for the 

software in general or just the active template, as described in the Recognition Settings Overview. Then 

click Tools|Recognition Settings and make your selection. 

  

To use Blank Page Detection  

1. Mark the checkbox for Ignore Blank Pages. 

2. Choose the desired Blank page fill 

threshold (10% is the default) as previously 

described.  

3. Click the OK button.  

The adjusted settings apply to your next Read 

operation and stay in place until you change them 

again.  
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Recognition Settings - Page Error 

Detection 

The Page Error Detection option allows you to queue pages that contain many errors for later review. If a 

page contains more OMR or barcode errors than the threshold you have set, the page's image is placed in 

the Unrecognized Images Queue. You can then review all of the images in the queue and decide whether 

to keep or discard them. 

• Note: Multiple response (green cells) and blank response (yellow BLANK cells) errors are not part 

of the error percentage used for detecting page errors. Page errors are recognition errors where 

the OMR region or barcode simply could not be read. 

Use the Page Error Threshold to set how much of the page must contain errors before it is put in the 

unrecognized images queue. The default setting is 40%. Use a lower percentage to require fewer errors on 

the page before the image is sent to the unrecognized images queue. Use a higher percentage to require 

more errors on the page before the image is sent to the unrecognized images queue. 

Before adjusting page error detection, remember to determine whether you want to adjust it for the 

software in general or just the active template, as described in the Recognition Settings Overview. Then 

click Tools|Recognition Settings and make your 

selection. 

  

To use Page Error Detection  

1. Mark the checkbox for Page Error Detection. 

2. Choose the desired Page error threshold 

(40% is the default) as previously described. 

3. Click the OK button.  

The adjusted settings apply to your next Read 

operation and stay in place until you change them 

again.  
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Recognition Settings - Bit Depth 

Reduction 

When using color or grayscale images with Remark Office OMR, they must first be converted to black and 

white behind the scenes before they can be properly recognized. The software has to figure out which 

pixels are black and which are white. 

• Tip: A pixel is the smallest single component of a digital image. Therefore a single image is made 

up of many pixels. 

Remember that if you use black and white native images, this conversion does not need to happen; this is 

why we recommend using black and white images to reduce the processing load whenever possible. 

Generally the software can do this conversion automatically. However, if the standard conversion 

produces images that are too light or too dark, you can use the Bit Depth Reduction settings to fine tune 

the conversion process. There are individual settings for black and white conversions. 

Use the Black Bit Depth Conversion Threshold to adjust the thresholds for converting pixels to black. The 

default setting is 175. Use a lower number to make the image lighter. Use a higher number to make the 

image darker. For example, using a higher number could help light pencil marks appear darker and aid 

with recognition of those lighter marks. 

Use the White Bit Depth Conversion Threshold to adjust the thresholds for converting pixels to white. The 

default setting is 225. Use a lower number to make the image lighter. Use a higher number to make the 

image darker. For example, using a lower number could help erasures become less visible during 

processing. 

Before adjusting thresholds, remember to determine whether you want to adjust them for the software in 

general or just the active template, as described in the Recognition Settings Overview. Then click 

Tools|Recognition Settings and make your selection. 

  

To use Bit Depth Reduction 

1. Mark the Enable Black Bit Depth 

Conversion Threshold checkbox to adjust 

the black threshold.  

2. Choose the desired threshold, as described 

previously (175 is the default). You may need 

to try a few different thresholds before you 

get it just right for your form. 

3. Mark the Enable White Bit Depth 

Conversion Threshold checkbox to adjust 

the white threshold. 

4. Choose the desired threshold, as described 

previously (225 is the default). You may need 

to try a few different thresholds before you get it just right for your form. 
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5. Click the OK button.  

The adjusted settings apply to your next Read operation and stay in place until you change them again.  

Recognition Settings - Image Processing 

Options 

When importing images into Remark Office OMR, there are recognition settings you can adjust should 

certain problems occur. 

Invert: Use the Invert option to correct an image that appears in reverse: black background with white 

text. The default setting is No. You only need to adjust this setting if your image comes in reversed. 

Deskew: Use the Deskew option to correct an image that is crooked. The default setting is off. You only 

need to adjust this setting if your image comes in crooked.  

Despeckle: Use the Despeckle option to correct an image that has specks on it. Specks are typically 

caused by colored paper, shading on the form, using a dark brightness setting on your scanner or a dirty 

scanner.  You can also specify the pixel size to despeckle. The higher the number, the more despeckling is 

applied (e.g. for large specks). The default setting is off. You only need to adjust this setting if your image 

comes in with speckles.  

Flatten: If you are reading digitally filled PDF files, you must turn on this checkbox. Flattening the PDF 

forces the data from the fillable items, such as bubbles and checkboxes, to be included in the PDF file. 

Before adjusting image options, remember to determine whether you want to adjust them for the 

software in general or just the active template, as described in the Recognition Settings Overview. Then 

click Tools|Recognition Settings and make your selection. 

  

To use the image processing options 

1. Under Tools|Recognition Settings|Image Pre-

Processing, mark the checkboxes for the items you 

wish to use, based on the descriptions above. You 

may also access these settings from the Read window 

when processing images. 

2. Click the OK button.  

The adjusted settings apply to your next Read operation and 

stay in place until you change them again.  
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Chapter 9: Remark Office 

OMR Preferences  

Preferences Overview 

This section details how to customize the Remark Office OMR software by setting up preferences. 

Preferences allow you to set the way the software functions by default, which can facilitate your use of the 

software. Please note that there are also preferences for the Template Editor and Remark Quick Stats. 

• Important Note: The Preferences are global software settings. When you make a change to the 

Preferences, it affects all actions from that point forward. It does not affect anything you have 

already completed. 

  

To access the Preferences 

1. In the Remark Office OMR Data Center, select the Tools menu and then click Preferences. 

2. Use the links in the left task pane to access all of the available preferences. Each item is described 

below and using the links to the left. 

3. Once you make a change, click the Apply button.  

4. When you are finished working with the Preferences, click the OK button to close the window.  

From this point forward, any changes you made take effect. Note that you may click the Defaults button 

at any time to return the settings back to their originally installed state. 
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Remark Office OMR Preferences - 

General 

General preferences allow you to setup defaults for basic software functions. The following options are 

available: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Preference Option Description 

Review Exceptions: Attempt to match typed 

response to the list 

Mark this checkbox so that you can type the first letter(s) of a 

response into the Response box of Review Exceptions and the 

software automatically selects the response that begins with those 

characters. This option applies to questions that employ list box 

style cells only (Multiple, List, Rank and Boolean OMR regions and 

Image regions that utilize Database Lookup or qualitative response 

coding). 

Review Exceptions: Play a sound when the 

review process begins  

Mark this checkbox to play a sound when Review Exceptions first 

starts. This feature is useful as an alert if you are processing forms 

in an unattended manner. 

Review Exceptions: Play this sound when an 

exception is located 

Mark this checkbox to play a sound every time an exception case is 

located in Review Exceptions. Click the … button to select a .wav 

sound file. You may also click the ... button to preview the sound. 
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Preference Option Description 

Review Exceptions: Clear exceptions after 

they have been reviewed 

Mark this checkbox to remove the color coding for an exception 

after it has been reviewed. This setting applies when you review 

grid cells but do not make changes that would automatically 

remove the exception color (e.g. if a question is legitimately blank, 

you might leave it as BLANK with the yellow colored cell). By 

clearing the exceptions, Review Exceptions does not stop on them 

the next time it is run. 

Maximum length for a value in a data grid 

cell 

Enter the maximum number of characters allowed in a data grid 

cell. You are not able to enter more characters than allowed (e.g. 

when entering text using a Data Entry Image region). Note that 

performance may be affected by data grid cells that contain very 

large amounts of text. 

System poll interval during Server Mode 

(secs.) 

Enter the number of seconds in between polls for Server Mode. 

The software searches for image files in a directory or pages in the 

scanner's sheetfeeder based on this time interval. 

Numeric data value used to represent 

invalid responses 

Enter the value to be used when invalid data are encountered 

during a data file export. Invalid data is anything that does not 

match the labels you defined in the template, such as error 

codes. If you typed a response in a list cell in the grid but it did not 

match the labels defined, this data would also be considered 

missing (e.g. "A" is defined in the form template, but you type "a"). 

The Missing Value is also used when running reports in Remark 

Quick Stats. The default value is -1. 

Numeric data value used to represent 

blank responses 

Enter the value to be used when blank data cells are encountered 

during a data file export. The Missing Value is also used when 

running reports in Remark Quick Stats. The default value is -2. 

Numeric data value used to represent 

multiple responses 

Enter the value to be used when multiple responses in data cells 

are encountered during a data file export (and are not allowed). 

The Missing Value is also used when running reports in Remark 

Quick Stats. The default value is -3. 

Database lookup & replace record limit The limit on the number of records loaded into the data grid’s list 

when using Database Lookup. If the limit is lower than the number 

of records in the database no data is loaded. The larger the limit 

the longer it takes to load the list. 
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Remark Office OMR Preferences - Folders 

Folder preferences allow you to setup the default folders that are used to store image files. If you prefer 

to store files on a network drive, you can enter that location here (ensure that you have permission to fully 

access that drive). When you import images using the Read option, Remark Office OMR remembers that 

location. However, it's still helpful for the software to know where to expect to find stored images. Note 

that Remark Office OMR uses a 'follow me' folder structure, meaning that it uses the last location you 

selected when saving and opening files in general (e.g. templates, data). The following options are 

available: 
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Preference Option Description 

Image Search Folders Sets the locations(s) in which images are stored for processed forms and 

Image region Image Clips. When a cell in the data grid is clicked, the 

stored image file is displayed in the Image Viewer. The Image Viewer can 

be used for image-assisted data entry, Review Exceptions and in-cell 

editing. Use the Add Folder... button to add any folders in which you 

plan to store image files for processed forms. Remark Office OMR 

searches for these images in the order in which the folders are specified. 

Use the Move Up or Move Down buttons to change the search order, 

and the Remove Folder button to remove a folder from the search list. 

Note that you can store images in any folder when processing forms. 

However, providing frequently used folders in the Image Search Folders 

List aids the Remark software in finding images to display whenever a 

data set is opened. 

Active Dictionary Sets the active dictionary to be used for Spell Checker. Click the down 

arrow to view any dictionaries that are currently installed on your 

computer. 

Remark Office OMR Preferences - Display 

Display preferences allow you to set up aspects of how Remark Office OMR looks. The following options 

are available: 
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Preference Option Description 

Shade alternating grid rows  Mark this checkbox and choose a color to shade every other Data 

Center grid row.  

Default row height Sets the height of the row based on font and screen resolution. 18 

is the default but you may set the number larger or smaller 

according to your preference. 

Update the Image Viewer after each image 

is processed 

Mark this checkbox to have the Image Viewer update with a new 

form image each time a form is processed. The Image Viewer is 

located beneath the data grid window. Using this option could 

alert you to issues such as skewed forms and is highly 

recommended. 

Update the Graph Viewer after each image 

is processed 

Mark this checkbox to have the Graph Viewer update with a new 

graph per question each time a form is processed. The Graph 

Viewer is located beneath the data grid window. It provides a 

quick glimpse into your data by graphing the active question. 

Use a Custom Font Custom Font preferences allow you to set up the default fonts to 

use throughout the application. Mark the Use a Custom Font 

checkbox to choose a font to use throughout the application, 

allowing you to customize the software's look. You may choose a 

character set, font name and font size. You should choose a font 

that is supported by your operating system. Please note that not 

all fonts look optimal in the software. You should restart the 

application after making any font changes.  

Remark Office OMR Preferences - Email 

Email preferences allow you to set your internal SMTP server or Outlook as your default email program 

when emailing data and report files out of Remark Office OMR (File|Email). When using Outlook, Outlook 

opens with your file(s) as an attachment. When using Custom (SMTP), a Remark Office OMR email window 

opens that utilizes your SMTP server. 

SMTP stands for Simple Mail Transfer Protocol and is the Internet standard for transmitting email across 

networks. It is likely your organization has a running SMTP server already set up. You just need to find out 

general information about the server. You will need to consult with your network/email administrator to 

obtain information about your SMTP server. 
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To choose your default email program 

1. Select the Tools menu, then click Preferences, then Email. 

2. In the Email drop-down list, choose Custom to use your SMTP server or Outlook to use 

Microsoft Outlook 2007 or greater.  

3. If using your SMTP server, click the SMTP Server button and put in the settings as described in 

the table below for your SMTP server.  

4. Click the OK button to close the Preferences.  

To set up an SMTP server, please use the following table as a guide to have your administrator provide 

the proper settings: 
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Option Description 

SMTP server This is the name, address or IP address of the mail server. 

SMTP port The SMTP port is usually 25 but may vary with your email server. 

Enable a secured (SSL) 

connection 

If desired, use a secure connection by marking the checkbox for Enable a secured 

(SSL) connection. SSL encrypts data as it is transmitted. Your SMTP server must be 

configured to use SSL in order for this feature to work. 

Use the default 

credentials of the 

currently logged in user 

If you need to use authentication for your SMTP server, you can enter credentials or 

use those of the user logged in to the computer. Mark the Use the default 

credentials of the currently logged in user checkbox to utilize the user's credentials 

(e.g. the person logged in when sending the emails from Remark Office OMR). 

Otherwise, continue to the next step to enter specific credentials. 

Username and Password If authentication is required, and you are not using the credentials of the currently 

logged in user, enter the Username and Password, as supplied by your 

network/email administrator. 

Throttle rate The throttle rate adds a delay while sending emails. The default setting is 500ms, 

meaning that one email is sent every 500 ms (in other words, two emails are sent per 

second). Throttling emails keeps the SMTP server from being overloaded when 

sending large numbers of emails. Unless you plan on sending hundreds of emails at 

one time, the default setting of 500 is likely fine. 

Remark Office OMR Preferences - Speech 

Remark Office OMR includes the ability to use speech recognition when running Review Exceptions. This 

feature is particularly helpful if you have Image regions on your form that have long comments. Instead of 

clipping or typing the comments, you can use the Image Viewer on-screen and read the comments into 

the data grid. You can also use speech recognition to review other data types during Review Exceptions 

(e.g. actual answer choices from an OMR region). 

Speech recognition relies on the Microsoft Windows built-in speech technology. Gravic has no control 

over the effectiveness of speech recognition. We strongly suggest you train your computer to recognize 

your voice using the Microsoft speech training options in the Windows Control Panel. If you encounter 

difficulties with speech recognition, ensure you have a good quality microphone and that you have 

conducted the speech recognition training. For speech recognition troubleshooting, consult the Microsoft 

website. 

The Speech preference in Remark Office OMR allows tells you the commands you can use when using 

speech recognition in Review Exceptions: 
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Next: Moves to the next exception 

Previous: Moves to the previous exception 

Finish: Ends the review process 

  

You can also click the Speech Recognition button to run through Microsoft's training process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remark Office OMR Preferences - Data 

As changes are made to data in the Remark Office OMR Data Center, they can optionally be logged, 

allowing you to see what changes were made and who made them. Logging is turned on and off in the 

Remark Office OMR Preferences. It can only be turned off if you know the password used when turning on 

the feature. Changes made to the data grid (edits, review exceptions, review duplicates, clipboard, open, 

save, etc.) are logged in a password protected Access database in the following location: 

C:\ProgramData\Gravic\Remark Office OMR\Change logs (note you must have the option to show hidden 

folders and files on to see this location). 

When the database is initially created, it uses the date of creation as the filename. From that point 

forward, all changes to all data files are stored in that Access file as long as the feature is turned on. Data 

file types, exception flags and actions are all listed with a numeric equivalent in the database. The 

additional tables in the database explain each of the numeric values. Once a database reaches 10MB in 

size, a new database is created the next time Remark Office OMR is opened. 

In addition, you can use this area to control whether to enable recovery logging (highly recommended). 

When enabled, Remark Office OMR will recover any open data in the event of a sudden, unplanned exit of 

the software (e.g. a power failure). 
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To turn on logging 

1. From the Remark Office OMR Data Center, 

select the Tools menu, then click 

Preferences, then Data.  

2. Mark the checkbox for Maintain Data 

Modification Log.  

3. Enter a password in the Password box. 

4. Click the OK button to close the 

Preferences.  

From this point forward, all changes to the data grid 

are logged. 

  

To turn off logging 

1. From the Remark Office OMR Data Center, select the Tools menu, then click Preferences, then 

Data. 

2. Enter the password that was set when turning on logging in the Password box. 

3. Click the Disable button. 

4. Click the OK button to close the Preferences.  

From this point forward, all changes to the data grid are not logged. If changes have been logged 

previously, the Access database still exists. 

 

You can also restrict changes that are made to the data grid.  Similar to the "Maintain Data Modification 

Log" feature, you turn on the data restriction feature by setting a password and turn off the feature by re-

entering the same password. If this option is turned on, users will not be able to review data or edit data 

in the grid. 

 

To restrict data modifications 

1. From the Remark Office OMR Data Center, 

select the Tools menu, then click 

Preferences, then Data. 

2. Mark the checkbox for Restrict Data 

Modifications.  

3. Enter a password in the Password box. 

4. Click the OK button to close the 

Preferences.  

From this point forward, no changes to the data grid 

are allowed. 
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 To turn off data modification restrictions 

1. From the Remark Office OMR Data Center, select the Tools menu, then click Preferences, then 

Data. 

2. Enter the password that was set when turning on logging in the Password box. 

3. Click the Disable button. 

4. Click the OK button to close the Preferences.  

From this point forward, changes are allowed in the data grid.  

 

To turn off data recovery 

 If you do not want to have Remark Office OMR automatically recover from any sudden closures, 

deselect the checkbox for Enable recovery logging. 

• Note: We highly recommend leaving data recovery on so you do not lose any data. 

Remark Office OMR Preferences - 

Updates 

Remark Office OMR has the ability to automatically check for software updates. You can check at any time 

by clicking the Help menu and then choosing Check for Updates. You can also have the software check 

for an update every time it starts up. When this option is turned on, every time you start the software, it 

sends information about your current version to the update website and lets you know if there is a newer 

version of the software available. If an update is available, you are prompted to install it. The Check for 

Updates window also has the ability to do an immediate check for updates. 

• Note: Updates are only available to customers with an active Technical Support and Maintenance 

agreement. If a new update is available but you have not purchased maintenance, you are not 

prompted to install it. If you are interested in Technical Support and Maintenance, please contact 

our sales department. 

 

To automatically check for updates 

1. Select the Tools menu, then click Preferences, then Updates. 

2. Mark the checkbox for Check for updates when program starts to turn on the automatic check 

for updates. 

3. [Optional] If you would like to see if an update is available immediately, click the Check for 

Updates Now link. 

4. Click the OK button to close the Preferences. 

The next time the software is started, it automatically checks for an update. If an update is found, and you 

would like to install it, follow the on-screen prompts. You must have an Internet connection to download 

the update. If no updates are available you receive a message indicating that your software is up to date. 

mailto:sales@gravic.com
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Please note that in order for the update to install, you need to close Remark Office OMR. You can either 

install the update as soon as it is downloaded, or continue working and when you close the software, the 

update will install itself. If the Remark Office OMR Data Center or Template Editor are open, you are 

prompted to close them. Please save all work before allowing the install to continue. 

The Remark Office OMR Automatic Update collects 

some system configuration data in order to provide you 

with updates that apply to your installation. This 

information includes: 

• Product Name  

• License Key  

• Remark Serial Number  

• Remark Authentication Code 

• Software Version and Build Number 

• System Finger Print (same as activation)  

Gravic, Inc. is committed to helping protect your privacy. 

Using the automatic update feature does not collect your name, address, email address, or any other form 

of personally identifiable information. Your Internet Protocol (IP) address is logged when you connect to 

the Gravic website, but this address is only used to generate aggregate statistics.

Remark Office OMR Preferences - Images 

PDF images are not native image files. However, they can be converted to an image format in order to 

read scanned forms. The Images settings are used to determine how best to convert these files to the 

most usable image format so that they both read well and display well (e.g. in Response reports).  

 

To set Image Handling 

1. Choose the Bit Depth: Bit Depth is the color information stored in an image. The higher the bit 

depth, the more colors stored. For example, a 1 bit image only shows black and white. Choose 

whether your image is Color or Grayscale bit depth. 

2. Choose the Compression: Compression is used to minimize the size of an image without 

degrading its quality. Choose from the following options: None, CCITT Group 3, CCITT Group 4, 

Run-length encoding, JPG, LZW and Packed bits. Group 4 creates the most compressed image 

(smallest file size that take up less space on your computer). 

3. Choose the Resolution: Resolution is the detail an image holds and is measured in dots per inch 

(DPI). Higher resolution means more detail (and a larger file size). Choose from the following 

options: 150 DPI, 200 DPI or 300 DPI. 

4. Click the OK button to close the Preferences. 
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Chapter 10: Automation 

Control Center  

Automation Control Center Overview 

Remark Office OMR includes an Automation Control Center that allows you to automate some of the 

functionality of the software. The Automation Control Center allows you to setup automation files that can 

be run by another user by simply double clicking a file. You can automate functions such as opening the 

software, opening a form template, processing forms, saving data, running reports and closing the 

software. This feature is useful for simplifying tasks for your users. 

The Automation Control Center is accessed from the Tools menu in the Remark Office OMR Data Center. 

It walks you through the steps to set up a REZ file. Once that file is created, it can be double clicked to 

launch the associated actions on a computer running Remark Office OMR. You can also call this file from 

other applications (this is outside the scope of Remark Office OMR). Ensure that the folders and files you 

set up in the REZ file are universally accessible to your Remark users. 

• Tip: The Automation Control Center allows you to automate basic features of the software. These 

features are described in the main Remark Office OMR user's guide and elsewhere in this file. 

Therefore, each feature will not be presented in detail here. You can learn about specific software 

features by locating them in the table of contents of this file. 

  

To create/modify a REZ file 

1. Select the Tools menu and then click Automation Control Center. 

2. Use the sections below to set up your REZ file.  

3. Once everything is set up, save the file. You have the following options: 

• Click the Save button to save the REZ file, but the Automation Control Center remains open for 

further modifications. 

• Click the drop-down arrow on the Save button and choose Execute. The REZ operation 

executes in a new instance of Remark Office OMR. The Automation Control Center remains 

open for you to make further modifications or save your REZ file. Nothing is saved. 

• Click the drop-down arrow on the Save button and choose Save and Execute. You are 

prompted to save the REZ file first, and then the operation executes in a new instance of 

Remark Office OMR.  

Once the REZ file is created, provide it to Remark users by placing it on the computer or embedding it 

into your own application. 
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Automation Control Center - General 

The first step in the Automation Control Center allows you to setup general software options. Once you 

make your selections, click the Open link in the left task pane to continue. 

  

 

 

 

 

 

 

 

 

 

 

 

 

Option Description 

Load The Load button provides two options: 

Load: Loads a previously saved Automation file so that you can 

make changes or execute it. 

New: Allows you to begin building a new Automation file (resets the 

Automation Control Center and all changes made previously are 

lost). 

Window State Configures how the main Remark Office OMR window appears when 

the software is launched: 

Normal: Displays the software in its default state. 

Minimized: Leaves the software minimized on the desktop so that 

the user can easily continue doing other things while processes are 

being executed. 

Maximized: Displays the software full screen. 

Hidden: Runs the software in a hidden state so that the user does 

not see the software running. Most prompts are suppressed. 

Hide the splash screen Mark this checkbox to hide the splash screen that displays when the 

software is first launched. 
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Option Description 

Use default folders when saving Mark this checkbox to have stored images saved to the folders 

specified in the software preferences. 

Display the image scanner 

configuration on startup 

Mark this checkbox to show the scanner properties window when 

the software is launched so that the user can configure the scanner. 

Automatically exit after completing 

execution 

Mark this checkbox to have Remark Office OMR automatically close 

once it has executed all of the parameters in the automation file. 

Launch another automation file upon 

completion 

Mark this checkbox to launch another automation (REZ) file after this 

one completes. Use the ellipse (…) to choose that file. This feature 

allows you to chain automation files together to run multiple 

operations automatically. 

Automation Control Center - Open 

The Open window allows you to select which templates, data files and analysis definition files to open 

automatically. In addition, you can set up data saving options here. Once you make your selections, click 

the Scan or Read Images links (depending on whether you will be using a directly connect TWAIN 

scanner or importing images into the software) in the left task pane to continue. 
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Option Description 

Template  Click the folder to select a form template to open automatically. You 

may open form templates (OMR), batch files (OBF), Remark Office 

Archive files (ROA/ROX) or Remark (RMK/RMX) data files. When 

opening ROA/ROX and RMK/RMX files, the associated form 

template file opens with the data file automatically (note that the 

files must be in the same location as specified when saving the data 

in order for this to work). 

Analysis File Optionally, click the folder to open an existing answer key or survey 

definition file. This file is executed after forms are processed. 

Grading and Tabulation parameters are specified in the last step of 

the Automation Control Center. You have several options for the use 

of this file: 

1) If using Quick Grade or Quick Survey, the file selected in this step 

is used to produce the results. 

2) If using Advanced Grade, do not specify grading options in the 

last step of the Automation Control Center. Instead, if an answer key 

file is specified here in the automation file, you can run Advanced 

Grade manually (e.g. click the toolbar button, task pane option or 

menu option) and the specified answer key file is opened 

automatically. You may click Grade to grade the data or further 

configure the selected answer key file. 

3) If using Advanced Survey you need to run it manually (e.g. click 

the toolbar button, task pane option or menu option) and then the 

file specified here is automatically loaded into Advanced Survey. You 

may click Analyze to tabulate the data or further configure the 

selected survey definition file. 

Open Data Click the folder to select a data file to open automatically. You may 

open any one of the supported file formats. When opening 

ROA/ROX and RMK/RMX files, the associated form template file 

opens with the data file automatically (note that the files must be in 

the same location as specified when saving the data in order for this 

to work). When opening data prior to processing forms, the newly 

processed data is added onto the end of the data file. You most 

likely want to overwrite the entire data file once you process 

additional forms in this case. 

Save Data (on Exit) Click the folder to select a data file for saving the data after forms 

are processed. You may choose an existing file or enter a new file 

name and format. Data from any open form templates is saved 

when the software is closed. This is the most common way to save 

data using an automation file. 
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Option Description 

Overwrite Mark this checkbox to overwrite the data file(s) specified each time 

the automation file is run. 

Add  Click the Add button to add another row where you may make 

further selections (e.g. open another form template, save to another 

data file, etc.). 

Delete Row Click the Delete Row button to remove the currently selected line of 

parameters. 

Show Organize & Save when saving 

data on exit 

Mark this checkbox to show the Organize & Save window if saving 

data when exiting the software. This feature allows you to customize 

the names used for data files and storage folders by utilizing data 

values from the active data set. 

 Automation Control Center - Scan 

The Scan window allows you to select the parameters to use for scanning forms with a TWAIN scanner 

directly connected to the computer running Remark Office OMR. Once you make your selections, click the 

Image Archiving link in the left task pane to continue. 
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Option Description 

Read from Scanner Mark this checkbox to use the scanner to scan forms once a form 

template is opened. 

Disable scan prompts Mark this checkbox to disable any scanning prompts. Scanning begins 

without any interaction from the user. When the ADF is empty, 

scanning simply stops with no additional prompts. 

Scan single page only Mark this checkbox to only scan a single page placed in the scanner. 

Use Auto Form ID Mode Mark this checkbox to scan in Auto Form ID mode. This feature only 

applies to form templates that have Auto Form ID regions on each 

page, allowing you to scan multiple forms at one time. Remark Office 

OMR automatically matches the scanned form to the appropriate form 

template based on the form ID it reads. 

Use Server Mode Mark this checkbox to scan in Server Mode. Server Mode provides 

unattended scanning where the scanner is polled for forms at user-

specified intervals. Any forms found in the scanner are then scanned 

and data produced. 

Display custom scan prompt Mark this checkbox to enter your own customized scanning prompt. 

Enter the text you wish to display when scanning begins in the box 

below the checkbox. 

Automation Control Center - Read 

Images 

The Read Images window allows you to specify parameters for processing stored image files (e.g. if you 

scan forms on a multi-function peripheral and then save them as image files for Remark Office OMR to 

process). Once you make your selections, if you chose the option to 'Archive images after processing', 

click the Image Archiving link in the left task pane to continue. Otherwise, click the Data Review link in the 

left task pane to continue. 
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Option Description 

Read Image Files Mark this checkbox to process images that you have already scanned 

and saved as image files on your computer or network. 

Add Folder Click the Add Folder... button to add a search folder to the Image 

Source Folders box. Any folders listed in this box are used to find image 

files to process. 

Delete Folder Click the Delete Folder button after selecting a folder in the Image 

Source Folders box to remove it from the search when processing 

image files. 

Image filters Mark the checkboxes corresponding to the types of images that you 

wish to process. Only images corresponding to these file types are 

read; all others are ignored (TIF and PDF are most common). If you 

select *.* any supported images found in the search folders are 

processed.  
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Option Description 

Custom filters Use the Custom Filters box to refine your Image Filters list. Image 

filters represent the types of image files you wish to process. You can 

specify specific cases here by using wildcards. For example, if you 

wanted to process all images that start with "English 101" you could 

enter "English 101*.*" as a custom filter. Only images that start with this 

text are processed. Type the custom filter into the Custom Filter box 

and then click the Add button. The filter is added to the Image Filters 

list and automatically selected. Note that when specifying image types, 

an asterisk (*) can be used to indicate any number of characters (e.g. 

.jp* would allow any number of characters after the "jp" such as .jpg 

and .jpeg), and the question mark (?) can be used to indicate any single 

character in addition to the specified file extension (e.g. .jp? would only 

allow three character extensions such as .jpg). When using a custom 

filter, it is executed separately from any other filters you may have 

applied, so make sure you include the extension type if needed. For 

example, do not turn on the generic PDF filter and add a wildcard such 

as "English101" or else you will get all PDFs and all files beginning with 

"English101. Instead, if you want English101 PDF files, specify 

"English101.pdf". 

Prompt for images to read Mark this checkbox to pause automation and allow the user to choose 

the images they want processed. This allows for more flexibility in the 

images chosen, as opposed to simply picking a type and location and 

processing all images found. 

Use Auto Form ID Mode Mark this checkbox to process images in Auto Form ID mode. This 

feature only applies to form templates that have Auto Form ID regions 

on each page, allowing you to scan multiple form types at one time. 

Remark Office OMR automatically matches the scanned form to the 

appropriate form template based on the form ID it reads. Remark 

Office OMR automatically matches the scanned form to the appropriate 

form template based on the form ID it reads. 

Use Server Mode Mark this checkbox to process images in Server Mode. Server Mode 

provides unattended image processing where the specified folders are 

polled for images at user-specified intervals. Any images found are 

then processed and data produced. 

Archive images after processing Mark this option to archive the images in a different format and/or 

location after they have been read. This option allows you move the 

images to a more permanent folder for storage and/or change formats. 

Configure the archive options in the Image Archiving window. 
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Option Description 

Delete images after processing Mark this checkbox to delete the images once they are processed. Note 

that using this feature will permanently delete the images from your 

computer. This features is particularly important if you use Server 

Mode. If the images remain and you stop and start Server Mode, the 

images will be processed again. You may wish to write a batch file that 

moves the images to another location once they are processed or use 

the archive option to move them elsewhere after processing. 

Automation Control Center - Image 

Archiving 

The Image Archiving window allows you to select the parameters to use when saving images, either from 

the scanner or when archiving images that are imported. Once you make your selections, click the Data 

Review link in the left task pane to continue. 
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Option Description 

Begin image names with Enter a file base name that the software can use to name the images 

stored for this form template as forms are scanned. You may use any 

name you like. We suggest using something that identifies to you that 

the images belong to a certain form (e.g. form template name). The 

images that are stored all begin with this base name and then have the 

page number (if larger than a one page form template), date and time 

appended to them to keep track of the various images. If you leave the 

Begin image names with option blank, your images only have the page 

number (if applicable), date and time as the name of each image. 

Target folder Click the ellipsis (...) to select a location in which to store the images for 

this form. You may use the default folder for images (stored in the 

software's preferences) or select a different folder. 

Name Builder The Name Builder button allows you to customize the image base names 

and storage folders for the scanned image files by pulling in data values 

from the active data set. In the Image Base Name area, you may choose 

to add a region from the processed data to the image base name. 

Choose the region from the drop-down list and then click the Insert 

Data into Base Name button. If you already added a region on the 

previous screen, the Name Builder allows you to add additional regions. 

For example, if processing tests, you could add a Student ID that is being 

collected from the form so that your processed images all have the 

Student ID number in them. 

In the Destination Folder area, you may choose to add a region from 

the processed data to the folder structure that holds the processed 

images. Choose the region from the drop-down list and then click the 

Append Data Onto Folder Path button. For example, if processing 

tests, you could add a Test ID that is being collected from the form so 

that each student's form images are stored in a folder containing the 

Test ID. 

In the Name Builder box, click the OK button to return to the 

Automation Control Center. 

Save image as Select an image type to use for storing images. The choices are: 

PCX/DCX, PDF, TIF or JPG. 

Compression level When saving to the PDF or TIF formats, you can choose the compression 

rate: Uncompressed, Group 3, Group 3 2d, Group 4 and LZW. Group 4 

creates the most compressed (smallest file size) image. 
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Option Description 

Save images in a subfolder based on 

the form template’s name 

Mark this checkbox to have Remark Office OMR automatically create a 

folder in which to store these images. The folder name will be the name 

of the form template and the folder will be created in the folder you 

have selected in the Image target folder box. 

Save multi-page form templates as 

multi-page images files 

Mark this checkbox if you are scanning with a multi-page form template 

and would like all of the images for one complete form saved as one 

image file. 

Automation Control Center - Data 

Review 

The Data Review window allows you to specify whether to review exception cases during form processing 

and which cases to review. Once you make your selections, click the Save Data or Analysis links in the left 

task pane to continue. 
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Option Description 

Review Exceptions Mark this checkbox to activate the Review Exceptions feature during 

form processing (scanning or reading image files). When selected 

exception cases are found, processing stops and you are required to 

take action (either correct the exception or continue the processing 

without correction). It is not common to stop the process to review 

exceptions. The Review Exceptions process can also be launched after 

forms are processed. The following exceptions are available: 

• Multiple Responses 

• Blank Responses 

• Recognition Errors 

• Image Regions 

• Database Lookup Regions 

• Barcode Regions 

• OCR Regions 

• Repeated Rank Responses 

• Required items 

Review after processing forms Mark this checkbox to have Review Exceptions start after all of the 

images are processed. Using Review Exceptions after processing 

images means that the processing does not stop for any exceptions. 

Instead you use Review Exceptions post-processing to clean the data. 

Review unrecognized images as they 

occur 

Mark this checkbox if processing forms with Form, Page or 

Respondent Tracker IDs. If an image cannot be matched to its form 

template, form template page or respondent, processing stops and 

you are able to identify the form, page or respondent and then resume 

processing. 

Review unrecognized images after 

processing  

Mark this checkbox if processing forms with Form, Page or 

Respondent Tracker IDs. If an image cannot be matched to its form 

template, form template page or respondent, you are able to identify 

the form, page or respondent after all of the forms have been 

processed. 
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Automation Control Center - Save Data 

The Save Data Options window allows you to specify saving options while forms are being processed. As 

each page is processed, the data is written directly to the file specified (as opposed to saving after all 

forms are processed). This feature allows you to send data to an external file right as the forms are 

processed so that some other action can be taken on the data. Any changes made after processing the 

forms are not written to this file. Use of this saving option is not common. You typically want to use the 

Save Data options in the Open window of the Automation Control Center. Once you make your selections, 

click the Analysis link in the left task pane to continue. 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

Option Description 

Save Data  Mark this checkbox to save all data collected to one data file. Click 

the ellipsis (...) to select an existing data file or enter a new file name. 

If you choose an existing file, you are prompted to overwrite or 

append to the file each time. 
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Option Description 

Organize & Save The Organize & Save button allows you to further customize how 

data files are named and stored. In the File base name area, you 

may choose to add a region from the processed data to the file base 

name. Choose the region from the drop-down list and then click the 

Insert Data into File Name button. For example, if processing tests, 

you could add a Student Name field that is being collected from the 

form so that data file names all begin with the students' names. 

In the Destination folder area, you may choose to add a region 

from the processed data to the folder structure that will hold the 

data files. Choose the region from the drop-down list and then click 

the Append Data Onto Folder Path button. For example, if 

processing tests, you could add teacher name and student name 

fields that are being collected from the form so that each student's 

data is stored in a folder containing the teacher's name and then a 

subfolder containing the student's name. 

In the Table name area, you may choose to add a region from the 

processed data to the table base name if using a database or 

spreadsheet format. Choose the region from the drop-down list and 

then click the Insert Data into Table Name button. For example, if 

processing tests, you could add a Test Name field that is being 

collected from the form so that the table name contains the test 

name. 

Overwrite existing file or table Mark this checkbox to overwrite the selected data file each time the 

Automation Control Center file is executed. 

Automation Control Center - Analysis 

The Automation Control Center can produce reports using Remark Quick Stats. You may run grade or 

survey operations, as well as save and export reports. Once you have configured your analysis options, 

you can save the REZ file. 

• Note: To learn more about Remark Quick Stats in general, please see the Remark Quick Stats 

user’s guide installed with your software. 
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Option Description 

Analyze Data Mark this checkbox to run analysis on your data. 

Analysis type Choose Quick Grade, Quick Survey, Advanced Grade or 

Advanced Survey from the list to automatically launch this type 

of analysis. 

Load Report Preferences  Allows you to select a set of Remark Quick Stats preferences 

that you want to use for this operation. These preferences may 

be exported from a copy of Remark Quick Stats so that they 

may be used here. If your copy of Remark Quick Stats is already 

using the preferences you desire for this report, you may skip 

this option. 

Save data  Mark this checkbox to save the Remark Quick Stats data as an 

RQS file for reuse within Remark Quick Stats. Then click the 

ellipsis (...) to choose a location in which to save the file. 

Export Excel reports Mark this checkbox to export the entire set of reports to the 

Excel format. 

Export gradebook Mark this checkbox to export the grade results to a gradebook 

file. Then click the ellipsis (...) to choose the gradebook type and 

a location in which to save the file. 
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Option Description 

Export test item data Mark this checkbox to export the grade results to a test item 

data file. Then click the ellipsis (...) to choose the file type and a 

location in which to save the file. 

Export data & grade results Mark this checkbox to export the data and grade results to a file. 

Then click the ellipsis (...) to choose a file type and a location in 

which to save the file. If you wish to overwrite an existing file, 

mark the checkbox for Overwrite existing file or table. If you 

wish to save the numeric equivalents for the data set, mark the 

checkbox for Save numeric equivalent. If you wish to save the 

learning objectives in a row based file (each learning objective 

per student is a data record), mark the checkbox for Save row-

based learning objectives. 

Gradebook Options Click the Gradebook Options button to set parameters specific 

to the gradebook export you have chosen. 

Generate Report / Batch Click the ellipsis (...) to choose the individual report (.rpx) or 

report batch file (.rbwx) you wish to generate. Report batches 

are created in Remark Quick Stats using the Report Batch 

feature. This feature allows you to generate, print and/or export 

multiple reports without having to select each one individually. 

Note: If you select a report batch, the exporting and printing 

options are disabled, as these options are setup in the batch file. 

Export Report Click the ellipsis (...) to choose a file type and location to which 

to export the report for individual reports. 

Print Mark this checkbox to print the report once it is generated. 

Add/Delete Row Click the Add button to add another row where you may make 

further selections (e.g. run another report). Click the Delete Row 

button to remove the currently selected line of parameters. 
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